SUSE Linux Enterprise
Server




Deployment Guide
All content is copyright © 2006- 2009 Novell, Inc.
Legal Notice

This manual is protected under Novell intellectual property rights. By reproducing, duplicating or
distributing this manual you explicitly agree to conform to the terms and conditions of this license
agreement.

This manual may be freely reproduced, duplicated and distributed either as such or as part of a bundled
package in electronic and/or printed format, provided however that the following conditions are ful-
filled:

That this copyright notice and the names of authors and contributors appear clearly and distinctively
on all reproduced, duplicated and distributed copies. That this manual, specifically for the printed
format, is reproduced and/or distributed for noncommercial use only. The express authorization of
Novell, Inc must be obtained prior to any other use of any manual or part thereof.

For Novell trademarks, see the Novell Trademark and Service Mark list http://www.novell
.com/company/legal/trademarks/tmlist.html. * Linux is a registered trademark of
Linus Torvalds. All other third party trademarks are the property of their respective owners. A trademark
symbol (®, ™ etc.) denotes a Novell trademark; an asterisk (*) denotes a third party trademark.

All information found in this book has been compiled with utmost attention to detail. However, this
does not guarantee complete accuracy. Neither Novell, Inc., SUSE LINUX Products GmbH, the authors,
nor the translators shall be held liable for possible errors or the consequences thereof.


http://www.novell.com/company/legal/trademarks/tmlist.html
http://www.novell.com/company/legal/trademarks/tmlist.html

Contents

About This Guide

1 Planning for SUSE Linux Enterprise Server

1.1 Considerations for Deployment of a SUSE Linux Enterprise Server . . . . .
1.2 Deployment of SUSE Linux Enterprise Server . . . . . . . . . . . . ..
1.3 Running SUSE Linux Enterprise Server . . . . . . . . . . . . . . . ..

Part 1 Architecture Specific Installation Considerations

2 Installation on x86, AMD64, Intel 64, and Itanium

2.1 Required Background . . . . . . . . . . . . ...
2.2 System Requirements for Operating Linux . . . . . . . . . . . . . ..
23 Installation Considerations . . . . . . . . . . . . . .. ... ...
2.4  Boot and Installation Media . . . . . . . . . . . ...
2.5 Installation Procedure . . . . . . . . . . . ..o L.
2.6 Controlling the Installation . . . . . . . . . . . . .. .. .. ...
2.7  Dealing with Boot and Installation Problems . . . . . . . . . . . . ..

3 Installation on IBM POWER

3.1 Requirements . . . . . . . . . . . . ..o
32 Preparation . . . . . . ..o

4 Installation on IBM System z

4.1 General Information and Requirements . . . . . . . . . . . . . . ..
4.2 Preparing for Installation . . . . . . . . . . . . . .. ... .. ..
43 Network Connection Types . . . . . . . . . . . . . . . . . . ...

N
14
15
16
18

21

21
23

39

39
46
63



44
4.5
4.6

Part Il

The parmfile—Automating the System Configuration . . . . . . . . . .
Using the vt220 Terminal Emulator . . . . . . . . . . . . . . . ..
Further In-Depth Information about IBM Systemz . . . . . . . . . . .

Manual Deployment

5 Deployment Strategies

5.1
5.2
5.3

Deploying up to 10 Workstations . . . . . . . . . . . . . . . ...
Deploying up to 100 Workstations . . . . . . . . . . . . . . . . ..
Deploying More than 100 Workstations . . . . . . . . . . . . . ..

6 Installation with YaST

6.1
6.2
6.3
6.4
6.5
6.6
6.7
6.8
6.9
6.10
6.11
6.12
6.13
6.14
6.15

Choosing the Installation Method . . . . . . . . . . . . . . . . ..

The Installation Workflow

IBM POWER: System Start-Up for Network Installation . . . . . . . . .
IBM System z: System Start-Up for Installation . . e e
System Start-Up for Installation . . . . . . . . . . . . . . .. ...

The Boot Screen . . . .

Welcome . . . . . . .

IBM System z: Hard Disk Configuration .

Installation Mode
Clock and Time Zone . .
Server Base Scenario . .

Installation Settings . . .
Performing the Installation

Configuration of the Installed System .

Graphical Login . . . . .

7 Updating SUSE Linux Enterprise

7.1
7.2
7.3

Updating SUSE Linux Enterprise . . . . . . . . . . . . . . . ...

Installing Service Packs .

Software Changes from Version 10 to Version 11 . . . . . . . . . . .

8 Setting Up Hardware Components with YaST

8.1
8.2
8.3
8.4
8.5

Probing Your Hardware . .

Setting Up Graphics Card and Monitor . .
Setting Up Keyboard and Mouse .

Setting Up Sound Cards .

Setting Up a Printer . . .

67
73
74

77

79

79
81
88

89

89
91
92
92
93
93
98
99
101
103
105
105
110
113
124



9 Installing or Removing Software

9.1 Definition of Terms
9.2 Using the Qt Interface
9.3  Using the GTK+ Interface
9.4  Managing Software Repositories and Services

10 Installing Add-On Products

10.1  Add-Ons
10.2  Binary Drivers
10.3 SUSE Software Development Kit (SDK) 10

11 Accessing the Internet

11.1  Direct Internet Connection . . . . . . . . . . . . . . . ..
11.2 Internet Connection Via Network . . . . . . . . . . . . . ..

12 Managing Users with YaST
12.1  User and Group Administration Dialog

12.3  Additional Options for User Accounts

13 Changing Language and Country Settings with YaST

13.1 Changing the System Language . . . . . . . . . . . . . . ..
13.2 Changing the Country and Time Settings . . . . . . . . . . .

14 Remote Installation

14.1 Installation Scenarios for Remote Installation

14.3  Preparing the Boot of the Target System
14.4 Booting the Target System for Installation

15 Advanced Disk Setup
15.1  Using the YaST Partitioner

9.5 Keeping the System Up-to-date . . . . . . . . . . . . . ..

12.2  Managing User Accounts . . . . . . . . . . . . . . . ...
12.4 Changing Default Settings for Local Users . . . . . . . . . . .
12.5 Assigning Usersto Groups . . . . . . . . . . . . . . .. ..
126 Managing Groups . . . . . . . . . . . .. ..o
12.7 Changing the User Authentication Method . . . . . . . . . . .

14.2 Setting Up the Server Holding the Installation Sources . . . . . .

14.5 Monitoring the Installation Process . . . . . . . . . . . . ..

141

141
142
147
151
153

161

161
162
162

163

163
166

167

167
169
171
179
180
180
182

185

185
189

193

193
202
212
222
226



15.2 LVM Configuration . . . . . . . . . . . . .. ... 239

15.3 Soft RAID Configuration . . . . . . . . . . . . . .. .. ... 245
16 Subscription Management 251
16.1  Using Kernel Parameters to Access an SMT Server . . . . . . . . . . . 252
16.2 Configuring Clients Using AutoYaST Profile . . . . . . . . . . . . .. 253
16.3  Configuring Clients Using the clientSetup4SMT.sh Script . . . . . . . . 255
16.4 Registering Clients Against SMT Test Environment . . . . . . . . . . . 255
Part lll Imaging and Creating Products 257
17 KIWI 259
17.1  Prerequisites for KIWI . . . . . . . . . . . . . ... ... ... 259
17.2  Knowing KIWI’s Build Process . . . . . . . . . . . . . . . . . .. 260
17.3 Image Description . . . . . . . . . . . . L. 260
17.4 Creating Appliances with KIWI . . . . . . . . . . . . . . . . . .. 264
17.5 For More Information . . . . . . . . . . . . ... ... .. 266
18 Creating Add-On Products With Add-on Creator 267
18.1 Creating Images . . . . . . . . . . . . ..o 267
18.2 Add-On Structure . . . . . . . . . . .. ..o 268
18.3 For More Information . . . . . . . . . . . . ... 269
19 Creating Images with YaST Product Creator 271
19.1 Prerequisites for Product Creator . . . . . . . . . . . . . . . ... 271
19.2 Creatinglmages . . . . . . . . . . . .. ..o 271
19.3 For More Information . . . . . . . . . . . . .. ... 273
20 Deploying Customized Preinstallations 275
20.1 Preparing the Master Machine . . . . . . . . . . . . .. ... .. 276
20.2 Customizing the Firstboot Installation . . . . . . . . . . . . . . .. 276
20.3 Cloning the Master Installation . . . . . . . . . . . . . . . .. .. 285
20.4 Personalizing the Installation . . . . . . . . . . . . . ... .. .. 285
Part IV Automated Installations 287
21 Automated Installation 289

21.1  Simple Mass Installation . . . . . . . . . .. o000 0oL 289



21.2  Rule-Based Autoinstallation
21.3  For More Information

22 Automated Deployment of Preload Images

22.1
22.2 Automated Deployment with PXE Boot

Deploying system manually from rescue image

301
306

307

308
309






About This Guide

Installations of SUSE Linux Enterprise Server are possible in many different ways. It
is impossible to cover all combinations of boot, or installation server, automated instal-
lations or deploying images. This manual should help with selecting the appropriate
method of deployment for your installation.

Part I, “Architecture Specific Installation Considerations” (page 5)
The standard deployment instructions differ depending on the architecture used.
For differences and requirements regarding the architecture, see this part.

Part II, “Manual Deployment” (page 77)
Most tasks that are needed during installations are described here. This includes
the manual setup of your computer as well as additional software and remote instal-
lations.

Part I1I, “Imaging and Creating Products” (page 257)
Mass installations often require to prepare images or products furnished with the
features that are needed in this special case. Several options are described that allow
the administrator to prepare this deployment methods.

Part IV, “Automated Installations” (page 287)
To do unattended installations, either use the installation with AutoYaST or prepare
an image with kiwi or firstboot. This part describes methods to deploy these instal-
lations with a minimum of user interaction.

Many chapters in this manual contain links to additional documentation resources. This
includes additional documentation that is available on the system as well as documen-
tation available on the Internet.

For an overview of the documentation available for your product and the latest docu-
mentation updates, refer to http://www.novell.com/documentation orto
the following section.

1 Available Documentation

We provide HTML and PDF versions of our books in different languages. The following
manuals for users and administrators are available on this product:


http://www.novell.com/documentation

X

Deployment Guide (page 1)
Shows how to install single or multiple systems and how to exploit the product
inherent capabilities for a deployment infrastructure. Choose from various approach-
es, ranging from a local installation or a network installation server to a mass de-
ployment using a remote-controlled, highly-customized, and automated installation
technique.

Administration Guide (* Administration Guide)
Covers system administration tasks like maintaining, monitoring and customizing
an initially installed system.

Security Guide (tSecurity Guide)
Introduces basic concepts of system security, covering both local and network se-
curity aspects. Shows how to make use of the product inherent security software
like Novell AppArmor (which lets you specify per program which files the program
may read, write, and execute) or the auditing system that reliably collects informa-
tion about any security-relevant events.

System Analysis and Tuning Guide (*System Analysis and Tuning Guide)
An administrator's guide for problem detection, resolution and optimization. Find
how to inspect and optimize your system by means of monitoring tools and how
to efficiently manage resources. Also contains an overview of common problems
and solutions and of additional help and documentation resources.

Virtualization with Xen (1 Virtualization with Xen)
Offers an introduction to virtualization technology of your product. It features an
overview of the various fields of application and installation types of each of the
platforms supported by SUSE Linux Enterprise Server as well as a short description
of the installation procedure.

Storage Administration Guide
Provides information about how to manage storage devices on a SUSE Linux En-
terprise Server.

In addition to the comprehensive manuals, several quick start guides are available:

Installation Quick Start (tInstallation Quick Start)
Lists the system requirements and guides you step-by-step through the installation
of SUSE Linux Enterprise Server from DVD, or from an ISO image.
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Linux Audit Quick Start
Gives a short overview how to enable and configure the auditing system and how
to execute key tasks such as setting up audit rules, generating reports, and analyzing
the log files.

Novell AppArmor Quick Start
Helps you understand the main concepts behind Novell® AppArmor.

Find HTML versions of most SUSE Linux Enterprise Server manuals in your installed
system under /usr/share/doc/manual or in the help centers of your desktop.
Find the latest documentation updates at http://www.novell.com/

documentation where you can download PDF or HTML versions of the manuals
for your product.

2 Feedback

Several feedback channels are available:

+ Toreport bugs for a product component or to submit enhancements requests, please

use https://bugzilla.novell.com/. If you are new to Bugzilla, you
might find the Bug Writing FAQs helpful, available from the Novell Bugzilla home

page.
+ We want to hear your comments and suggestions about this manual and the other
documentation included with this product. Please use the User Comments feature

at the bottom of each page of the online documentation and enter your comments
there.

3 Documentation Conventions

The following typographical conventions are used in this manual:
* /etc/passwd: filenames and directory names
* placeholder: replace placeholder with the actual value

* PATH: the environment variable PATH

About This Guide
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* 1s, ——help: commands, options, and parameters

® user: users or groups

+ Alt, Alt + F1: a key to press or a key combination; keys are shown in uppercase as
on a keyboard

* File, File > Save As: menu items, buttons

+ »amd64 em64t ipf: This paragraph is only relevant for the specified architectures.
The arrows mark the beginning and the end of the text block. <«

> ipseries zseries: This paragraph is only relevant for the specified architectures.
The arrows mark the beginning and the end of the text block. <«

 Dancing Penguins (Chapter Penguins, T Another Manual): This is a reference to a
chapter in another manual.
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Planning for SUSE Linux
Enterprise Server

The implementation of an operating system either in an existing IT environment or as
a completely new rollout must be carefully prepared. SUSE Linux Enterprise Server
11 provides a variety of new features. It is impossible to describe all the new features
here. The following is just a list of major enhancements that might be of interest.

Xen 3.3 Virtualization
Runs many virtual machines on a single server, each with its own instance of an
operating system. For more information, see Virtualization with Xen (1 Virtualization

with Xen).

YaST
Several new configuration options have been developed for YaST. These are nor-

mally described in the chapters about the technology involved.
SPident
The management utility SPident gives an overview of the installed software base

and clarifies the current service pack level of the system.

Directory Services
Several LDAP-compliant directory services are available:

+ Microsoft Active Directory

* OpenLDAP

Planning for



Novell AppArmor
Harden your System with the Novell AppArmor technology. This service is de-
scribed in depth in Part “Confining Privileges with Novell AppArmor” (tSecurity
Guide).

AIDE
This is an intrusion detection system that can be setup to detect unauthorized changes
to the system.

iSCSI
iSCSI provides an easy and reasonably inexpensive solution for connecting Linux
computers to central storage systems. Find more information about iSCSI in the
Storage Administration Guide

Network File System v4
Starting with version 10, SUSE Linux Enterprise Server supports NFS also in ver-
sion 4. This gives you performance improvements, strong security, and a “stateful”
protocol.

Oracle Cluster File System 2
OCFS2 is a general-purpose journaling file system that is fully integrated in the
Linux 2.6 kernel and later. Find an overview of OCFS2 in the High Availability
Guide .

Linux Kernel Crash Dump
Debugging kernel-related problems is now much more comfortable when using
Kexec and Kdump. This technology is available on x86, AMD64, Intel 64, and
POWER platforms.

1.1 Considerations for Deployment of
a SUSE Linux Enterprise Server

At the beginning of the planning process, you should try to define the project goals and
needed features. This must always be done individually for each project, but the questions
to answer should include the following;:

+ How many installations should be done? Depending on this, the best deployment
method differs. See also Chapter 5, Deployment Strategies (page 79).
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+ Will the system run as physical host, a virtual machine or as a virtual machine?

+ Will the system be in a hostile environment? Have a look at Chapter 1, Security
and Confidentiality (1 Security Guide) to get an overview of consequences.

+ How will you get regular updates? All patches are provided online for registered
users. Find the registration and patch support database at http: //www.novell
.com/linux/suse/portal/index.html.

+ Do you need help for your local installation? Novell provides training, support,
and consulting for all topics around SUSE Linux Enterprise Server. Find more in-
formation about this at http://www.novell.com/products/server/.

+ Do you need third-party products? Make sure that the required product is also
supported on the desired platform. Novell can also provide help to port software
to different platforms when needed.

1.2 Deployment of SUSE Linux
Enterprise Server

To make sure that your system will run flawlessly, always try to use certified hardware.
The hardware certification process is an ongoing process and the database of certified
hardware is updated regularly. Find the search form for certified hardware at http: //
developer.novell.com/yessearch/Search. jsp.

Depending on the number of desired installations, it is beneficial to use installation
servers or even completely automatic installations. Have a look at Chapter 5, Deployment
Strategies (page 79) for more information. When using the Xen virtualization technolo-
gies, network root file systems or network storage solutions like iSCSI should be con-
sidered.

SUSE Linux Enterprise Server provides you with a broad variety of services. Find an
overview of the documentation in this book in About This Guide (* Administration
Guide). Most of the needed configurations can be made with YaST, the SUSE configu-
ration utility. In addition to that, many manual configurations are described in the cor-
responding chapters.

Planning for
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In addition to the plain software installation, you should consider training the end users
of the systems as well as help desk staff.

1.3 Running SUSE Linux Enterprise
Server

The SUSE Linux Enterprise Server operating system is a well-tested and stable system.
Unfortunately, this does not prevent hardware failures or other causes for downtime or
data loss. For any serious computing task where data loss could occur, a regular backup
should be done.

For optimal security and safe work, you should make regular updates of all the operated
machines. If you have a mission critical server, you should probably run a second
identical machine where you can apply all changes for testing purposes before doing
so on the real system. This also gives you the possibility to switch machines in case of
hardware failure.
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Part I. Architecture Specific
Installation Considerations






Installation on x86, AMD64,
Intel 64, and Itanium

This chapter describes the steps necessary to prepare for the installation of SUSE Linux
Enterprise Server on x86, AMD64, Intel 64, and Itanium computers. It introduces the
steps required to prepare for various installation methods and provides useful informa-
tion. The list of hardware requirements provides an overview of supported systems
supported by SUSE Linux Enterprise Server. Find information about available installa-
tion methods and several common known problems. Also learn how to control the in-
stallation, provide installation media, and boot with regular methods.

2.1 Required Background

To keep the scope of these guidelines manageable, certain technical assumptions have
been made. It is assumed that:

* You have some computer experience and are familiar with common technical terms.

* You are familiar with the documentation for your system and the network on which
it runs.

* You have a basic understanding of Linux systems.

For an overview of the documentation available for your product and the latest docu-
mentation updates, refer to http://www.novell.com/documentation.

Installation on x86, AMDG64, Intel 64, and Itanium
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2.2 System Requirements for
Operating Linux

The SUSE® Linux Enterprise Server operating system can be operated on a wide range
of hardware. It is impossible to list all the different combinations of hardware SUSE
Linux Enterprise Server supports. However, to provide you with a guide to help you
during the planning phase, the minimum requirements are presented here.

If you want to be sure that a given computer configuration will work, find out which
computers have been certified by SUSE. Find a list of these computers at http: //
developer.novell.com/yessearch/Search. jsp.

2.2.1 Hardware for x86

Computers based on x86 constitute a cost-effective way of building high-performance
systems. The preconditions to operating SUSE Linux Enterprise Server on this platform
are as follows:

CPU
The number of CPUs supported depends on the kernel used. Specifically, these are
as follows:

Table 2.1 CPUs Supported by the Kernel

Kernel Oldest CPU Type Maximum Number of
CPUs

kernel-default PentiumPro, Athlon 32

kernel-pae Pentium II, Athlon XP 128

Memory Requirements
A minimum of 512 MB is required. The minimum recommended memory is 1 GB.
For a multiprocessor system, 256 MB per processor is required. Systems with less
than 1 GB main memory need additional swap space that extends the virtual
memory to 1 GB.

Deployment Guide
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Hard Disk Requirements
The disk requirements depend largely on the installation. Commonly, you need
more space than the installation software itself needs to have a system that works
properly. Minimal requirements for different selections are:

System Hard Disk Requirements
Minimal X Window System 1.2GB
GNOME Desktop 3.2GB
KDE Desktop 2.7 GB
All patterns 10 GB
Boot Methods

The computer can be booted for installation from DVD, USB hard drive, floppy,
or the network. A special boot server is required to boot over the network. This
boot server can be configured with SUSE Linux Enterprise Server. To use USB
hard drives, the BIOS or firmware must support booting from USB devices. Create
an bootable USB hard drive with mkbootdi sk, which is found on the first instal-
lation DVD in the directory /boot /1386 / or /boot /x86_64. For more infor-
mation, read the documentation below the /boot directory.

2.2.2 Hardware for Itanium

The Itanium architecture is 64-bit and allows operation of large servers.

CPU
Itanium II (older Itanium CPUs are no longer supported). Dual core CPUs and
hyperthreading are also supported.

Maximum Number of CPUs
At most, 4096 CPUs are supported. For the calculation of the CPU count, a dual-
core CPU counts as two CPUs and a hyperthreaded CPU with two siblings also
counts as two CPUs. 1024 CPUs could mean 512 dual cores, 512 single cores with
hyperthreading, or 256 dual cores with hyperthreading.

Installation on x86, AMDG64, Intel 64, and Itanium
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Memory
A minimum of 1GB RAM per CPU socket is recommended.

Hard Disk Requirements
The disk requirements depend largely on the installation selected. Commonly, you
need more space than the installed software itself needs to have a system that works
properly. Minimal requirements for different selections are:

System Hard Disk Requirements
Minimal System 4 GB
Recommended 10 GB

Boot Methods

Options for booting the computer depend on the available hardware. All boot
methods available to the machine should work. A special boot server is required
to use PXE boot over the network. This may also be set up with SUSE Linux En-
terprise Server.

2.2.3 Hardware for AMD64 and Intel 64

The AMD64 and Intel 64 architectures support the simple migration of x86 software
to 64 bits. Like the x86 architecture, they constitute a value-for-money alternative.

CPU
All CPUs available on the market to date are supported. This includes dual-core
CPUs.

Maximum Number of CPUs
The maximum number of CPUs supported by AMD64 and Intel 64 is 128.

Memory Requirements
A minimum of 512 MB of memory is required. Requirements depend on the appli-
cation. However, the minimum recommended is 1024 MB or 512 MB per CPU on
multiprocessor computers. The theoretical upper limit on the amount of memory
supported by the kernel is 512 GB.
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Hard Disk Requirements
The disk requirements depend largely on the installation selected. The required
space for this architecture is similar to x86 but you should plan some space for
compatibility libraries. Minimum requirements for different selections are:

System Hard Disk Requirements
Minimal X Window System 1.4GB
GNOME Desktop 3.5GB
KDE Desktop 3GB
All patterns 8.5 GB
Boot Methods

The computer can be booted from CD or network. A special boot server is required
to boot over the network. This can be set up with SUSE Linux Enterprise Server.

2.3 Installation Considerations

This section encompasses many decisions that need to be made before installing SUSE
Linux Enterprise Server on x86, AMD64, Intel 64, and Itanium hardware.

2.3.1 Installation Type

SUSE Linux Enterprise Server is normally installed as an independent operating system.
With the introduction of Xen, it is also possible to run multiple instances of SUSE
Linux Enterprise Server on the same hardware. However, the controlling Domain-0
installation for Xen is performed like a typical installation with some additional packages.
The installation of Xen guests is described in Chapter 3, Setting Up Virtual Machines
(1 Virtualization with Xen).

Installation on x86, AMDG64, Intel 64, and Itanium
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2.3.2 Boot Methods

Depending on the hardware used, the following boot methods are available for the first
boot procedure prior to the installation of SUSE Linux Enterprise Server:

Table 2.2 Boot Options

Boot Option Use

CD or DVD drive  The simplest booting method. The system requires a locally-
available CD-ROM or DVD-ROM drive for this.

Floppy or USB Find the images required for creating boot disks on the first CD

disks or DVD in the /boot directory. See also the README in the
same directory. Booting from a USB memory stick is only
possible if the BIOS of the machine supports booting from it.

PXE or bootp Must be supported by the BIOS or by the firmware of the system
used. This option requires a boot server in the network. This
task can be handled by a separate SUSE Linux Enterprise
Server.

Hard disk SUSE Linux Enterprise Server can also be booted from hard

disk. For this, copy the kernel (1inux) and the installation
system (initrd) from the /boot/loader directory of the
first CD or DVD onto the hard disk and add an appropriate entry
to the boot loader.

2.3.3 Installation Source

When installing SUSE Linux Enterprise Server, the actual installation data must be
available in the network, on a hard disk partition, or on a local DVD. To install from
the network, you need an installation sever. To make the installation data available, set
up any computer in a Unix or Linux environment as an NFS, HTTP, SMB, or FTP
server. To make the installation data available from a Windows computer, release the

data with SMB.
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The installation source is particularly easy to select if you configure an SLP server in
the local network. For more information, see Section 14.2, “Setting Up the Server
Holding the Installation Sources” (page 202).

2.3.4 Installation Target

Most installations are to a local hard disk. Therefore, it is necessary for the hard disk
controllers to be available to the installation system. If a special controller, like a RAID
controller, needs an extra kernel module, provide a kernel module update disk to the
installation system.

Other installation targets may be all kinds of block devices that provide sufficient disk
space and speed to run an operating system. This includes network block devices like
1SCST or SAN. It is also possible to install on network file systems that offer the
standard Unix permissions. However, it may be problematic to boot these, because they
must be supported by the initramfs before the actual system can start. Such instal-
lations are useful if there is a need to start the same system in different locations or if
you intend to use Xen features like domain migration.

2.3.5 Different Installation Methods

SUSE Linux Enterprise Server offers several different methods for controlling installa-
tion:

+ Installation on the console

+ Installation via serial console
+ Installation with AutoYaST

+ Installation with KIWI images
+ Installation via SSH

+ Installation with VNC

By default, the graphical console is used. If you have a large number of similar computers
to install, it is advisable to create an AutoYaST configuration file or a KIWI preload
image and make this available to the installation process. See also the documentation

Installation on x86, AMDG64, Intel 64, and Itanium
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for autoyast2 in Chapter 21, Automated Installation (page 289) and KIWI in Chap-
ter 17, KIWI (page 259).

2.4 Boot and Installation Media

When installing the system, the media for booting and for installing the system may be
different. All combinations of supported media for booting and installing may be used.

2.4.1 Boot Media

Booting a computer depends on the capabilities of the hardware used and the availabil-
ity of media for the respective boot option.

Booting from DVD
This is the most common possibility of booting a system. It is straightforward for
most computer users, but requires a lot of interaction for every installation process.

Booting from a USB Hard Drive or Floppy Disk
Depending on the hardware used, it is possible to boot from a USB hard drive or
a floppy disk. The respective media must be created with the utility mkbootdisk,
which can be found together with its documentation on the first CD or DVD in the
directory /boot/<architecture>.

Booting from the Network
You can only boot a computer directly from the network if this is supported by the
computer's firmware or BIOS. This booting method requires a boot server that
provides the needed boot images over the network. The exact protocol depends on
your hardware. Commonly you need several services, such as tftp and dhcp or
pxeboot. If you need a boot server, also read Section 14.1.3, “Remote Installation
via VNC—PXE Boot and Wake on LAN” (page 197).

2.4.2 Installation Media

The installation media contain all the necessary packages and meta information that is
necessary to install a SUSE Linux Enterprise Server. These must be available to the
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installation system after booting for installation. Several possibilities to provide the
installation media to the system are available with SUSE Linux Enterprise Server.

Installation from DVD
All necessary data is delivered on the boot media. Depending on the selected instal-
lation, a network connection or add on media may be necessary.

Networked Installation
If you plan to install several systems, providing the installation media over the
network makes things a lot easier. It is possible to install from many common
protocols, such as NFS, HTTP, FTP, or SMB. For more information about how to
run such an installation, refer to Chapter 14, Remote Installation (page 193).

2.5 Installation Procedure

This section offers an overview of the steps required for the complete installation of
SUSE® Linux Enterprise Server in the required mode. Part II, “Manual Deployment”
(page 77) contains a full description of how to install and configure the system with
YaST.

2.5.1 Booting from a Local Interchangeable
Drive

CD-ROM and floppy drives and USB memory sticks can be used for installation pur-
poses. Adjust your computer to your needs:

1. Make sure that the drive is entered as a bootable drive in the BIOS.
2. Insert the boot medium in the drive and start the boot procedure.

3. The boot menu of the CD, DVD, floppy, or USB disk allows transferring different
parameters to the installation system. See also Section 14.4.2, “Using Custom Boot
Options” (page 223). If the installation should be performed over the network,
specify the installation source here.

4. If unexpected problems arise during installation, use safe settings to boot.
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2.5.2 Installing over the Network

An installation server is required to perform the installation by using a network source.
The procedure for installing this server is outlined in Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 202).

If you have an SLP server, select SLP as the installation source in the first boot screen.
During the boot procedure, select which of the available installation sources to use.

If the DVD is available in the network, use it as an installation source. In this case,
specify the parameter install=<URL> with suitable values at the boot prompt. Find
a more detailed description of this parameter in Section 14.4.2, “Using Custom Boot
Options” (page 223).

2.6 Controlling the Installation

Control the installation in one of several ways. The method most frequently used is to
install SUSE® Linux Enterprise Server from the computer console. Other options are
available for different situations. Find more information about the available installation
methods in Chapter 5, Deployment Strategies (page 79).

2.6.1 Installation on the Computer Console

The simplest way to install SUSE Linux Enterprise Server is using the computer console.
With this method, a graphical installation program guides you through the installation.
This installation method is discussed in detail in Chapter 6, Installation with YaST

(page 89).

You can still perform the installation on the console without a working graphics mode.
The text-based installation program offers the same functionality as the graphical version.
Find some hints about navigation in this mode in Section “Navigation in Modules”
(Chapter 3, YaST in Text Mode, t Administration Guide).

Deployment Guide



2.6.2 Installation Using a Serial Console

For this installation method, you need a second computer that is connected by a null
modem cable to the computer on which to install SUSE Linux Enterprise Server. De-
pending on the hardware, even the firmware or BIOS of the computer may already be
accessible to the serial console. If this is possible, you can carry out the entire installation
using this method. To activate the serial console installation, additionally specify the
parameter console=ttyS0 at the boot prompt after the boot process has completed
and before the installation system starts.

On most computers, there are two serial interfaces, #£yS0 and #£yS1. For the installation,
you need a terminal program like minicom or screen. To initiate the serial connection,
launch the screen program in a local console by entering the following command:

screen /dev/ttyS0 9600

This means that screen listens to the first serial port with a baud rate of 9600. From this
point on, the installation proceeds similarly to the text-based installation over this ter-
minal.

2.6.3 Installation with SSH

If you do not have direct access to the computer hardware and, for example, the instal-
lation should be launched from a management console, control the entire installation
process over the network. To do this, enter the parameters UseSSH=1 and
SSHPassword=<secret> at the boot prompt. An SSH daemon is then launched in
the system and you can log in to the system as user root with the password “secret”.
To connect, use the command ssh —-X root@<ipaddr>.

If you do not have a DHCP server available in your local network, manually assign an
IP address to the installation system. Do this by entering the option
HostIP=<ipaddr> at the boot prompt.

As soon as you are logged in to the installation system, launch the actual installation
with the command yast for a text-based installation or yast 2 to proceed with the
graphical installation. This then guides you through the installation. This procedure is
described in detail in Section 14.1.5, “Simple Remote Installation via SSH—Dynamic
Network Configuration” (page 199).
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2.6.4 Installation over VNC

If you do not have direct access to the system, but want a graphical installation, install
SUSE Linux Enterprise Server over VNC. This method is described in detail in Sec-
tion 14.5.1, “VNC Installation” (page 226).

As suitable VNC clients are also available for other operating systems, such as Microsoft
Windows and MacOS, the installation can also be controlled from computers running
those operating systems.

2.6.5 Installation with AutoYaST

If you need to install SUSE Linux Enterprise Server on a number of computers with
similar hardware, it is recommended to perform the installations with the aid of Auto-
YaST. In this case, start by installing one SUSE Linux Enterprise Server and use this
to create the necessary AutoYaST configuration files.

AutoYaST is extensively documented in Chapter 21, Automated Installation (page 289).

2.7 Dealing with Boot and Installation
Problems

Prior to delivery, SUSE® Linux Enterprise Server is subjected to an extensive test
program. Despite this, problems occasionally occur during boot or installation.

2.7.1 Problems Booting

Boot problems may prevent the YaST installer from starting on your system. Another
symptom is when your system does not boot after the installation has been completed.

Installed System Boots, Not Media
Change your computer's firmware or BIOS so that the boot sequence is correct. To
do this, consult the manual for your hardware.
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The Computer Hangs
Change the console on your computer so that the kernel outputs are visible. Be sure
to check the last outputs. This is normally done by pressing Ctrl + Alt + F10. If you
are unable to resolve the problem, consult the SUSE Linux Enterprise Server support
staff. To log all system messages at boot time, use a serial connection as described
in Section 2.6, “Controlling the Installation” (page 16).

The Itanium Boot Loader
If you have manually altered the kernel or initrd on your system, run
/sbin/elilo before shutting down the computer. If you leave out this step,
your system may not be bootable.

Boot Disk
The boot disk is a useful interim solution if you have difficulties configuring the
other possibilities or if you want to postpone the decision regarding the final boot
mechanism. A boot disk may also be a suitable solution in connection with OS/2
or Windows NT. Fore more details on creating boot disks, see Section “Creating
Boot CDs” (Chapter 9, The Boot Loader GRUB, t Administration Guide).

Virus Warning after Installation
There are BIOS variants that check the structure of the boot sector (MBR) and er-
roneously display a virus warning after the installation of GRUB or LILO. Solve
this problem by entering the BIOS and looking for corresponding adjustable settings.
For example, switch off virus protection. You can switch this option back on again
later. It is unnecessary, however, if Linux is the only operating system you use.

2.7.2 Problems Installing

If an unexpected problem occurs during installation, information is needed to determine
the cause of the problem. Use the following directions to find useful information:

+ Check the outputs on the various consoles. You can switch consoles with the key
combination Ctrl + Alt + Fn. For example, obtain a shell in which to execute various
commands by pressing Ctrl + Alt + F2.

+ Try launching the installation in failsafe mode. If the installation works without
problems in this case, there is an incompatibility that causes either ACPT or APIC
to fail. In some cases, a BIOS or firmware update fixes this problem.
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+ Check the system messages on a console in the installation system by entering the
command dmesg.

2.7.3 Redirecting the Boot Source to the
Boot DVD

To facilitate the installation process and avoid accidental installations, the default setting
on the installation DVD for SUSE Linux Enterprise Server is that your system is booted
from the first hard disk. At this point, an installed boot loader normally takes over
control of the system. This means that the boot DVD can stay in the drive during an
installation. To start the installation, choose one of the installation possibilities in the
boot menu of the media.
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Installation on IBM POWER

This chapter describes the procedure for preparing the installation of SUSE® Linux
Enterprise Server on IBM POWER systems.

3.1 Requirements

3.1.1 Hardware Requirements

The SUSE® Linux Enterprise Server operating system can be operated on a wide range
of hardware. To provide you with a guide to help you during the planning phase, the
minimum requirements are presented here.

If you want to be sure that a given computer configuration will work, find out which
computers have been certified by SUSE. Find a list of these computers at http://
developer.novell.com/yessearch/Search. jsp.

pSeries and System p Models
These systems are operated with a PPC64 kernel.

Table 3.1 Supported Models

pSeries models p615, p630, p650, p655, p670, P690
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eServer p5, System p, OpenPower, and 505, 510, 520, 550, 560Q, 570, 570+, 575,
ATX Server models 575+, 590, 595, 710, 720, 185

ATX Workstation 185

All POWER3 and RS64-based models that were supported by SUSE Linux Enterprise
Server 9 are no longer supported.

A standard installation requires at least 256 MB of RAM. The installation of a standard
system requires at least 2.0 GB of free hard disk space.

Up-to-date hardware information for Linux on System p is available by model from
http://www-03.ibm.com/systems/p/linux/.

BladeCenter

BladeCenter JS12, BladeCenter JS20, BladeCenter JS21, and BladeCenter JS22 are
supported systems.

3.1.2 Software Requirements

IBM pSeries, IBM eServer p5, System p, OpenPower

Find up-to-date firmwareat http://www—912.ibm.com/eserver/support/
fixes/fixcentral. Select UNIX servers and Hardware microcode and firmware
to find your system model. Updates for the Hardware Management Console can also
be selected from this page.

JSxx BladeCenter

Find up-to-date firmware for the BladeCenter at http: //www—304.ibm.com/
systems/support/supportsite.wss/docdisplay?lndocid=

MIGR-63017&brandind=5000020 (Software and device drivers — IBM Blade-
Center).
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3.2 Preparation

This section describes the preparatory steps that must be taken before the actual instal-
lation. The installation procedure depends on the system used. See the following docu-
mentation:

» For IBM eServer p5 Systems, see Section 3.2.1, “Preparing for Installation on IBM
eServer p5, System p, and OpenPower Models” (page 24)

+ For IBM pSeries systems, see Section 3.2.2, “Preparing for Installation on IBM
pSeries Models” (page 30)

» For IBM JS20/JS21/JS22 Blades, see Section 3.2.3, “Preparing an Installation on
IBM JSxx BladeCenter” (page 34)

If SUSE® Linux Enterprise Server should be installed on a number of systems or par-
titions, it is recommended to create a network installation source. The same source can
also be used for the concurrent installation on several partitions or several systems. The
configuration of a network installation source is described in Section 14.2.1, “Setting
Up an Installation Server Using YaST” (page 202).

The installation can be controlled with a VNC client. For more information about VNC,
see Section 14.1.1, “Simple Remote Installation via VNC—Static Network Configura-
tion” (page 194).

To participate in the 1inuxppc—-dev mailing list, sign up using the forms at
https://ozlabs.org/mailman/listinfo/linuxppc—dev. The following
links are interesting for the maintenance of an installation:

* http://www.novell.com/suselinuxportal isan effective help tool
for assisting customers in solving problems. A corresponding article is published
whenever SUSE discover that a special case could lead to serious problems. Search
the portal using keywords like PPC or POWER.

* Find security alerts at http://www.novell.com/linux/security/
securitysupport.html. SUSE also maintains two security-related mailing
lists to which anyone may subscribe.

* suse-secur ity — General discussion of security regarding Linux and SUSE.
All security alerts for SUSE Linux Enterprise Server are sent to this list.

Installation on IBM POWER

23


https://ozlabs.org/mailman/listinfo/linuxppc-dev
http://www.novell.com/suselinuxportal
http://www.novell.com/linux/security/securitysupport.html
http://www.novell.com/linux/security/securitysupport.html

24

* suse-security-announce — The SUSE mailing list exclusively for secu-
rity alerts.

3.2.1 Preparing for Installation on IBM
eServer p5, System p, and OpenPower
Models

This section covers the preparatory steps for installing SUSE® Linux Enterprise Server
on IBM eServer p5 systems. It explains the installation from a built-in CD-ROM drive
and over the network.

This section assumes you have set up your HMC and connected it to your system. Find
more information about using the wizard to configure the HMC in “Configuring the
HMC using the Guided Setup Wizard”: http://publib.boulder.ibm.com/

infocenter/systems/scope/hw/topic/iphai_p5/confighmcgs.htm
?

Modern Features of IBM eServer p5 Systems

IBM eServer p5 systems offer the possibility to partition the system. This enables the
concurrent operation of up to 254 operating systems on one machine. These operating
systems are installed in LPARs (logical partitions). One or several of these partitions
can contain a SUSE Linux Enterprise Server environment.

To prepare an LPAR for SUSE Linux Enterprise Server, first configure the system over
the HMC. Refer to the IBM documentation for details: http://publib.boulder
.1bm.com/infocenter/systems/scope/hw/topic/iphbi/
iphbikickoff.htm

Hard Disk Space

Make sure that you have sufficient hard disk space for installing SUSE Linux Enterprise
Server. The standard system requires at least 4 GB of free hard disk space.
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Assigning an Installation Device to an LPAR

SUSE Linux Enterprise Server can be installed from a CD-ROM or DVD drive or using
a network installation source. Make the CD-ROM, DVD drive, or network device
available to the LPAR to install.

Figure 3.1 HMC: Server Management—Properties
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Procedure 3.1 Assigning a CD-ROM or DVD Drive to an LPAR

1 Open the HMC application and go to Server and Partition > Server Management.

2 From the available servers, expand the server and partition to install.

3 Right-click the profile to use for installation and select Properties—see Figure 3.1,

“HMC: Server Management—Properties” (page 25).

4 In the Logical Partition Profile Properties dialog, select the Physical 1/0 tab.

5 From Managed system /0 devices, select the Other Mass Storage Controller
from the bus where it is installed. To assign this DVD drive to the partition, click
Add as required.

The result should look like Figure 3.2, “HMC: Managed System I/O Devices” (page 26).
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Figure 3.2 HMC: Managed System I/O Devices
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Now insert the SUSE Linux Enterprise Server CD1 or DVDI1 in the drive.

Procedure 3.2 Assigning a Network Device to an LPAR

1 Openthe HMC application and go to Server and Partition > Server Management.

2 From the available servers, open the server and partition to install.

3 Right-click the profile to use for installation and select Properties—see Figure 3.1,
“HMC: Server Management—Properties” (page 25).

4 In the Logical Partition Profile Properties dialog, select the Physical 1/0 tab.

5 From Managed system I/0 devices, select PCI 10/100/1000Mbps Ethernet UTP
2-port from the bus where it is installed. Then click Add as required.

If you plan to install using a virtual ethernet adapter, refer to the IBM documen-

tation.
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Create a network installation source if SUSE Linux Enterprise Server should be installed
on a number of partitions. This eliminates the need to change CDs during installation.
The same source can also be used for concurrent installation of various systems. The
configuration of the network installation source is described in Section 14.2.1, “Setting
Up an Installation Server Using YaST” (page 202).

Starting the Installation

To start the installation, reboot the system. Right-click the profile name, select Activate,
and press OK in the following dialog.

Use the screen console or connect to a serial console as described in the IBM documen-
tation. One simple way to start a serial console is to open a VTerm while activating the
partition. To do this, activate Open a terminal window or console session in the Activate
Logical Partition dialog.

Enter the system firmware by pressing F1 or 1 when using a serial console or a virtual
console during the system check when the system is rebooted:

IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM

1 = SMS Menu 5 = Default Boot List
8 = Open Firmware Prompt 6 = Stored Boot List
memory keyboard network scsi speaker

Press F1 or 1 while the SCSI devices are checked. Select 5. Select Boot Options to enter
the boot options dialog;:

Version SF220_004

SMS 1.5 (c) Copyright IBM Corp. 2000,2003 All rights reserved.
Main Menu

1. Select Language

2. Setup Remote IPL (Initial Program Load)

3. Change SCSI Settings
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4. Select Console
5. Select Boot Options

Type the number of the menu item and press Enter or select Navigation
Key:5

Select 1. Select Install/Boot Device to set the Install Device. Go to 7. List all Devices
to see the list of available devices:

Version SF220_011
SMS 1.5 (c) Copyright IBM Corp. 2000,2003 All rights reserved.

Select Device
Device Current Device
Number Position Name

1. - Virtual Ethernet
( 1loc=U09111.520.10D3CCC-V1-C3-T1 )
2. - Ethernet
( loc=U787A.001.DNZ00XG-P1-T5 )
3. - Ethernet
( 1oc=U787A.001.DNZ00XG-P1-T6 )
4. - IDE CD-ROM
( 1loc=U787A.001.DNZ00XG-P4-D3 )
5. 1 SCSI 73407 MB Harddisk

( 1loc=U787A.001.DNZ00XG-P1-T10-L8-L0 )

Navigation keys:
M = return to Main Menu
ESC key = return to previous screen X = eXit System Management Services

Type the number of the menu item and press Enter or select Navigation Key:

Booting from the CD-ROM Drive

Select the CD-ROM drive (4 in this example):

SMS 1.5 (c) Copyright IBM Corp. 2000,2003 All rights reserved.

Select Task

IDE CD-ROM
( 1oc=U787A.001.DNZ00XG-P4-D3 )
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1. Information
2. Normal Mode Boot
3. Service Mode Boot

Navigation keys:
M = return to Main Menu
ESC key = return to previous screen X = eXit System Management Services

Type the number of the menu item and press Enter or select Navigation Key:

Choose 2. Normal Mode Boot to install from this device. On the next screen, confirm
with 1. Yes to exit System Management Services and boot from the device.

The system reads from the CD-ROM drive and the yaboot utility starts:

Welcome to SuSE:SLE-11:GA!

Type "install" +to start the YaST installer on this CD/DVD
Type "slp" to start the YaST install via network
Type "rescue" to start the rescue system on this CD/DVD

Welcome to yaboot version 1.3.11.SuSE
Enter "help" to get some basic usage information
boot:

Type install and press Enter.

To read the installation data from a network install source rather than continuing the
installation from the CD-ROM (see Section “Assigning an Installation Device to an
LPAR” (page 25)), append the option manual to the name of the kernel (install).

For an installation over VNC, append the parameters vnc=1 and
vncpassword=passwordto the name of the kernel (install). Read more about
VNCin Section 14.1.1, “Simple Remote Installation via VNC—Static Network Confi-
guration” (page 194).

Booting from the Network Source

Select an ethernet device that has access to the installation source (2 in this example).
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Additional Steps

Proceed as described in Chapter 6, Installation with YaST (page 89) to begin installing
the software with linuxrc and YaST.

3.2.2 Preparing for Installation on IBM
pSeries Models

This section covers the preparatory steps for installing SUSE® Linux Enterprise Server
on pSeries systems. It explains the installation from a built-in CD-ROM drive or a
network source.

Special Features of IBM pSeries p630, p655, p670, and
p690

IBM p630, p655, p670, and p690 systems offer the possibility to statically partition the
system similarly to eServer p5/System p5 (which is described in Section 3.2.1,
“Preparing for Installation on IBM eServer p5, System p, and OpenPower Models”
(page 24)). This enables the concurrent operation of up to 16 operating systems on one
machine. These operating systems are installed in LPARs (logical partitions). One or
several of these partitions can contain a SUSE Linux Enterprise Server environment.

To prepare an LPAR for SUSE Linux Enterprise Server, first configure the system over
the HMC. Refer to the Redbook IBM eServer pSeries 690 System Handbook (SG24-
7040-00) for details (http://www.redbooks.ibm.com/redbooks/
SG247040/).

Important notes regarding the configuration:

* The recommended maximum number of processors for a SUSE Linux Enterprise
Server LPAR is eight, because the kernel can only manage eight processors effec-
tively.

+ For the installation, select SMS as the boot mode for the respective partition.
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» The HMC terminal used for the input during the installation is a VT320 emulation.
This emulation can lead to strange effects with some applications. If possible, use
an XTerm for communicating with the LPAR.

Hard Disk Space

Make sure that you have sufficient hard disk space for installing SUSE Linux Enterprise
Server. The use of a separate hard disk is recommended.

SUSE Linux also supports installing to Fibre Channel-attached storage. Before beginning
installation, the Fibre Channel Host Bus Adapter (FCHBA), SAN fabric, and storage
system must each be configured to provide access from the FCHBA through the SAN
Fabric to target logical units (LUNSs) on the storage system.

SAN storage devices, if properly configured, are listed among existing hard disks on
your system. Create Custom Partitioning Setup opens the dialog, as described in Sec-
tion 15.1, “Using the YaST Partitioner” (page 231).

For more information, see http://publib.boulder.ibm.com/infocenter/
eserver/vlr2s/en_US/index.htm?info/iphai/confighmcgs.htm.

Setting Up the Installation Source

If you plan to install from CD-ROM, insert CD1 in the drive. In LPAR mode, the par-
tition to install must have the CD-ROM in its partition profile. Create a network instal-
lation source if SUSE Linux Enterprise Server should be installed over a number of
partitions. This eliminates the need to change CDs during installation. The same source
can also be used for concurrent installation of various systems. The configuration of
the network installation source is described in Section 14.2.1, “Setting Up an Installation
Server Using YaST” (page 202).

Starting the Installation

To start the installation, reboot the system. Then enter the system firmware by pressing
F1 or 1 when using the serial console during the system check when the system is re-
booted. See Figure 3.3, “Entering the System Firmware” (page 32).
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Figure 3.3 Entering the System Firmware

1 = SMS Menu 5 = Default Boot List
8 = Open Firmware Prompt 6 Stored Boot List

memory keyboard network scsi speaker

Press F1 or 1 while the SCSI devices are checked. Select 6 MultiBoot to enter the
Multiboot dialog. See Figure 3.4, “Multiboot Dialog” (page 32)

Figure 3.4 Multiboot Dialog

Version M2P01113
(c) Copyright IBM Corp. 2000 All rights reserved.

Multiboot

Select Software
Software Default
Select Install Device
Select Boot Devices

OK Prompt

Multiboot Startup <ON>

O U W N

| X=Exit|

—==>3
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Select 3 to set the install device. A list of available devices is displayed. See Figure 3.5,
“Installing the Operating System” (page 33).

Figure 3.5 Installing the Operating System

Install Operating System

Device Device
Number Name
1 Diskette

2 SCSI Tape id=0 ( slot=50322fb5a )

3 SCSI CD-ROM id=1 ( slot=50322f5a )

4 Ethernet ( Integrated )

5 SysKonnect PCI FDDI Adapter ( slot=4 )
6 Ethernet ( slot=2 )

7 None

===>3

Booting from the CD-ROM Drive

Select the respective CD-ROM drive (3 in this example). The system reads from the
CD-ROM drive and displays the identstring.

->1 SuSE:SLE-11:GA<—

After you select 1, the yaboot utility is started.

Welcome to SuSE:SLE-11:GA!
Type "install" +to start the YaST installer on this CD/DVD

Type "slp" to start the YaST install via network
Type "rescue" to start the rescue system on this CD/DVD

Type install and press Enter. Alternatively, just press Enter to start the installer, the
default option.
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To install from a network source (see Section “Setting Up the Installation Source”
(page 31)), append manual to the kernel to install. For an installation over VNC,
append the parameters vnc=1 and vncpassword=passwordto install. Read
more about VNC in Section 14.1.1, “Simple Remote Installation via VNC—Static
Network Configuration” (page 194).

In LPAR mode, the partition to install must have the CD-ROM in its partition profile.

Booting from the Network Source

Select an ethernet device that has access to the installation source (6 in this example).

Additional Steps

Proceed as described in Chapter 6, Installation with YaST (page 89) to begin installing
the software with linuxrc and YaST.

3.2.3 Preparing an Installation on IBM JSxx
BladeCenter

This section describes the preparatory steps for the installation of SUSE® Linux Enter-
prise Server on JSxx Blades. It covers installation using the CD-ROM drive of the
BladeCenter and using the network.

Creating a Network Installation Source

Create a network installation source if SUSE Linux Enterprise Server should be installed
over a number of partitions. This provides the advantage that no CDs need to be changed
during installation. The same source can also be used for the concurrent installation of
various systems. Configuration of a network installation source is described in Sec-
tion 14.2.1, “Setting Up an Installation Server Using YaST” (page 202).

Hard Disk Storage Space

Ensure that enough hard disk storage space is available for the installation of SUSE
Linux Enterprise Server. It is recommended to use a dedicated hard disk.
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Notes and Information

Introductory Information:

* JSxx Blades Site: https://www—304.1ibm.com/systems/support/
supportsite.wss/brandmain?brandind=5000020

Preparing the System for Boot

Preparing to Boot from the CD-ROM Drive
Perform the steps described in this section if an installation from CD-ROM is desired.

Assign the CD-ROM drive to the Blade chosen for installation by connecting with a
Web browser to a BladeCenter Management Module then logging in. After login, select
the function Remote Control in the menu Blade Tasks then activate Start Remote Control.
Assign the CD-ROM drive to the desired blade in the menu Change Media Tray Owner
of the new window.

Then set up the CD-ROM drive as a boot device. Do this by selecting Blade Tasks then
Configuration while in the BladeCenter Management Module. Then select the JSxx
Blade in the section Boot Sequence. Set the entry for 1st Device on the page for Blade
Boot Sequence to CDROM.

Put CD 1 in the CD-ROM drive and restart the blade.

Preparing to Boot from the Network

Perform the steps as described in this section if an installation over the network is de-
sired.

Connect to the BladeCenter Management Module using a Web browser and log in. Set
the boot device to the network by accessing the Configuration menu from the Blade
Tasks page. Then select the JSxx Blade in the section Boot Sequence and set 1st Boot
Device to Network — BOOTP on Blade Boot Sequence.
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Rebooting and Connecting to the Console of the JSxx Blade

Reboot the JSxx Blade from the item Power/Restart of the Blade Tasks menu in the
BladeCenter Management Module. A table appears, showing the power status of the
blades in the Pwr column. Mark the check box of the desired blade and restart it with
Power On Blade.

Connect to the BladeCenter with the command telnet bladecenter and log in.

username: user
password: ***xxkokokk
system>

The command env -T system:blade[bay number] determines for which
JSxx Blade the subsequent commands are intended. The blades installed in the Blade-
Center are listed by calling 1ist -1 3.

system> list -1 3
system
mm[1] primary
power [1]
power [2]
power [3]
power [4]
blower[1]
blower [2]
switch[1]
switch[3]
blade[1]
sp
cpull]
cpul2]
blade[3]
sp
blade[4]
sp
blade[6]
sp
blade[8]
sp
cpull]
cpul?2]
blade[9]
sp
cpull]
cpul2]
blade[10]
sp
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blade[11]
sp
blade[13]
sp
mt
system>

The command target is then determined. To work, for example, with blade number 9,
enter env —-T system:blade[9]. Connect with the console of the JSxx Blade
over Serial over LAN (SOL) with the command console.

system> env -T system:blade[9]
OK
system:blade[9]> console

Starting the Installation

The SUSE Linux Enterprise Server boot loader starts after the system check has com-
pleted.

Welcome to SuSE:SLE-11:GA!

Type "install" +to start the YaST installer on this CD/DVD

Type "slp" to start the YaST install via network

Type "rescue" to start the rescue system on this CD/DVD
Welcome to yaboot version 1.3.11.SuSE

Enter "help" to get some basic usage information
boot:

Select install from the menu and press Enter.

In the case of an installation over VNC, append the parameters vnc=1 and
vncpassword=password to the command line for the kernel (install).

Additional Steps

Proceed as described in Chapter 6, Installation with YaST (page 89) to begin installing
the software with linuxrc and YaST.

Installation on IBM POWER

37






Installation on IBM System z

This chapter describes the procedure for preparing the installation of SUSE® Linux
Enterprise Server on IBM System z systems. It provides all information needed to
prepare the installation on the LPAR and z/VM side.

4.1 General Information and
Requirements

This section gives basic information about the system requirements, like supported
hardware, level of MicroCode, and software. It also covers the different installation
types, how to do an IPL for the first installation, and information about the IOCDS.

4.1.1 System Requirements

This section provides a list of hardware for IBM System z supported by SUSE Linux
Enterprise Server. Next, the level of the MicroCode (MCL) used in your IBM System
z system, which is very important for the installation, is covered. Additional software
to install and use for installation is mentioned at the end of this section.

Hardware
SUSE Linux Enterprise Server has run successfully on the following platforms:

+ IBM Series 79 (z9-EC) 2094

Installation on IBM System z
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« IBM Series z9 (z9-BC) 2096
+ IBM Series z10 (z10-EC) 2097

« IBM Series z10 (z10-BC) 2098

Memory Requirements

Different installation methods have different memory requirements during installation.
After installation is completed, the system administrator may reduce memory to the
desired size. SUSE recommends using;:

768 MB For installation under z/VM.

1 GB For installation under LPAR.

NOTE: Memory Requirements with Remote Installation Sources

for installation from NFS, FTP, or SMB installation sources or whenever VNC is
used, 512MB of memory is required as a minimum, otherwise the installation
attempt is likely to fail. Further note that the number of devices visible to the
z/VM guest or LPAR image affects memory requirements. Installation with liter-
ally hundreds of accessible devices (even if unused for the installation) may
require more memory.

Disk Space Requirements

The disk requirements depend largely on the installation. Commonly, you need more
space than the installation software itself needs to have a system that works properly.
Minimal requirements for different selections are:

2.6 GB Default Installation

3.6 GB+ Recommended (this is with graphical desktop, develop-
ment packages and java).
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Network Connection

A network connection is needed to communicate with your SUSE Linux Enterprise
Server system. This can be one or more of the following connections or network cards:

» OSA Express Ethernet (including Fast and Gigabit Ethernet)
» HiperSockets or Guest LAN
+ 10 GBE, VSWITCH
The following interfaces are still included, but no longer supported:
» CTC (or virtual CTC)
+ ESCON

» IP network interface for [IUCV

IPL Options

For an LPAR installation, the Load from CD-ROM or Server option is the preferred
way to IPL the installation kernel and initrd (initial RAM disk). If this option is not
available and you cannot use z/VM for installing the system, you need to IPL from a
channel attached tape with the tapeipl kernel, the parmfile, and the initrd. Thus, you
need access to a tape unit (3480, 3490, or 3590, for example).

MicroCode Level, APARs, and Fixes

This release of SUSE Linux Enterprise Server is based on the May 2008 codestream
from IBM developerWorks (http: //www.ibm.com/developerworks/linux/
1linux390/development_recommended.html). The restrictions and require-
ments listed at the Web site also apply for this release of SUSE Linux Enterprise
Server, except where stated differently in this manual. It is recommended always to use
the highest service level available. Contact your IBM support for minimum requirements.
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VM/ESA and z/VM
Z/VM 5.2
zZ/VGM 5.3
Z/VM 5.4

Negotiate the order of installation with your IBM support, because it might be necessary
to activate the VM APARs before installing the new MicroCode levels.

Software

To install SUSE Linux Enterprise Server via non-Linux—based NFS or FTP, you might
experience problems with NFS or FTP server software. Especially the Windows standard
FTP server can cause errors, so installing via SMB on these machines is generally rec-
ommended.

To connect to the SUSE Linux Enterprise Server installation system, one of the following
methods is required:

SSH with Terminal Emulation (xterm compatible)
SSH is a standard Unix tool that should be present on any Unix or Linux system.
For Windows, there is an SSH client called Putty. It is free to use and is available
from http://www.chiark.greenend.org.uk/~sgtatham/putty/.

VNC Client
For Linux, a VNC client called vncviewer is included in SUSE Linux Enterprise
Server as part of the t i ght vnc package. For Windows, tightvnc is also available.
Downloaditfromhttp://www.tightvnc.com/. Alternatively, use the VNC
Java client and a Java-enabled Web browser.

X Server
Find a suitable X server implementation on any Linux or Unix workstation. There
are many commercial X Window System environments for Windows and Macintosh.
Some of them can be downloaded as free trial versions. A trial version of the Mocha
X Server from MochaSoft can be obtained at http://www.mochasoft.dk/
freeware/x11.htm.
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TIP: Additional Information

Consult the README located in the highest directory of DVD 1 of your SUSE
Linux Enterprise Server before installing SUSE Linux Enterprise Server on IBM
System z. This file completes the documentation presented in this book.

4.1.2 Installation Types

This section gives an overview of the different types of installation possible with SUSE
Linux Enterprise Server for IBM System z. Basically, these two types are given:

LPAR
Installation of SUSE Linux Enterprise Server using a logical partition (LPAR).

VM (z/VM)
Installation of SUSE Linux Enterprise Server as as a guest operating system within
z/VM.

Depending on the mode of installation (LPAR or VM), there are different possibilities
for starting the installation process and IPLing the installed system.

LPAR

If you install SUSE Linux Enterprise Server for IBM System z into a separate logical
partition (LPAR), allow SUSE Linux Enterprise Server to use a special part of physical
memory in your system. Also decide how many processors are used by SUSE Linux
Enterprise Server. In this mode, you can run different operating systems simultaneously
on your IBM System z system.

z/VNM

Running SUSE Linux Enterprise Server for IBM System z in z/VM means that SUSE
Linux Enterprise Server is a guest system within z/VM. An advantage of this mode is
that you have full control over SUSE Linux Enterprise Server from z/VM. This is very
helpful for kernel development or kernel-based debugging. It is also very easy to add

or remove hardware to and from Linux guests. Creating additional SUSE Linux Enter-
prise Server guests is simple and you are able to run hundreds of Linux instances simul-
taneously.
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4.1.3 IPL Options

This section provides the information needed to do an IPL for the first installation.
Depending on the type of installation, different options need to be used. The channel-
attached tape, VM reader, and load from CD-ROM or server options are discussed.
Installing the software packages, which is done over the network, does not require the
IPL medium.

ESCON or FICON Attached Tape

IPLing from a channel-attached tape is possible on all systems connected to a tape li-
brary. The only prerequisite is that the LPAR in which to install (or allowing z/VM to
run) is allowed to access the tape unit. For this, the TODEVICE statement in the IOCDS
must have the attribute SHARED or PART=<LPARName>.

VM Reader

To IPL from a VM reader, transfer the necessary files into the reader first. Then multiple
IPLs are easily done. This is the preferred way on z/VM. For comfortable administration,
it is recommended to create a user 1 inuxmnt that owns a minidisk with the files and
scripts needed for IPL. This minidisk is then accessed read-only by the Linux guests.

Load from CD/DVD-ROM or Server

For IPLing into an LPAR, it is possible to load directly from the SE's or the HMC's
CD/DVD-ROM device. It also allows you to IPL via FTP from a server holding the
SUSE Linux Enterprise Server for IBM System z files. Find this button near the LOAD
button (if you have upgraded to the latest MCL, see Section 4.1, “General Information
and Requirements” (page 39)).

This function can be performed from the HMC. Do this by accessing the Defined CPCs
icon in the Groups Work Area on the HMC desktop. From there, access the Defined
CPCs Work Area. Select a system image and initiate CPC Recovery. Use Single Object
Operations to access the service element remotely.

Access the service element's Groups Work Area. Select the LPAR to perform the load
from CD-ROM or server and initiate CPC recovery for that LPAR. Start Load from
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CD ROM or Server from the action menu. Provide information as requested on subse-
quent windows.

Load from SCSI-Attached DVD

To IPL from a SCSI DVD, you need access to an FCP adapter connected to a DVD
drive. You need values like the WWPN and LUN from the SCSI drive. For details, see
Section “IPL from FCP-Attached SCSI DVD” (page 54).

4.1.4 The IOCDS

This section provides some necessary information about the IOCDS and how to cus-
tomize some settings for sharing network cards or DASDs among several LPARs. In
the IOCDS, the chpid and types of the devices connected to the IBM System z are
defined. The resources can be dedicated or shared among LPARs.

WARNING: Sharing Devices (DASD)

Do not share DASD writable among LPARs because this might result in data
loss. Consider the definition of the necessary resources in advance when plan-
ning the setup for SUSE Linux Enterprise Server on IBM System z.

This example shows how to dedicate a DASD to one specific LPAR. This LPAR is
referred to as LPAR1I.

Example 4.1 Dedicating DASD to One LPAR

CHPID PATH=FD, TYPE=DSD, SHARED
CNTLUNIT CUNUMBR=FDOO,PATH=FD,UNITADD=((00,256)),UNIT=3990-2
IODEVICE ADDRESS=(FD03,1), CUNUMBR=FDOO,UNIT=3390, PART=LPAR]

To share a DASD among LPARs, delete the PART=LPAR1 part in the IOCDS definition.
This might be useful for high availability reasons or for sharing data among LPARs
read-only.

Several Linux systems can use the same network device if you share it among LPARs
or z/VM guests. This reduces the number of network devices that must be provided to
the Linux system. On the other hand, you might provide more than one network device
to one Linux system to make it more available in case one connection fails.
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Network cards like OSA-Express can be used in two different modes. These modes are
known as QDIO and non-QDIO mode. Define these modes in the IOCDS by using the
TYPE statement. QDIO mode is much faster than non-QDIO mode, but uses three device
addresses instead of two in non-QDIO. Consider the limited number of device addresses
when planning the setup of your IBM System z Linux environment.

Example 4.2 Sharing OSA Express Card among LPARs (non-qdio) on z9

CHPID PATH=(FE), SHARED, PARTITION=( (LPAR1l,LPAR2)), TYPE=0OSE
CNTLUNIT CUNUMBR=FEQ0O,PATH=(FE),UNIT=0SA

IODEVICE ADDRESS=(FE00,016), CUNUMBR=(FE0O), UNIT=0SA
IODEVICE ADDRESS=(FEFE,001), CUNUMBR=(FE0O), UNIT=0SAD

Example 4.3 Sharing OSA Express Card among LPARs (qdio) on z9

CHPID PATH=(FE), SHARED, PARTITION=( (LPAR1, LPAR2)), TYPE=0SD
CNTLUNIT CUNUMBER=FEQO, PATH=(FE),UNIT=0SA

IODEVICE ADDRESS=(FE00,016), CUNUMBR=(FEOO),UNIT=0SA
IODEVICE ADDRESS=(FEFE, (001), CUNUMBR=(FE0O0), UNIT=0SAD

4.2 Preparing for Installation

In this section, learn how to make the data accessible for installation, install SUSE
Linux Enterprise Server using different methods, and prepare and use the IPL of the
SUSE Linux Enterprise Server installation system. Also find out about network confi-
guration and network installation.

4.2.1 Making the Installation Data Available

This section provides detailed information about making the SUSE Linux Enterprise
Server IBM System z installation data accessible for installation. Depending on your
computer and system environment, choose between NFS or FTP installation. If you are
running Microsoft Windows workstations in your environment, you can also use the
Windows network including the SMB protocol to install SUSE Linux Enterprise Server
on your IBM System z system.

TIP: IPL from DVD

Since Service Pack 1 of SUSE Linux Enterprise Server Version 10, it is possible
to IPL from DVD and use the DVD as the installation medium. This is very
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conveniant if you have restrictions setting up an installation server providing
installation media over your network. The prerequisite is an FCP-attached SCSI
DVD Drive.

Using a Linux Workstation or SUSE Linux Enterprise
Server DVD

If you have a Linux workstation running in your computer environment, use the work-
station to provide the installation data to the IBM System z installation process by NFS
or FTP. If the Linux workstation runs under SUSE Linux Enterprise Server for x86,
you can set up an installation server (NFS or FTP) using the YaST Installation Server
module as described in Section 14.2.1, “Setting Up an Installation Server Using YaST”
(page 202).

Over NFS

Use NFS (network file system) to make the installation media available.

IMPORTANT: Exporting Mounted Devices with NFS

Exporting the file system root (/) does not imply the export of mounted devices,
such as DVD. Explicitly name the mount point in /etc/exports:

/media/dvd * (ro)

After changing this file, restart the NFS server with the command
rcnfsserver restart.

Over FTP

Setting up an FTP server on a Linux system involves the installation of the server
software itself, such as wuftpd or proftpd, as well as other possible configuration tasks.
Using YaST, the installation step is straightforward: select the package to install and
start the installation. Skip the configuration of the FTP server if no anonymous FTP
should be used for the installation. Instead, use FTP login with a valid username and
password. You might want to create a user account for this task only. The FTP daemon
itself does not need to be started by hand. It can be started by inetd if an FTP connection
is requested. To activate the new settings, enter rcinetd restart or

rcxinetd restart.
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SUSE Linux Enterprise Server on DVD

DVDI1 of the SUSE Linux Enterprise Server for IBM System z contains a bootable
Linux image for Intel-based workstations as well as an image for System z.

For Intel-based workstations, boot from this DVD, answer the questions regarding your
language and keyboard layout, and select Start rescue system. You need at least 64 MB
RAM for this. No disk space is needed because the entire rescue system resides in the
workstation's RAM. This approach takes some Linux and networking experience, be-
cause you need to set up the networking of the workstation manually.

For System z, IPL. your LPAR/VM guest from this DVD as described in Section “IPL
from FCP-Attached SCSI DVD” (page 54). After entering your network parameters,
the installation system treats the DVD as the source of installation data. Because System
z cannot have an X11-capable terminal attached directly, choose between VNC or SSH
installation. SSH also provides a graphical installation by tunneling the X connection
through SSH with ssh -X.

Using a Microsoft Windows Workstation

If there is a Microsoft Windows workstation available in your network, use this com-
puter to make the installation media available. The easiest way to do this is to use the
SMB protocol, already included in the Windows operating system. Be sure to activate
SMB over TCP/IP as this enables the encapsulation of SMB packages into TCP/IP
packages. Find details in the Windows online help or other Windows-related documen-
tation that covers networking. Another option is to use FTP. This also requires some
third-party software for Windows.

With SMB

To make the installation media available with SMB, just insert the SUSE Linux Enter-
prise Server DVD 1 into the DVD drive of the Windows workstation. Then create a
new share using the DVD-ROM drive's letter and make it available for everyone in the
network.

TIP: SMB Installation Path for YaST

Consult the README from the highest directory of DVD 1 for detailed informa-
tion about the syntax of the installation path for YaST.
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With NFS

Refer to the documentation provided with the third party product that enables NFS
server services for your Windows workstation. The DVD-ROM drive containing the
SUSE Linux Enterprise Server DVDs must be in the available NFS path.

With FTP

Refer to the documentation provided with the third party product that is enabling FTP
server services on your Windows workstation. The DVD-ROM drive containing the
SUSE Linux Enterprise Server DVDs must be in the available FTP path.

The FTP server that is part of some Microsoft Windows releases implements only a
subset of the FTP command set and is not suitable for providing the installation data.
However, other products, such as the FTP server that is part of Hummingbird Exceed
or WAR-FTPD, have been reported as functional.

Using an FCP-Attached SCSI DVD Drive

After you IPLed from the SCSI DVD as described in Section “Load from SCSI-Attached
DVD?” (page 45), the installation system use the DVD as the installation medium. In
that case, you do not need the installation media on an FTP, NFS, or SMB server.
However, you need the network configuration data for your SUSE Linux Enterprise
Server, because you must set up the network during the installation to perform a
graphical installation by VNC or by X tunneled through SSH.

4.2.2 Installation Types

This section provides information about which steps must be performed to install SUSE
Linux Enterprise Server for each of the installation modes and where to find the appro-
priate information. After the preparations mentioned in the previous chapters have been
accomplished, follow the installation overview of the desired installation mode to install
SUSE Linux Enterprise Server on your system.

As described in Section 4.2.1, “Making the Installation Data Available” (page 46),
there are two different installation modes for Linux on IBM System z:

» LPAR Installation
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+ z/VM Installation
Procedure 4.1 Installation Overview of LPAR Installation

1 Prepare the devices needed for installation. See Section “LLPAR Installation”
(page 51).

2 [PL the installation system. See Section “LPAR Installation” (page 54).
3 Configure the network. See Section 4.2.5, “Network Configuration” (page 59).

4 Connect to the SUSE Linux Enterprise Server installation system. See Sec-
tion 4.2.6, “Connecting to the SUSE Linux Enterprise Server Installation System’

(page 61).

>

5 Start installation using YaST and IPL the installed system. See Chapter 6, Instal-
lation with YaST (page 89).

Procedure 4.2 Installation Overview of z/VM Installation

1 Prepare the devices needed for installation. See Section “z/VM Installation”
(page 52).

2 [PL the installation system. See Section “z/VM Installation” (page 55).
3 Configure the network. See Section “z/VM Installation” (page 60).

4 Connect to the SUSE Linux Enterprise Server installation system. See Sec-
tion 4.2.6, “Connecting to the SUSE Linux Enterprise Server Installation System’

(page 61).

>

5 Start installation using YaST and IPL the installed system. See Chapter 6, /nstal-
lation with YaST (page 89).
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4.2.3 Preparing the IPL of the SUSE Linux
Enterprise Server Installation System

LPAR Installation

Configure your IBM System z system to start in ESA/S390 or LINUX only mode with
an appropriate activation profile and IOCDS. Consult IBM documentation for more
about how to achieve this.

IOCDS: Attaching and Configuring Devices

A SUSE Linux Enterprise Server installation needs at least two devices: a DASD and
a network connection device. For an IPL from tape, a tape device should also be acces-
sible. Devices are configured and attached to an LPAR in the IOCDS (input output
configuration data set). This example defines one DASD, one OSA-2 network device,
and a tape device for LPAR Z1. For further information about how to set up the IOCDS
for Linux, refer to IBM hardware documentation of your machine.

Example 4.4 An Example IOCDS

CHPID PATH=(CSS(0),FD),PCHID=120, TYPE=FC
CHPID PATH=(CSS(0),FE),PCHID=320, TYPE=0OSD
CHPID PATH=(CSS(0),10),PCHID=3A0, TYPE=CNC

CNTLUNIT CUNUMBR=FDO0O,PATH=((CSS(0),FD)),UNITADD=((00,1)),UNIT=2105
IODEVICE ADDRESS=(FD00, 1), CUNUMBR=(FD00O),UNIT=3390B, UNITADD=00

CNTLUNIT CUNUMBR=FE20,PATH=((CSS(0),FE)),UNIT=0SA
IODEVICE ADDRESS=(FE20,1), CUNUMBR=(FE20), UNIT=0SA
IODEVICE ADDRESS=(FEFE, 1), CUNUMBR=(FE20),UNIT=0SAD

CNTLUNIT CUNUMBR=100A,PATH=((CSS(0),10)),UNIT=3480,UNITADD=((0A, 1))
IODEVICE ADDRESS=(100A,1),CUNUMBR=(100A),UNIT=3480,UNITADD=00

Proceed with Section “LLPAR Installation” (page 54).
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z/VM Installation

Adding a Linux Guest

The first step is to attach and format one or multiple DASDs in the system to be used
by the Linux guest in z/VM. Next, create a new user in z/VM. The example shows the
directory for a user LINUX1 with the password LINPWD, 256 MB of memory (extend-
able up to 1024 MB), 32 MB of expanded RAM (XSTORE), some minidisks (MDISK),
two CPUs and an OSA QDIO device.

TIP: Assigning Memory to z/VM guests

When assigning memory to a z/VM guest, make sure that the memory size suits
the needs of your preferred installation type. See Section “Memory Require-
ments” (page 40). To set the memory size to 512 MB, use the command CP
DEFINE STORAGE 512M. After the installation has finished, reset the memory
size to the desired value.
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Example 4.5 Configuration of a z/VM Directory

USER LINUX1 LINPWD 256M 1024M G

*

LINUX1

*
*
* This VM Linux guest has two CPUs defined.

CPU 01 CPUID 111111

CPU 02 CPUID 111222

IPL CMS PARM AUTOCR

IUCV ANY

IUCV ALLOW

MACH ESA 10

OPTION MAINTCCW RMCHINFO

SHARE RELATIVE 2000

XSTORE 32M

CONSOLE 01CO 3270 A

SPOOL 000C 2540 READER *

SPOOL 000D 2540 PUNCH A

SPOOL 000E 3203 A

* OSA QDIO DEVICE DEFINITIONS

DEDICATE 9A0 9A0

DEDICATE 9A1 9Al

DEDICATE 9A2 9A2

*

LINK MAINT 0190 0190 RR

LINK MAINT 019E 019E RR

LINK MAINT 019D 019D RR

* MINIDISK DEFINITIONS

MDISK 201 3390 0001 0050 DASD40 MR ONE4ME TWO4ME THR4ME
MDISK 150 3390 0052 0200 DASD40 MR ONE4ME TWO4ME THR4ME
MDISK 151 3390 0253 2800 DASD40 MR ONE4ME TWO4ME THR4ME

This example uses minidisk 201 as the guest's home disk. Minidisk 150 with 200
cylinders is the Linux swap device. Disk 151 with 2800 cylinders holds the Linux in-
stallation.

Now add (as the user MAINT) the guest to the user directory with DIRM FOR LINUX1
ADD. Enter the name of the guest (LINUX1) and press F5. Set up the environment of
the user with:

DIRM DIRECT
DIRM USER WITHPASS

The last command returns a reader file number. This number is needed for the next
command:

RECEIVE <number> USER DIRECT A (REPL)
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Assign the directories to the guest with DISKMAP USER DIRECT A. You can now
log in on the guest as user LINUX1.

If you do not have the dirmaint option available, refer to the IBM documentation
to set up this user.

Proceed with Section “z/VM Installation” (page 55).

4.2.4 IPLing the SUSE Linux Enterprise
Server Installation System

LPAR Installation

There are different ways to IPL. SUSE Linux Enterprise Server into an LPAR. The
preferred way is to use the Load from CD-ROM or server feature of the SE or HMC.

IPL from CD-ROM

Mark the LPAR to install and select Load from CD-ROM or server. Leave the field for
the file location blank or enter the path to the root directory of the first CD-ROM then
select continue. In the list of options that appears, choose the default selection. Operating
system messages should now show the kernel boot messages.

IPL from FCP-Attached SCSI DVD

You can use the Load procedure by selecting SCSI as Load type to IPL from SCSI.
Enter the WWPN (Worldwide port name) and LUN Logical unit number) provided by
your SCSI bridge or storage (16 digits—do not omit the trailing 0s). The boot program
selector must be 2. Use your FCP adapter as Load address and perform an IPL.

IPL from ESCON or FICON Attached Tape

If you cannot IPL from DVD, create a channel attached tape from which to IPL the
SUSE Linux Enterprise Server installation image. Use the LOAD button in the SE or
HMC with the tape device address as the load address to IPL the SUSE Linux Enterprise
Server installation system.
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There are many ways to create an IPLable tape. One is to copy the files:
/boot/s390x/tapeipl.ikr

/boot/s390x/parmfile
/boot/s390x/initrd

as binary files from DVD 1 (for example, using FTP from a Linux workstation).

Name them

SLES11 IMAGE
SLES11 PARM
SLES11 INITRD

and write them onto a tape with the REXX from the example.

IMPORTANT: Transferring Binaries using FTP

Do not upload the files as fixed 80. Store them as fixed 1024. Use the
FTP command loc site fix 1024.

Example 4.6 REXX Script to Create an IPLable Tape

'REWIND 181"

'FILEDEF IN1 DISK' SLES11 IMAGE A
'FILEDEF IN2 DISK' SLES11 PARM A
'FILEDEF IN3 DISK' SLES11 INITRD A
'FILEDEF OUT TAP1 (RECFM F BLOCK 1024 LRECL 1024 PERM'
say 'Writing: ' left(filel, 23)
'MOVEFILE IN1 OUT'

say 'Writing: ' left(file2,23)
'MOVEFILE IN2 OUT'

say 'Writing: ' left(file3,23)
'MOVEFILE IN3 OUT'

say 'Done.'

'REWIND 181'

exit

The tape in this script is attached as 181. Adjust the script to your needs.

z/VM Installation

This section is about IPLing the installation system to install SUSE Linux Enterprise
Server for IBM System z on a z/VM system.
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IPL from the z/VM Reader

You need a working TCP/IP connection and an FTP client program within your newly
defined z/VM guest to transfer the installation system via FTP. Setting up TCP/IP for
z/VM is beyond the scope of this manual. Refer to the appropriate IBM documentation.

Log in as the z/VM Linux guest to IPL. Make the content of the directory /boot /
s390x on DVD 1 of the SUSE Linux Enterprise Server for IBM System z available
by FTP within your network. From this directory, get the files vimrdr . ikr, initrd,
parmfile,and slesll.exec. Transfer the files with a fixed block size of 80
characters. Specify it with the FTP command locsite fix 80. It is important to
copy vimrdr . ikr (the Linux kernel) and initrd (the installation image) as binary

files, so use the binary transfer mode. parmfile and slesll.exec need to be
transferred in ASCII mode.

The example shows the steps necessary. In this example, the required files are accessible

from an FTP server at the IP address 192.168.0.3 and the loginis 1ininst. It
may differ for your network.
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Example 4.7 Transferring the Binaries via FTP

FTP 192.168.0.3

VM TCP/IP FTP Level 530

Connecting to 192.168.0.3, port 21

220 ftpserver FTP server (Version wu-2.4.2-academ|[BETA-18] (1)
Fri Jan 30 14:58:32 GMT 2009) ready.

USER

lininst

331 Password required for lininst

PASS

* Kk k k ok ok

230 User lininst logged in.

Command :

binary

200 Type set to I

Command :

locsite fix 80

Command :

get /media/dvdl/boot/s390x/vmrdr.ikr slesll.image
200 PORT Command successful

150 Opening BINARY mode data connection for /media/dvdl/boot/s390x/vmrdr.ikr
(6757376 bytes)

226 Transfer complete.

6757376 bytes transferred in 8.826 seconds.
Transfer rate 766.70 Kbytes/sec.

Command:

get /media/dvdl/boot/s390x/initrd slesll.initrd

200 PORT Command successful

150 Opening BINARY mode data connection for /media/dvdl/boot/s390x/initrd
(12654815 bytes)

226 Transfer complete.

12194534 bytes transferred in 16.520 seconds.
Transfer rate 766.70 Kbytes/sec.

Command:

ascii

200 Type set to A

Command:

get /media/dvdl/boot/s390x/parmfile slesll.parmfile
150 Opening ASCII mode data connection for /media/dvdl/boot/s390x/parmfile
(71 bytes)

226 Transfer complete.

71 bytes transferred in 0.092 seconds.

Transfer rate 0.71 Kbytes/sec.

Command :

get /media/dvdl/boot/s390x/slesll.exec slesll.exec
150 Opening ASCII mode data connection for /media/dvdl/boot/s390x/slesll.exec
(891 bytes)

226 Transfer complete.

891 bytes transferred in 0.097 seconds.

Transfer rate 0.89 Kbytes/sec.

Command :

quit
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Use the REXX script sles11.exec you just downloaded to IPL the Linux installation
system. This script loads the kernel, parmfile, and the initial RAM disk into the reader
for IPL.

Example 4.8 SLESI11 EXEC

/* REXX LOAD EXEC FOR SUSE LINUX S/390 VM GUESTS */
/* LOADS SUSE LINUX S/390 FILES INTO READER */
SAY "'

SAY 'LOADING SLES11 FILES INTO READER...'
'CP CLOSE RDR'

'PURGE RDR ALL'

'SPOOL PUNCH * RDR'

'PUNCH SLES11 IMAGE A (NOH'

'PUNCH SLES11 PARMFILE A (NOH'

'PUNCH SLES11 INITRD A (NOH'

'T 0o0cC!

With this script you can IPL the SUSE Linux Enterprise Server installation system with
the command s1les11. The Linux kernel then starts and prints its boot messages.

To continue the installation, proceed with Section “z/VM Installation” (page 60).

IPL from FCP-Attached SCSI DVD

To IPL in z/VM, prepare the SCSI IPL process by using the SET LOADDEYV parameter:

SET LOADDEV PORTNAME 200400E8 00D74E00 LUN 00020000 00000000 BOOT 2

After setting the LOADDEYV parameter with the appropriate values, IPL your FCP
adapter, for example:

IPL FCOO

To continue the installation, proceed with Section “z/VM Installation” (page 60).

IPL from ESCON or FICON Attached tape

If you cannot IPL from a z/VM reader, create a channel attached tape from which to
IPL the SUSE Linux Enterprise Server installation image. For instructions, refer to
Section “IPL from ESCON or FICON Attached Tape” (page 54).

To continue the installation, proceed with Section “z/VM Installation” (page 60).
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4.2.5 Network Configuration

Wait until the kernel has completed its start-up routines. If you are installing in basic
mode or in an LPAR, open the Operating System Messages on the HMC or SE.

First, choose Start Installation or System in the linuxrc main menu then Start Installation
or Update to start the installation process. Select Network as your installation medium
then select the type of network protocol you will be installing over. Section 4.2.1,
“Making the Installation Data Available” (page 46) describes how to make the instal-
lation data available for the various types of network connections. Currently, F7P,
HTTP, NFS, and SMB/CIFS (Windows file sharing) are supported.

Now set up the network device over which to receive the installation data: OSA-2 or
OSA Express or HiperSockets. The following network adapters are still available and
usable, but no longer supported: CTC, ESCON, IUCV. Next, choose the CCW bus in-
terface and the physical medium (Ethernet). As a result, the respective driver is installed
and you see the corresponding kernel messages.

Proceeding with the installation, linuxrc displays a list of potential usable read, write,
and, if applicable, data channels. After entering the addresses for each channel, you
may also need to enter additional information, such as the port name for OSA ethernet
cards.

Next, decide whether to use DHCP autoconfiguration for setting up the network interface
parameters. Because DHCP only works on a few devices and requires special hardware
configuration settings, you probably want to say NO here. When you do so, you are
prompted for the networking parameters of your installation network device:

+ The IP address of the system to install

+ The corresponding netmask

» The IP address of a gateway to reach the server

+ The IP address of your domain name server (DNS)

When using an OSA Express Network Card you are now prompted for a relative port
number. This was added to support the new 2 port OSA Express 3 Network devices. If

you are not using an OSA Express 3 device, please enter 0. OSA Express cards also
have the option of running in an “OSI layer 2 support” mode or using the older more
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common “layer 3” mode. The card mode affects all systems that share the device includ-
ing systems on other LPARSs. If in doubt, please specify 2 for compatibility with the
default mode used by other operating systems such as z/VM and z/OS. Consult with
your hardware administrator for further information on these options.

z/VM Installation

After the kernel has completed its start-up routines, answer a few questions regarding
the network setup. First, select the type of network connection to use: OSA Express or
HiperSockets. In this example installation, OSA Express is used.

The system now displays a possible OSA configuration. Choose first whether to use
QDIO or LCS OSA. Next, choose the physical medium to use and enter the device ad-
dresses. If you prefer another setup, enter the device address of the OSA read channel
(0.0.0700 in this example) then the one of the OSA write channel (0.0.0701) and the
OSA control channel (0.0.0702). After entering the channels, insert the name of the
port to which the OSA card is connected.

SUSE Linux Enterprise Server now tries to load the network module by building a pa-
rameter line with the information provided then displays all loaded modules. Loading
was successful if you get an output like:

Example 4.9 Network Device Driver Parameters

geth: Device 0.0.0700/0.0.0701/0.0.0702 is a Guest LAN QDIO card (level: V448)
with link type GuestLAN QDIO (portname: VSW1)

geth: Hardware IP fragmentation not supported on ethO

geth: VLAN enabled

geth: Multicast enabled

geth: IPV6 enabled

geth: Broadcast enabled

geth: Could not set up broadcast echo filtering on eth0O: 0x2

geth: Using SW checksumming on ethO.

geth: Outbound TSO not supported on ethO

Next, enter your IP address, netmask, and default gateway. To install over iucv or ctc,
enter additional information, like the the peer address (for a point-to-point adapter) or
the port name.

Finally, the IP address of the DNS server and the MTU size are requested. The MTU
size should always match the one used by the network to which to connect.
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Now a summary is displayed. Confirm whether your input is correct. Before the network
is started, enter a password that is valid only during the installation. After having IPLed
the installed system, enter the real root password.

With all basic parameters set up, the network is started. Check the output of ifconfig,
which should contain two entries: a loopback (lo) connection and one connection (eth0,
ctc0, escon0, iucv0, or hsi0) with correct settings.

Example 4.10 Example ifconfig

/sbin/ifconfig ethO :
Link encap:Ethernet HWaddr 02:00:01:00:00:27
inet addr:192.168.0.1 Bcast:192.168.0.255 Mask:255.255.255.0
inet6 addr: fe80::200:100:100:27/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1492 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:0 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:0 (0.0 Mb) TX bytes:0 (0.0 Mb)

4.2.6 Connecting to the SUSE Linux
Enterprise Server Installation System

After setting up your network connection, linuxrc prompts for the details of the instal-
lation source chosen earlier in the process, for example, the server IP address and the
directory in which the data is located.

Finally, linuxrc wants to know what type of display you want to use to control the in-
stallation procedure. Possible choices are X11 (X Window System), VNC (Virtual

Network Computing protocol), and SSH (text mode or X11 installation via Secure
Shell).

Initiating the Installation for VNC

1 After the installation option VNC has been chosen, the VNC server starts. A short
note displayed in the console provides information about which IP address and
display number is needed for a connection with vncviewer. Alternatively, a URL
is given here for entry into your Java-enabled browser to connect to the installation
system.
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2 Start a VNC client application on your client system. Either use vncviewer or
the VNC Java client and a Java-enabled Web browser.

3 Enter the IP address and the display number of the SUSE Linux Enterprise
Server installation system when prompted to do so.

If you connect via a Java-enabled browser, enter a URL containing the IP address
of the installation system and the appropriate port number in the format:

http://<IP address of installation system>:5801/

4 After the connection has been established, start installing SUSE Linux Enterprise
Server with YaST.

Initiating the Installation for the X Window System

IMPORTANT: X Authentication Mechanism

The direct installation with the X Window System relies on a primitive authen-
tication mechanism based on hostnames. This mechanism is disabled on current
SUSE Linux Enterprise Server versions. Installation with SSH or VNC is preferred.

1 Make sure that the X server allows the client (the system that is installed) to
connect. Set the variable
DISPLAYMANAGER_XSERVER_TCP_PORT_6000_OPEN="yes" inthefile
/etc/sysconfig/displaymanager. Then restart the X server and allow
client binding to the server using xhost <client IP address>.

2 When prompted at the installation system, enter the IP address of the machine
running the X server.

3 Wait until YaST opens then start the installation.
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Initiating the Installation for SSH

To connect to an installation system with the name earth using SSH, execute ssh —-X
earth. If your workstation runs on Microsoft Windows, use the ssh and telnet client
and terminal emulator putty, which is available from http://www.chiark

.greenend.org.uk/~sgtatham/putty/. Set Enable X11 forwarding in putty
under Connection > SSH > X11.

A login prompt appears. Enter root and log in with your password. Then enter yast 2
to start YaST.

Proceed with the detailed description of the installation procedure that can be found in
Chapter 6, Installation with YaST (page 89).

4.3 Network Connection Types

SUSE Linux Enterprise Server for IBM System z includes network drivers for OSA
devices (ethernet, and gigabit ethernet) and HiperSockets. This chapter describes the
configuration within the SUSE Linux Enterprise Server installation system.

WARNING: CTC, ESCON, and IUCV Interfaces No Longer Supported

CTC, ESCON, and IUCV interfaces are no longer officially supported. For com-
patibility reasons, they are still usable, but with the next release of SUSE Linux
Enterprise Server the support of these interfaces will be dropped completely.

4.3.1 HiperSockets

Select your device from the list of network devices. Then enter the network device read
channel number (such as 0.0.700), the write channel number (like 0.0.701) and the data
channel number (like 0.0.702).
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Example 4.11 Supported Network Connection Types and Driver Parameters

Choose the network device.

1) IBM parallel CTC Adapter (0.0.0600)

2) IBM parallel CTC Adapter (0.0.0602)

3) IBM parallel CTC Adapter (0.0.0604)

4) IBM Hipersocket (0.0.0700)

5) IBM Hipersocket (0.0.0701)

6) IBM Hipersocket (0.0.0702)

7) IBM OSA Express Network card (0.0.050c)
8) IBM OSA Express Network card (0.0.050d)
9) IBM OSA Express Network card (0.0.050e)
10) IBM OSA Express Network card (0.0.£401)
11) IBM OSA Express Network card (0.0.£400)
12) IBM OSA Express Network card (0.0.£402)
13) IBM IUCV

> 4

Device address for read channel [0.0.700]
>[0.0.700]

Device address for write channel
> 0.0.701

Device address for data channel
> 0.0.702

Next, choose manual configuration then enter the IP address, netmask, broadcast address,
IP address of the gateway, and the searchlist of the DNS server.
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Example 4.12 Network Device Name

Automatic configuration via DHCP?

1) Yes
2) No
> 2

Enter your IP address
> 192.168.0.20

Enter your netmask. For a normal class C network, this is usually
255.255.255.0 [255.255.255.0]
> 255.255.255.0

Enter the IP address of the gateway. Leave empty if you don't need one
> 192.168.0.1

Enter your search domains, separated by a space:
> example.com

4.3.2 Gigabit Ethernet with the qeth Module

Selectan IBM OSA Express Network card from the list of network devices,
and then 1 for ethernet. When prompted, enter the network device's read, write, and

data channel numbers (for example, 0.0.0600,0.0.0601,and 0.0.0602) and
the port name, if applicable. Choose whether to enable OSI Layer 2 support.
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Example 4.13 Network Device Driver Parameters

Detecting and loading network drivers
netiucv.8db02b: driver initialized
Choose the network device.

1) IBM OSA Express Network card (
2) IBM OSA Express Network card (
3) IBM OSA Express Network card (
4) IBM OSA Express Network card (
5) IBM OSA Express Network card (
6) IBM OSA Express Network card (
7) IBM IUCV

>

4

Please choose the physical medium.
1) Ethernet

2) Token Ring

>

1

Enter the relative port number

>

0

Device address for read channel
[0.0.0600]>

0.0.0600

Device address for write channel

>

0.0.0601

Device address for data channel

>

0.0.0602

Portname to use

>

DT70

Enable OSI Layer 2 support?

1) Yes

2) No

>

2

O O O O o o
o
o
o
o

Next, enter the full hostname. Then choose manual configuration and enter the IP ad-
dress, netmask, broadcast address, IP address of the gateway, and IP address of the
DNS server.
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Example 4.14 Network Device Name

Fully qualified hostname> earth.cosmos.com

Automatic configuration wvia DHCP?

1) Yes
2) No
> 2

Enter your IP address> 192.168.0.20

Enter your netmask. For a normal class C network, this is usually
255.255.255.0 [255.255.255.0]> 255.255.255.0

If you need a gateway to reach the server, enter the IP address of the
gateway. If you do not need a gateway, enter your own IP address
[192.168.0.20]> 192.168.0.1

Enter the IP address of your name server. Leave empty or enter "+++" if you
don't need one
>

4.4 The parmfile—Automating the
System Configuration

The installation process can be partly automated by specifying the crucial parameters
in the parmfile. The parmfile contains all the data required for network setup
and DASD configuration. In addition to that, it can be used to set up the connection
method to the SUSE Linux Enterprise Server installation system and the YaST instance
running there. User interaction is thus limited to the actual YaST installation controlled
by YaST dialogs.

The following parameters can be passed to the installation routine, which takes them
as default values for installation. All IP addresses, server names, and numerical values
are just examples. Replace these values with the ones needed in your installation sce-
nario.

The number of lines in the parmfile is limited to 10. Specify more than one parameter
on a line. Parameter names are not case-sensitive. Separate the parameters by spaces.
You may specify the parameters in any order. Always keep the PARAMETER=value
string together in one line. For example:
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Hostname=s390zvm0l.suse.de HostIP=10.11.134.65

TIP: Using IPv6 during the Installation

By default you can only assign IPv4 network addresses to your machine. To
enable IPv6 during installation, enter one of the following parameters at the
bootprompt: ipv6=1 (accept IPv4 and IPv6) or ipveonly=1 (accept IPv6
only).

Some of the following parameters are required. If they are missing, the automatic process
pauses and asks for the value interactively.

4.4.1 General Parameters

AutoYaST=<URL>Manual=0
The Aut oYaST parameter specifies the location of the autoinst . xml control
file for automatic installation. The Manual parameter controls whether the other
parameters are only default values that still must be acknowledged by the user. Set
this parameter to 0 if all values should be accepted and no questions asked. Setting
AutoYaST implies setting Manual to 0.

Info=<URL>
Specifies a location for a file to read more options from. Useful to overcome the
limitations of 10 lines (and 80 characters per line under z/VM) for the parmfile.
More documentation on the Info file can be found in Section 21.1.5, “Creating the
info File” (page 297). Since the Info file can typically only be accessed through the
network on System z, you cannot use it to specify options required to setup the
network, i.e. options described in Section 4.4.2, “Configuring the Network Interface”
(page 69). Also other linuxrc specific options such as for debugging have to be
specified in the parmfile to be effective.

TIP: Creating a File with Autoinstallation Information

At the very end of the installation of a system you can check Clone This System
for Autoyast. This creates a ready-to-use profile as /root/autoinst.xml
that can be used to create clones of this particular installation. To create an
autoinstallation file from scratch or to edit an existing one, use the YaST module
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Autoinstallation. For more information about AutoYaST, refer to Chapter 21,
Automated Installation (page 289).

4.4.2 Configuring the Network Interface

IMPORTANT: Configuring the Network Interface

All settings discussed here only apply to the network interface used during in-
stallation. Configure additional network interfaces in the installed system by
following the instructions given in Section “Configuring a Network Connection
Manually” (Chapter 18, Basic Networking, 1Administration Guide).

Hostname=zseries.example.com
Enter the fully qualified hostname.

Domain=example.com
Domain search path for DNS. Allows you to use short host names instead of fully
qualified ones.

HostIP=192.168.1.2
Enter the IP address of the interface to configure.

Gateway=192.168.1.3
Specify the gateway to use.

Nameserver=192.168.1.4
Specify the DNS server in charge.

InstNetDev=0sa
Enter the type of interface to configure. Possible values are osa, hsi. ctc, escon,
and iucv. (CTC, ESCON, and IUCV are no longer officially supported).

For the interfaces of type hsi and osa, specify an appropriate netmask and an
optional broadcast address:

Netmask=255.255.255.0
Broadcast=192.168.255.255

For the interfaces of type ctc, escon, and iucv (CTC, ESCON, and IUCV are
no longer officially supported), enter the IP address of the peer:
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Pointopoint=192.168.55.20

OsalInterface=<lcs|gdio> OsaMedium=<eth|tr>
For osa network devices, specify the host interface (gdio or 1cs) and the phys-
ical medium (eth for ethernet or tr for token ring).

Layer2=<0]1>
For osa QDIO ethernet devices, specify whether to enable OSI Layer 2 support.

PortNo=<0]|1>

For osa network devices, specify the port number (provided the device supports
this feature). If not specified, it defaults to 0.

Each of the interfaces requires certain setup options:

* Interfaces ctc and escon (CTC and ESCON are no longer officially supported):

ReadChannel=0.0.0424
WriteChannel=0.0.0425

ReadChannel specifies the READ channel to use. WriteChannel is the
WRITE channel.

* For the ctc interface (no longer officially supported), specify the protocol that
should be used for this interface:

CTCProtocol=<0/1/2>

Valid entries would be:

0 Compatibility mode, also for non-Linux peers other than
0S/390 and z/OS (this is the default mode)

1 Extended mode

2 Compatibility mode with OS/390 and z/OS

* Network device type osa with interface 1cs:

ReadChannel=0.0.0124
Portname=1
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ReadChannel stands for the channel number used in this setup. A second port
number can be derived from this by adding one to ReadChannel. Portnumber
is used to specify the relative port.

* Interface iucv:

IUCVPeer=PARTNER

Enter the name of the peer machine.

* Network device type osa with interface gdio for OSA-Express Gigabit Ethernet
and OSA-Express High-speed Token Ring;:

ReadChannel=0.0.0524
WriteChannel=0.0.0525
DataChannel=0.0.0526
Portname=FEF400

For ReadChannel, enter the number of the READ channel. ForWriteChannel,
enter the number of the WRITE channel. DataChannel specifies the DATA

channel. For Por t name, enter an appropriate port name. Make sure that the READ
channel carries an even device number.

* Interface hsi for HiperSockets and VM guest LANSs:
ReadChannel=0.0.0624

WriteChannel=0.0.0625
DataChannel=0.0.0626

For ReadChannel, enter the appropriate number for the READ channel. For
WriteChannel and DataChannel, enter the WRITE and DATA channel
numbers.

4.4.3 Specifying the Installation Source and
YaST Interface

Install=nfs://server/directory/DVD1l/
Specify the location of the installation source to use. Possible protocols are nf's,
smb (Samba/CIFS), ftp, and http.
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Ifan ftp or smb URL is given, specify the username and password with the URL.
These parameters are optional and anonymous or guest login is assumed if they
are not given.

Install=ftp://user:password@server/directory/DVD1l/

In case of a Samba or CIFS installation, you can also specify the domain that should
be used:

Install=smb://workdomain; user:password@server/directory/DVD1l/

UseSSH=1 UseVNC=1 Display_IP=192.168.42.42

Depending on which parameter you give, a remote X server, SSH, or VNC will be
used for installation. UseSSH enables SSH installation, UseVNC starts a VNC
server on the installing machine, and Display_IP causes the installing system

to try to connect to an X server at the given address. Only one of these parameters
should be set at any time.

IMPORTANT: X Authentication Mechanism

The direct installation with the X Window System relies on a primitive au-
thentication mechanism based on hostnames. This mechanism is disabled
on current SUSE Linux Enterprise Server versions. Installation with SSH or
VNC is preferred.

To allow a connection between YaST and the remote X server, run xhost <IP
address> with the address of the installing machine on the remote machine.

For VNC, specify a password of six to eight characters to use for installation:

VNCPassword=<a password>

For SSH, specify a password of six to eight characters to use for installation:

SSHPassword=<a password>

4.4.4 Example Parmfiles

For an automatic installation with AutoYaST in an LPAR, it is preferred that the
parmfile has just one long line. If multiple lines are desired for readability, use blank
characters at the beginning and end of each line. The maximum number of lines in a
parmfile is 10.
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To receive potential error messages on the console, use

linuxrclog=/dev/console

Example 4.15 Parmfile for Installation with NFS, VNC, and IUCV and AutoYaST
with HTTP

ramdisk_size=131072 root=/dev/raml ro init=/linuxrc TERM=dumb
instnetdev=iucv iucvpeer=ROUTERO1l pointopoint=192.168.0.1
hostip=192.168.0.2

nameserver=192.168.0.3
install=nfs://192.168.0.4/SLES/SLES-11-s390%x/DVD1
autoyast=http://192.168.0.5/autoinst.xml
linuxrclog=/dev/console usevnc=1

vncpassword=testin

Example 4.16 Parmfile for Installation with NFS, SSH, and HSI and AutoYaST with
NFS

ramdisk_size=131072 root=/dev/raml ro init=/linuxrc TERM=dumb

AutoYast=nfs://192.168.1.1/autoinst/s390.xml

Hostname=zseries.example.com HostIP=192.168.1.2

Gateway=192.168.1.3 Nameserver=192.168.1.4

InstNetDev=hsi layer2=0

Netmask=255.255.255.128 Broadcast=192.168.1.255

readchannel=0.0.702c writechannel=0.0.702d datachannel=0.0.702e

install=nfs://192.168.1.5/SLES-11-s390x/DVD1/

UseSSH=1 SSHPassword=testing linuxrclog=/dev/console

4.5 Using the vt220 Terminal
Emulator

Recent MicroCode Levels allow the use of an integrated vt220 terminal emulator in
addition to the standard line mode terminal. The vt220 terminal is connected to /dev/
ttyS1. The line mode terminal is connected to /dev/ttySO0. If the vt220 emulation
is available, an icon for an integrated vt220 ASCII console appears next to the icon for
the 3215 console on the HMC/SE.

To activate vt220 support on your machine, edit /etc/inittab asuser root. Look
for the following line and delete the leading # sign:

#2:2345:respawn:/sbin/mingetty --noclear /dev/ttySl xterm
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Save the file and run telinit gto pass the changesin /etc/inittab to init. The
vt220 terminal should then be ready to use. If not, try hitting Enter at the terminal until
the login prompt appears.

Make sure that you do not apply the changes as described above to a system that does
not support vt220 terminal emulators. Otherwise, login might become impossible on
this system and you will be shown the following message:

INIT respawning too fast, disabled for 5 minutes.

To redirect the kernel messages at boot time from the system console to the vt220 ter-
minal, add the following entries to the parameters linein /etc/zipl.conf:

console=ttyS0 console=ttyS1l

The resulting parameters line would look like the following example:

parameters = "root=/dev/dasda2 TERM=dumb console=ttyS0 console=ttyS1"

Save the changes in /etc/zipl.conf, run zipl, and reboot the system.

4.6 Further In-Depth Information
about IBM System z

IBM has published a number of very interesting documents about their System z plat-
form. Find them either on the Internet (http://www.redbooks.ibm.com) or in
your installed system (package redbook) under /usr/share/doc/packages/
redbook.

4.6.1 IBM System z with SUSE Linux
Enterprise Server

Find additional in-depth technical documentation about the kernel and application topics
on IBM System z with SUSE Linux Enterprise Server at the following location:

* http://www.ibm.com/developerworks/linux/1inux390/
documentation_novell_ suse.html
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4.6.2 Hardware

For a first glance at the technical details of some systems, refer to:
+ IBM System z10 Enterprise Class Technical Introduction (SG24-7515)
+ IBM System z9 Business Class Technical Introduction (SG24-7241)
+ IBM eServer zSeries 990 Technical Introduction (SG24-6863)
+ IBM eServer zSeries 900: Technical Guide (SG24-5975)

+ Linux on zSeries Fibre Channel Protocol Implementation Guide (SG24-6344)

4.6.3 General Documents about Linux on
IBM System z

A general coverage of Linux on IBM System z can be found in the following documents:
+ Linux on IBM eServer zSeries and S/390: ISP and ASP Solutions (SG24-6299)

These documents might not reflect the current state of Linux, but the principles of
Linux deployment outlined there remain accurate.

4.6.4 Technical Issues of Linux on IBM
System z

Refer to the following documents to get in-depth technical information about Linux
kernel and application topics. Refer to the Internet for up-to-date versions of these
documents for the most recent code drop (http://www.ibm.com/
developerworks/linux/1inux390/index.html).

+ Linux for zSeries and S/390: Device Drivers, Features, and Commands
+ zSeries ELF Application Binary Interface Supplement

+ Linux for zSeries and S/390: Using the Dump Tools
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+ IBM System z9-109 Technical Introduction (SG26-6669)
» IBM System z10 Enterprise Class Technical Guide (SG24-7516)

There also is a Redbook for Linux application development on http: //www
.redbooks.ibm.com:

+ Linux on IBM eServer zSeries and S/390: Application Development (SG24-6807)

4.6.5 Advanced Configurations for Linux on
IBM System z

Refer to the following Redbooks, Redpapers, and links for some more complex IBM
System z scenarios:

+ Linux on IBM eServer zSeries and S/390: Large Scale Deployment (SG24-6824)

+ Linux on IBM eServer zSeries and S/390: Performance Measuring and Tuning
(SG24-6926)

+ Linux with zSeries and ESS: Essentials (SG24-7025)

+ IBM TotalStorage Enterprise Storage Server Implementing ESS Copy Services
with IBM eServer zSeries (SG24-5680)

+ Linux on IBM zSeries and S/390: High Availability for z/VM and Linux (REDP-
0220)

+ Saved Segments Planning and Administration
http://publibz.boulder.ibm.com/epubs/pdf/hcsg4al0.pdf
+ Linux on System z documentation for "Development stream"

http://www.ibm.com/developerworks/linux/1inux390/
development_documentation.html
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Deployment Strategies

There are several different ways to deploy SUSE Linux Enterprise Server. Choose from
various approaches ranging from a local installation using physical media or a network
installation server to a mass deployment using a remote-controlled, highly-customized,
and automated installation technique. Select the method that best matches your require-
ments.

5.1 Deploying up to 10 Workstations

If your deployment of SUSE Linux Enterprise Server only involves 1 to 10 workstations,
the easiest and least complex way of deploying SUSE Linux Enterprise Server is a plain
manual installation as featured in Chapter 6, /nstallation with YaST (page 89). Manual
installation can be done in several different ways depending on your requirements:

Installing from the SUSE Linux Enterprise Server Media (page 80)
Consider this approach if you want to install a single, disconnected workstation.

Installing from a Network Server Using SLP (page 80)
Consider this approach if you have a single workstation or a small number of
workstations and if a network installation server announced via SLP is available.

Installing from a Network Server (page 81)
Consider this approach if you have a single workstation or a small number of
workstations and if a network installation server is available.
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Table 5.1 Installing from the SUSE Linux Enterprise Server Media

Installation Source SUSE Linux Enterprise Server media kit
Tasks Requiring Manual Inter- ~ » Inserting the installation media
action

+ Booting the installation target
+ Changing media
+ Determining the YaST installation scope

+ Configuring the system with YaST system

Remotely Controlled Tasks ~ None

Details Installing from the SUSE Linux Enterprise Server
Media (page 89)

Table 5.2 Installing from a Network Server Using SLP

Installation Source Network installation server holding the SUSE Linux
Enterprise Server installation media

Tasks Requiring Manual + Inserting the boot disk
Interaction
* Booting installation target
+ Determining the YaST installation scope

+ Configuring the system with YaST

Remotely Controlled Tasks None, but this method can be combined with VNC

Details Section 6.1.1, “Installing from a Network Server Using
SLP” (page 91)
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Table 5.3 Installing from a Network Server

Installation Source Network installation server holding the SUSE Linux
Enterprise Server installation media

Tasks Requiring Manual + Inserting the boot disk
Interaction

+ Providing boot options

+ Booting the installation target

» Determining the YaST installation scope

+ Configuring the system with YaST

Remotely Controlled Tasks None, but method can be combined with VNC

Details Section 6.1.2, “Installing from a Network Source with-
out SLP” (page 91)

5.2 Deploying up to 100 Workstations

With a growing numbers of workstations to install, you certainly do not want to install
and configure each one of them manually. There are many automated or semiautomated
approaches as well as several options to perform an installation with minimal to no
physical user interaction.

Before considering a fully-automated approach, take into account that the more complex
the scenario gets the longer it takes to set up. If a time limit is associated with your de-
ployment, it might be a good idea to select a less complex approach that can be carried
out much more quickly. Automation makes sense for huge deployments and those that
need to be carried out remotely.

Choose from the following options:

Simple Remote Installation via VNC—Static Network Configuration (page 83)
Consider this approach in a small to medium scenario with a static network setup.
A network, network installation server, and VNC viewer application are required.
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Simple Remote Installation via VNC—Dynamic Network Configuration (page 83)
Consider this approach in a small to medium scenario with dynamic network setup
through DHCP. A network, network installation server, and VNC viewer application
are required.

Remote Installation via VNC—PXE Boot and Wake on LAN (page 84)
Consider this approach in a small to medium scenario that should be installed via
network and without physical interaction with the installation targets. A network,
a network installation server, network boot images, network bootable target hard-
ware, and a VNC viewer application are required.

Simple Remote Installation via SSH—Static Network Configuration (page 84)
Consider this approach in a small to medium scenario with static network setup.
A network, network installation server, and SSH client application are required.

Remote Installation via SSH—Dynamic Network Configuration (page 85)
Consider this approach in a small to medium scenario with dynamic network setup
through DHCP. A network, network installation server, and SSH client application
are required.

Remote Installation via SSH—PXE Boot and Wake on LAN (page 85)
Consider this approach in a small to medium scenario that should be installed via
network and without physical interaction with the installation targets. A network,
a network installation server, network boot images, network bootable target hard-
ware, and an SSH client application are required.

Simple Mass Installation (page 86)
Consider this approach for large deployments to identical machines. If configured
to use network booting, physical interaction with the target systems is not needed
at all. A network, a network installation server, a remote controlling application
such as a VNC viewer or an SSH client, and an AutoYaST configuration profile
are required. If using network boot, a network boot image and network bootable
hardware are required as well.

Rule-Based Autoinstallation (page 87)
Consider this approach for large deployments to various types of hardware. If
configured to use network booting, physical interaction with the target systems is
not needed at all. A network, a network installation server, a remote controlling
application such as a VNC viewer or an SSH client, and several AutoYaST confi-
guration profiles as well as a rule setup for AutoYaST are required. If using network
boot, a network boot image and network bootable hardware are required as well.
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Table 5.4 Simple Remote Installation via VNC—Static Network Configuration

Installation Source

Preparations

Control and Monitoring
Best Suited For

Drawbacks

Details

Network

+ Setting up an installation source

» Booting from the installation media

Remote: VNC
small to medium scenarios with varying hardware

+ Each machine must be set up individually

+ Physical access is needed for booting

Section 14.1.1, “Simple Remote Installation via
VNC—Static Network Configuration” (page 194)

Table 5.5 Simple Remote Installation via VNC—Dynamic Network Configuration

Installation Source

Preparations

Control and Monitoring
Best Suited For

Drawbacks

Network

+ Setting up the installation source

» Booting from the installation media

Remote: VNC
Small to medium scenarios with varying hardware

+ Each machine must be set up individually

+ Physical access is needed for booting
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Details Section 14.1.2, “Simple Remote Installation via
VNC—Dynamic Network Configuration” (page 195)

Table 5.6 Remote Installation via VNC—PXE Boot and Wake on LAN

Installation Source Network

Preparations + Setting up the installation source
+ Configuring DHCP, TFTP, PXE boot, and WOL

+ Booting from the network

Control and Monitoring Remote: VNC

Best Suited For + Small to medium scenarios with varying hardware

+ Completely remote installs; cross-site deployment

Drawbacks Each machine must be set up manually

Details Section 14.1.3, “Remote Installation via VNC—PXE
Boot and Wake on LAN” (page 197)

Table 5.7 Simple Remote Installation via SSH—Static Network Configuration

Installation Source Network

Preparations + Setting up the installation source

» Booting from the installation media

Control and Monitoring Remote: SSH

Best Suited For + Small to medium scenarios with varying hardware
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» Low bandwidth connections to target

Drawbacks » Each machine must be set up individually

+ Physical access is needed for booting

Details Section 14.1.4, “Simple Remote Installation via
SSH—Static Network Configuration” (page 198)

Table 5.8 Remote Installation via SSH—Dynamic Network Configuration

Installation Source Network

Preparations + Setting up the installation source

+ Booting from installation media

Control and Monitoring Remote: SSH
Best Suited For + Small to medium scenarios with varying hardware

» Low bandwidth connections to target

Drawbacks » Each machine must be set up individually

+ Physical access is needed for booting

Details Section 14.1.5, “Simple Remote Installation via
SSH—Dynamic Network Configuration” (page 199)

Table 5.9 Remote Installation via SSH—PXE Boot and Wake on LAN

Installation Source Network

Preparations + Setting up the installation source
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+ Configuring DHCP, TFTP, PXE boot, and WOL

* Booting from the network

Control and Monitoring Remote: SSH
Best Suited For + Small to medium scenarios with varying hardware
+ Completely remote installs; cross-site deployment

+ Low bandwidth connections to target

Drawbacks Each machine must be set up individually

Details Section 14.1.6, “Remote Installation via SSH—PXE
Boot and Wake on LAN” (page 201)

Table 5.10 Simple Mass Installation

Installation Source Preferably network
Preparations + Gathering hardware information
+ Creating AutoYaST profile
+ Setting up the installation server
+ Distributing the profile
+ Setting up network boot (DHCP, TFTP, PXE, WOL)
or

Booting the target from installation media

Control and Monitoring  Local or remote through VNC or SSH
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Best Suited For + Large scenarios
+ Identical hardware

+ No access to system (network boot)

Drawbacks Applies only to machines with identical hardware

Details Section 21.1, “Simple Mass Installation” (page 289)

Table 5.11 Rule-Based Autoinstallation

Installation Source Preferably network
Preparations + Gathering hardware information
+ Creating AutoYaST profiles
+ Creating AutoYaST rules
+ Setting up the installation server
+ Distributing the profile
+ Setting up network boot (DHCP, TFTP, PXE, WOL)
or

Booting the target from installation media

Control and Monitoring ~ Local or remote through SSH or VNC

Best Suited For + Varying hardware

+ Cross-site deployments

Drawbacks Complex rule setup
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Details Section 21.2, “Rule-Based Autoinstallation” (page 301)

5.3 Deploying More than 100
Workstations

Most of the considerations brought up for medium installation scenarios in Section 5.1,
“Deploying up to 10 Workstations” (page 79) still hold true for large scale deployments.
However, with a growing number of installation targets, the benefits of a fully automated
installation method outweigh its disadvantages.

It pays off to invest a considerable amount of time to create a sophisticated rule and
class framework in AutoYaST to match the requirements of a huge deployment site.
Not having to touch each target separately can save you a tremendous amount of time
depending on the scope of your installation project.

As an alternative, and if user settings should be done during the first bootup, create
preload images with kiwi and firstboot. Deploying such images could even be done by
a PXE boot server specialized for this task. For more details, see Chapter 17, KIWI
(page 259), Chapter 21, Automated Installation (page 289), and Chapter 20, Deploying
Customized Preinstallations (page 275).
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Installation with YaST

After your hardware has been prepared for the installation of SUSE® Linux Enterprise
Server as described in the Part I, “Architecture Specific Installation Considerations”
(page 5) and after the connection with the installation system has been established,
you are presented with the interface of SUSE Linux Enterprise Server's system assistant
YaST. YaST guides you through the entire installation and configuration procedure.

6.1 Choosing the Installation Method

After having selected the installation medium, determine a suitable installation method
and boot option that best match your needs:

Installing from the SUSE Linux Enterprise Server Media
Choose this option, if you want to perform a stand-alone installation and do not
want to rely on a network providing the installation data or the boot infrastructure.
The installation proceeds exactly as outlined in Section 6.2, “The Installation
Workflow” (page 91).

Installing from a Network Server
Choose this option, if you have an installation server available in your network or
want to use an external server as the source of your installation data. This setup
can be configured to use from physical media (Floppy, CD/DVD, or hard disk) for
booting or configured to boot via network using PXE/BOOTP. Refer to Sec-
tion 6.1.1, “Installing from a Network Server Using SLP” (page 91), Section 6.1.2,
“Installing from a Network Source without SLP” (page 91), or Chapter 14, Remote
Installation (page 193) for details.
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SUSE Linux Enterprise Server supports several different boot options from which you
can choose depending on the hardware available and on the installation scenario you
prefer. Booting from the SUSE Linux Enterprise Server media is the most straightforward
option, but special requirements might call for special setups:

Table 6.1 Boot Options

Boot Option  Description

DVD This is the easiest boot option. This option can be used if the system
has a local DVD-ROM drive that is supported by Linux.

Floppy The data for generating boot floppies are located on DVD 1 in the
/boot/architecture/ directory. A README with instructions
on how to create the boot floppies is available in the same directory.

PXE or Booting over the network must be supported by the system's BIOS

BOOTP or firmware and a boot server must be available in the network.
This task can also be handled by another SUSE Linux Enterprise
Server system. Refer to Chapter 14, Remote Installation (page 193)
for more information.

Hard Disk SUSE Linux Enterprise Server installation can also be booted from
the hard disk. To do this, copy the kernel (1 inux) and the installa-
tion system (initrd) from the directory
/boot/architecture/ on the installation media to the hard
disk and add an appropriate entry to the existing boot loader of a
previous SUSE Linux Enterprise Server installation.

TIP: Booting from DVD on UEFI machines

»amd64 em64t: DVD1 can be used as a boot medium for machines equipped
with UEFI (Unified Extensible Firmware Interface). Refer to your vendor's doc-
umentation for specific information. If booting fails, try to enable CSM (Com-
patibility Support Module) in your firmware. <«
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6.1.1 Installing from a Network Server Using
SLP

If your network setup supports OpenSLP and your network installation source has been
configured to announce itself via SLP (described in Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 202)), boot the system, press F4 in the
boot screen and select SLP from the menu.

The installation program configures the network connection with DHCP and retrieves
the location of the network installation source from the OpenSLP server. If the automatic
DHCP network configuration fails, you are prompted to enter the appropriate parameters
manually. The installation then proceeds as described below with the exception of the
network configuration step needed prior to adding additional repositories. This step is
not needed as the network is already configured and active at this point.

6.1.2 Installing from a Network Source
without SLP

If your network setup does not support OpenSLP for the retrieval of network installation
sources, boot the system and press F4 in the boot screen to select the desired network

protocol (NES, HTTP, FTP, or SMB/CIFES). Provide the server's address and the path

to the installation media.

The installation program automatically configures the network connection with DHCP.
If this configuration fails, you are prompted to enter the appropriate parameters manu-
ally. The installation retrieves the installation data from the source specified. The instal-
lation then proceeds as described below with the exception of the network configuration
step needed prior to adding additional repositories. This step is not needed as the network
is already configured and active at this point.

6.2 The Installation Workflow

The SUSE Linux Enterprise Server installation is split into three main parts: preparation,
installation, configuration. During the preparation phase you configure some basic pa-
rameters such as language, time, desktop type, users, passwords, hard disk setup and
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installation scope. In the non-interactive installation phase the software is installed and
the system is prepared for the first boot. Upon finishing the installation the machine
reboots into the newly installed system and starts the final system configuration. In this
stage, network and Internet access, as well as hardware components such as printers,
are set up.

6.3 IBM POWER: System Start-Up for
Network Installation

For IBM POWER platforms, the system is booted (IPL, Initial Program Load) as de-
scribed in Section 3.2, “Preparation” (page 23). For a network installation, SUSE Linux
Enterprise Server does not show a splash screen or boot loader command line on these
systems. During the installation, load the kernel manually. YaST starts with its installa-
tion screen as soon as a connection has been established to the installation system via
VNC, X, or SSH. Because there is no splash screen or boot loader command line, kernel
or boot parameters cannot be entered on screen, but must be included in the kernel image
using the mkzimage_cmdline utility.

TIP: IBM POWER: The Next Steps

To install, follow the description of the installation procedure with YaST starting
from Section 6.7, “Welcome” (page 98).

6.4 IBM System z: System Start-Up for
Installation

For IBM System z platforms, the system is booted (IPL, Initial Program Load) as de-
scribed in Section 4.2.4, “IPLing the SUSE Linux Enterprise Server Installation System”
(page 54). SUSE Linux Enterprise Server does not show a splash screen on these sys-
tems. During the installation, load the kernel, initrd, and parmfile manually. YaST starts
with its installation screen as soon as a connection has been established to the installation
system via VNC, X, or SSH. Because there is no splash screen, kernel or boot parameters
cannot be entered on screen, but must be specified in a parmfile (see Section 4.4, “The
parmfile—Automating the System Configuration” (page 67)).
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TIP: IBM System z: The Next Steps

To install, follow the description of the installation procedure with YaST starting
from Section 6.7, “Welcome” (page 98).

6.5 System Start-Up for Installation

You can install SUSE Linux Enterprise Server from local installation sources, such as
the SUSE Linux Enterprise Server CDs or DVD, or from network source of an FTP,
HTTP, NFS, or SMB server. Any of these approaches requires physical access to the
system to install and user interaction during the installation. The installation procedure
is basically the same regardless of the installation source. Any exceptions are sufficiently
highlighted in the following workflow description. For a description on how to perform
non-interactive, automated installations, refer to Part IV, “Automated Installations”
(page 287).

6.6 The Boot Screen

The boot screen displays a number of options for the installation procedure. Boot from
Hard Disk boots the installed system and is selected default, because the CD is often
left in the drive. Select one of the other options with the arrow keys and press Enter to
boot it. The relevant options are:

Installation
The normal installation mode. All modern hardware functions are enabled. In case
the installation fails, see F5Kernel (page 95) for boot options that disable poten-
tially problematic functions.

Repair Installed System
Boots into the graphical repair system. More information on repairing an installed
system is available in Section “Recovering a Corrupted System” (Chapter 7,
Common Problems and Their Solutions, 1System Analysis and Tuning Guide).

Rescue System
Starts a minimal Linux system without a graphical user interface. For more infor-
mation, see Section “Using the Rescue System” (Chapter 7, Common Problems
and Their Solutions, 1System Analysis and Tuning Guide).
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Firmware Test
Starts a BIOS checker that validates ACPI and other parts of your BIOS.

Memory Test
Tests your system RAM using repeated read and write cycles. Terminate the test
by rebooting. For more information, see Section “Fails to Boot” (Chapter 7, Common
Problems and Their Solutions, 1 System Analysis and Tuning Guide). This option
is not available with the CD-KDE and CD-GNOME media.

Figure 6.1 The Boot Screen

Boot from Hard Disk
Repair Installed System
Rescue System
Firmware Test

Memory Test

Boot Options

F1 Help F2 Language F3 Video Mode F4 Source FS Kernel F6 Driver
English (US) 800 x 600 DVD Default No

Use the function keys indicated in the bar at the bottom of the screen to change the
language, screen resolution, installation source or to add additional driver from your
hardware vendor:

F1Help
Get context-sensitive help for the active element of the boot screen. Use the arrow
keys to navigate, Enter to follow a link, and Esc to leave the help screen.

F2Language
Select the display language and a corresponding keyboard layout for the installation.
The default language is English (US).
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F3Video Mode
Select various graphical display modes for the installation. Select Text Mode if the
graphical installation causes problems.

F4Source
Normally, the installation is performed from the inserted installation medium. Here,
select other sources, like FTP or NFS servers. If the installation is carried out in a
network with an SLP server, select an installation source available on the server
with this option. Find information about SLP in Chapter 20, SLP Services in the
Network (1 Administration Guide).

F5Kernel
In case you encounter problems with the regular installation, this menu offers to
disable a few potentially problematic functions. If your hardware does not support
ACPI (advanced configuration and power interface) select No ACPI to install
without ACPI support. No local APIC disables support for APIC (Advanced Pro-
grammable Interrupt Controllers) which may cause problems with some hardware.
Safe Settings boots the system with the DMA mode (for CD/DVD-ROM drives)
and power management functions disabled.

If you are not sure, try the following options first: Installation—ACPI Disabled or
Installation—Safe Settings. Experts can also use the command line (Boot Options)
to enter or change kernel parameters.

F6Driver
Press this key to tell the system that you have an optional driver update for SUSE
Linux Enterprise Server. With File or URL, load drivers directly before the instal-
lation starts. If you select Yes, you are prompted to insert the update disk at the
appropriate point in the installation process.

TIP: Using IPv6 during the Installation

By default you can only assign IPv4 network addresses to your machine. To
enable IPv6 during installation, enter one of the following parameters at the
bootprompt: ipv6=1 (accept IPv4 and IPv6) or ipv6only=1 (accept IPv6
only).

After starting the installation, SUSE Linux Enterprise Server loads and configures a
minimal Linux system to run the installation procedure. To view the boot messages
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and copyright notices during this process, press Esc. On completion of this process, the
YaST installation program starts and displays the graphical installer.

TIP: Installation without a Mouse

If the installer does not detect your mouse correctly, use Tab for navigation,
arrow keys to scroll, and Enter to confirm a selection. Various buttons or selec-
tion fields contain a letter with an underscore. Use Alt + Letter to select a button
or a selection directly instead of navigating there with Tab.

6.6.1 Providing Data to Access an SMT
Server

By default updates for SUSE Linux Enterprise Server are delivered by the Novell
Customer Center. If your network provides a so called SMT server to provide a local
update source, you need to equip the client with the server's URL. Client and server
communicate solely via HTTPS protocol, therefore you also need to enter a path to the
server's certificate if the certificate was not issued by a certificate authority. This infor-
mation can either be entered at the boot prompt as described here, or during the regis-
tration process as described in Section “Local Registration Server” (page 118).

smturl
URL of the SMT server. The URL has a fixed format
https://FQON/center/regsvc/ FON has to be full qualified hostname of
the SMT server. Example:

smturl=https://smt.example.com/center/regsvc/

smtcert
Location of the SMT server's certificate. Specify one of the following locations:

URL
Remote location (http, https or ftp) from which the certificate can be download-
ed. Example:

smtcert=http://smt.example.com/smt-ca.crt
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Floppy
Specifies a location on a floppy. The floppy has to be inserted at boot time,
you will not be prompted to insert it if it is missing. The value has to start with

the string £ 1oppy followed by the path to the certificate. Example:
smtcert=floppy/smt/smt-ca.crt

local path
Absolute path to the certificate on the local machine. Example:

smtcert=/data/inst/smt/smt-ca.cert

Interactive

Use ask to open a pop-up menu during the installation where you can specify
the path to the certificate. Do not use this option with AutoYaST. Example

smtcert=ask

Deactivate certificate installation

Use done if either the certificate will be installed by an add-on product, or if
you are using a certificate issued by an official certificate authority. Example:

smtcert=done

WARNING: Beware of typing errors

Make sure the values you enter are correct. If smturl has not been specified
correctly, the registration of the update source will fail. If a wrong value for
smtcert has been entered, you will be prompted for a local path to the certifi-
cate.

In case smtcert is not specified, it will default to http://FON/smt .crt with
FQN being the name of the SMT server.

6.6.2 Configuring an alternative data server
for supportconfig

The data supportconfig (see Chapter 2, Gathering System Information for Support
(* Administration Guide) for more information) gathers is sent to the Novell Customer
Center by default. It is also possible to set up a local server collecting this data. If such
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a server is available on your network, you need to equip the client with the server's
URL. This information has to be entered at the boot prompt.

supporturl
URL of the server. The URL has the format http://FQON/Path/ FON has to
be full qualified hostname of the server, Path has to be replaced with the location
on the server. Example:

supporturl=http://support.example.com/supportconfig/data/

6.7 Welcome

Start the installation of SUSE Linux Enterprise Server by choosing your language.
Changing the language will automatically preselect a corresponding keyboard layout.
Override this proposal by selecting a different keyboard layout from the drop-down
menu. The language selected here is also used to assume a time zone for the system
clock. This setting—along with the selection of secondary languages to install on your
system—can be modified later in the Installation Summary, described in Section 6.12,
“Installation Settings” (page 105). For information about language settings in the installed
system, see Chapter 13, Changing Language and Country Settings with YaST (page 185).

Read the license agreement that is displayed beneath the language and keyboard selection
thoroughly. Use License Translations... to access translations. If you agree to the terms,
check I Agree to the License Terms and click Next to proceed with the installation. If
you do not agree to the license agreement, you cannot install SUSE Linux Enterprise
Server. Click Abort to terminate the installation.
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Figure 6.2
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6.8 IBM System z:
Configuration
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Hard Disk

When installing on IBM System z platforms, the language selection dialog is followed
by a dialog to configure the attached hard disks. Select DASD, Fibre Channel Attached
SCSI Disks (ZFCP), or iSCSI for installation of SUSE Linux Enterprise Server.

After selecting Configure DASD Disks, an overview lists all available DASDs. To get
a clearer picture of the available devices, use the entry field located above the list to
specify a range of channels to display. To filter the list according to such a range, select
Filter. See Figure 6.3, “IBM System z: Selecting a DASD” (page 100).
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Figure 6.3 IBM System z: Selecting a DASD
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Now specify the DASDs to use for the installation by selecting the corresponding entries
in the list then clicking Select or Deselect. After that, activate and make the DASDs
available for the installation by selecting Perform Action > Activate. See Figure 6.4,
“IBM System z: Activating a DASD” (page 100). To format the DASDs, select Perform
Action> Format right away or use the YaST partitioner later as described in Section 15.1,
“Using the YaST Partitioner” (page 231).

Figure 6.4 [IBM System z: Activating a DASD
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To use ZFCP disks for the SUSE Linux Enterprise Server installation, select Configure
ZFCP Disks in the selection dialog. This opens a dialog with a list of the ZFCP disks
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available on the system. In this dialog, select Add to open another dialog in which to
enter ZFCP parameters.

To make a ZFCP disk available for the SUSE Linux Enterprise Server installation,
choose an available Channel Number from the drop-down list. Get WWPNs (World
Wide Port Number) and Get LUNs (Logical Unit Number) return lists with available
WWPNs and FCP-LUNS, respectively, to choose from. When completed, exit the ZFCP
dialog with Next and the general hard disk configuration dialog with Finish to continue
with the rest of the configuration.

TIP: Adding DASD or zFCP Disks at a Later Stage

Adding DASD or zFCP disks is not only possible during the installation workflow,
but also when the installation proposal is shown. To add disks at that stage,
click Expert and scroll down. The DASD and zFCP entries are shown at the very
bottom.

After adding the disks, reread the partition table. Return to the installation
proposal screen and choose Partitioning then select Reread Partition Table.
This reads the new partition table and resets any previously entered information.

6.9 Installation Mode

After a system analysis where YaST probes for storage devices and tries to find other
installed systems on your machine, the installation modes available are displayed.

New installation
Select this option to start a new installation from scratch.

Update
Select this option to update to a newer version. For more information about system
update, see Chapter 7, Updating SUSE Linux Enterprise (page 125).

Repair Installed System
Choose this option to repair a damaged system that is already installed. More infor-
mation is available in Section “Recovering a Corrupted System” (Chapter 7,
Common Problems and Their Solutions, tSystem Analysis and Tuning Guide).
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Figure 6.5 Installation Mode
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This screen also offers to include add-on products during the installation. To include
such products, check Include Add-On Products from Separate Media. An add-on
product can include extensions, third-party products or additional software for your
system.

Click Next to proceed. If you selected to include an add-on product, proceed with Sec-
tion 6.9.1, “Add-On Products” (page 102), otherwise skip the next section and advance
to Section 6.10, “Clock and Time Zone” (page 103).

6.9.1 Add-On Products

Add-on products can be installed either from a local source (CD, DVD, or directory)
or from a network source (HTTP, FTP, NFS, CIFS,...). When installing from a network
source, you need to configure the network first—unless you are performing a network
installation anyway. Choose Yes, Run the Network Setup and proceed as described in
Section “Network Setup” (page 103). If the add-on product is available locally, select
No, Skip the Network Setup.

Click Next and specify the product source. Source types available are CD, DVD, Hard
Disk, USB Stick or Disk, a Local Directory or a Local ISO Image, if no network was
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configured. If the add-on product is available on removable media, the system automat-
ically mounts the media and reads it's contents. If the add-on product is available on
hard disk, choose Hard Disk to install from an unmounted hard drive, or Local Direc-
tory/Local ISO Image if it is located in the file system. Add-on products may be delivered
as a repository or as a set of rpm files. In the latter case, check Plain RPM Directory.
While a network is available, you can chooses from additional remote sources such as
HTTP, SLP, FTP and others. It is also possible to specify a URL directly.

Check Download Repository Description Files to download the files describing the
repository now. If unchecked, they will be downloaded once the installation starts.
Proceed with Next and insert a CD or DVD if required. Depending on the product's
content it may be necessary to accept additional license agreements.

It is also possible to configure add-on products at any time in the installed systems.
Using add-on products in the installed system is described in Chapter 10, /nstalling
Add-On Products (page 161).

Network Setup

When invoking the network setup, YaST scans for available network cards. If more
than one network card is found, you have to choose the card to configure from the list.

If an ethernet network adapter is not already connected, a warning will open. Make
sure the network cable is plugged in and choose Yes, Use It. If your network is equipped
with a DHCP server, choose Automatic Address Setup (via DHCP). To manually set
up the network choose Static Address Setup and specify IP Address, Netmask, Default
Gateway IP, and the DNS Server IP.

Some networks require the use of a proxy server to access the Internet. Tick the check
box Use Proxy for Accessing the Internet and enter the appropriate specifications. Click
Accept to perform the network setup. The installation procedure will continue with the
add-on products or repositories setup as described in Section 6.9.1, “Add-On Products”
(page 102).

6.10 Clock and Time Zone

In this dialog, select your region and time zone. Both are preselected according to the
selected installation language. To change the preselected values, either use the map or
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the drop down lists for Region and Time Zone. When using the map, point the cursor
at the rough direction of your region and left-click to zoom. Now choose your country
or region by left-clicking. Right-click to return to the world map.

Figure 6.6 Clock and Time Zone
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To set up the clock, choose whether the Hardware Clock is Set to UTC. If you run an-
other operating system on your machine, such as Microsoft Windows*, it is likely your
system uses local time instead. If you only run Linux on your machine, set the hardware
clock to UTC and have the switch from standard time to daylight saving time performed
automatically.

If a network is already configured, you can configure time synchronization with an
NTP server. Click Change to either alter the NTP settings or to Manually set the time.
See Chapter 21, Time Synchronization with NTP (* Administration Guide) for more
information on configuring the NTP service. When finished, click Accept to continue
the installation.
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6.11 Server Base Scenario

In SUSE Linux Enterprise Server, you can choose from three base scenarios. The se-
lected scenario affects the package selection.

Physical Machine
Choose this scenario when installing on a “real” machine without XEN.

Virtual Machine
Choose this scenario when installing in a virtual machine, such as XEN.

XEN Virtualization Host
Choose this scenario when installing on a machine, that should serve as a XEN
host.

Figure 6.7 Server Base Scenario
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6.12 Installation Settings

On the last step before the real installation takes place, you can alter installation settings
suggested by YaST and also review the settings you made so far. Basic settings can be
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changed in the Overview tab, advanced options are available on the Experts tab. To

modify the suggestions, either click Change and select the category to change or click
on one of the headlines. After configuring any of the items presented in these dialogs,
you are always returned to the Installation Settings window, which is updated accord-

ingly.

Figure 6.8 Installation Settings
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TIP: Restoring the Default Settings

You can reset all changes to the defaults by clicking Change > Reset to Defaults.
YaST then shows the original proposal again.

6.12.1 Partitioning (Overview)

Review and—if necessary—change the partition setup proposed by the system.
Changing the partition setup either let's you partition a specific disk or, when choosing
Custom Partitioning, apply your own partitioning scheme. Modifying the partition
setup opens the Expert Partitioner described in Section 15.1, “Using the YaST Partition-

er” (page 231).
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6.12.2 Booting (Expert)

» zseries: This module cannot be used to configure the boot loader (zipl) on the IBM
System z platforms. <

YaST proposes a boot configuration for your system. Other operating systems found
on your computer, such as Microsoft Windows or other Linux installations, will auto-
matically be detected and added to the boot loader. However, SUSE Linux Enterprise
Server will be booted by default. Normally, you can leave these settings unchanged. If
you need a custom setup, modify the proposal for your system. For information, see
Section “Configuring the Boot Loader with YaST” (Chapter 9, The Boot Loader GRUB,
t Administration Guide).

6.12.3 Software (Overview)

SUSE Linux Enterprise Server contains a number of software patterns for various ap-
plication purposes. Click Software to start the pattern selection and modify the installa-
tion scope according to your needs. Select your pattern from the list and see a pattern
description in the right part of the window. Each pattern contains a number of software
packages needed for specific functions (Web and LAMP server or a print server). For
a more detailed selection based on software packages to install, select Details to switch
to the YaST Software Manager.

You can also install additional software packages or remove software packages from
your system at any later time with the YaST Software Manager. For more information,
refer to Chapter 9, Installing or Removing Software (page 141).
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Figure 6.9 Software Selection and System Tasks
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NOTE: Default Desktop

The default desktop of SUSE Linux Enterprise Server is GNOME. To install KDE,
click Software and select KDE Desktop Environment from Graphical Environment.

6.12.4 Language (Overview)

Here you can change the system Language you defined in the first step of the installation.
It is also possible to add additional languages. To adjust the system language settings,
select Language. Select a language from the list. The primary language is used as the
system language. You can also adapt keyboard layout and time zone to the primary
language if the current settings differ. Details lets you tune language settings for the
user root, set UTF -8 support, or further specify the language (e.g. select South African
English).

Choose secondary languages to be able to switch to one of these languages at any time
without having to install additional packages. For more information, see Chapter 13,
Changing Language and Country Settings with YaST (page 185).
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6.12.5 Add-On Products (Expert)

If you added a source for an add-on media earlier, it appears here. Add, remove, or
modify add-on products here if needed.This is the same configuration dialog as discussed
earlier in Section 6.9.1, “Add-On Products” (page 102).

6.12.6 Keyboard Layout (Expert)

To change the keyboard layout, select Keyboard Layout. By default, the layout corre-
sponds to the language chosen for installation. Select the keyboard layout from the list.
Use the Test field at the bottom of the dialog to check if you can enter special characters
of that layout correctly. Options to fine-tune various settings are available under Expert
Mode. Find more information about changing the keyboard layout in Section 8.3,
“Setting Up Keyboard and Mouse” (page 131). When finished, click Accept to return
to the installation summary.

6.12.7 Time Zone (Expert)

Adjust time zone and clock settings here. Provided a network is configured, you can
also set up a Network Time Protocol (NTP) client that automatically synchronizes your
computer with a time server. This is the same configuration as shown earlier in Sec-
tion 6.10, “Clock and Time Zone” (page 103).

6.12.8 Default Runlevel (Expert)

SUSE Linux Enterprise Server can boot to different runlevels. Normally, there should
be no need to change anything here, but if necessary set the default runlevel with this
dialog. Refer to Section “Configuring System Services (Runlevel) with YaST” (Chap-
ter 8, Booting and Configuring a Linux System, T Administration Guide) for more infor-
mation about runlevel configuration.

6.12.9 System (Expert)

This dialog presents all the hardware information YaST could obtain about your com-
puter. When called, the hardware detection routine is started. Depending on your system,
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this may take some time. Select any item in the list and click Details to see detailed
information about the selected item. Use Save fo File to save a detailed list to either the
local file system or a floppy. Advanced users can also change the PCI ID setup and
Kernel Settings by choosing System Settings.

6.12.10 Kdump (Expert)

Using kdump, you can save a dump of the kernel in case of a crash to analyze what
went wrong. Use this dialog to enable and configure kdump. Find detailed information
at Chapter 4, Kexec and Kdump (1System Analysis and Tuning Guide).

6.13 Performing the Installation

After making all installation settings, click /nstall in the Installation Settings window
to start the installation. Some software may require a license confirmation. If your
software selection includes such software, license confirmation dialogs are displayed.
Click Accept to install the software package. When not agreeing to the license, click 7
Disagree and the software package will not be installed. In the dialog that follows,
confirm with Install again.

The installation usually takes between 15 and 30 minutes, depending on the system
performance and the selected software scope. After having prepared the hard disk and
having saved and restored the user settings, the software installation starts.

After the software installation has completed, the basic system is set up. Among others,
“Finishing the Basic Installation” includes installing the boot manager, initializing fonts
and more. Next YaST boots into the new Linux system to start the system configuration.

TIP: Existing SSH Host Keys

If you install SUSE Linux Enterprise Server on a machine with existing Linux in-
stallations, the installation routine automatically imports the SSH host key with
the most recent access time from an existing installation.
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6.13.1 IBM System z: IPLing the Installed
System

In most cases, YaST automatically reboots into the installed system on the IBM System
z platform. Known exceptions to this are installations, where the bootloader resides on
an FCP device in environments with LPAR on a machine older than z9 or with z/’VM

older than release 5.3. The bootloader gets written to the device, that holds the /boot
directory. If /boot is not on a separate partition, it is on the same partition as the root
file system /.

In cases where an automatic reboot is not possible, YaST will show a dialog box con-
taining information from which device to do an IPL. Accept the shutdown option and
perform an IPL after the shutdown. The procedure varies according to the type of instal-
lation:

LPAR Installation
In the IBM System z HMC, select Load, select Clear, then enter the loading address
(the device address of the device holding the /boot directory with the bootloader).
If using a ZFCP disk as the boot device, choose Load from SCSI and specify the
load address of your FCP adapter as well as WWPN and LUN of the boot device.
Now start the loading process.

z/VM Installation
Log in to the VM guest as LINUX1 and proceed to IPL the installed system:

IPL 151 CLEAR

151 is an example address of the DASD boot device, replace this value with the
correct address.

If using a ZFCP disk as the boot device, specify both the ZFCP WWPN and LUN
of the boot device before initiating the IPL. The parameter length is limited to eight
characters. Longer numbers must be separated by spaces:

SET LOADDEV PORT 50050763 00C590A9 LUN 50010000 00000000

Finally, initiate the IPL:

IPL FCOO
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FCOO0 is an example address of the ZFCP adapter, replace this value with the correct
address.

6.13.2 IBM System z: Connecting to the
Installed System

After IPLing the installed system, establish a connection with it to complete the instal-
lation. The steps involved in this vary depending on the type of connection used at the
outset.

Using VNC to Connect

A message in the 3270 terminal asks you to connect to the Linux system using a VNC
client. This message is easily missed, however, because it is mixed with kernel messages
and the terminal process might quit before you become aware of the message. If nothing
happens for five minutes, try to initiate a connection to the Linux system using a VNC
viewer.

If you connect using a Java-capable browser, enter the complete URL, consisting of
the IP address of the installed system along with the port number, in the following
fashion:

http://<IP of installed system>:5801/

Using X to Connect

When IPLing the installed system, make sure that the X server used for the first phase
of the installation is up and still available before booting from the dasd. YaST opens
on this X server to finish the installation. Complications may arise if the system is
booted up but unable to connect to the X server in a timely fashion.

Using SSH to Connect

IMPORTANT: IBM System z: Connecting from a Linux or UNIX System

Start SSH in an xterm. Other terminal emulators lack complete support for the
text-based interface of YaST.
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A message in the 3270 terminal asks you to connect to the Linux system with an SSH
client. This message is easily missed, however, because it is mixed with kernel messages
and the terminal process might quit before you become aware of the message.

Once the message appears, use SSH to log in to the Linux system as root. If the con-
nection is denied or times out, wait a few minutes then try again.

When the connection is established, execute the command
/usr/1lib/YaST2/startup/YaST2. ssh. Just executing the command yast
does not suffice in this case.

YaST then starts to complete the installation of the remaining packages and create an
initial system configuration.

6.14 Configuration of the Installed
System

The system is now installed, but not yet configured for use. The hardware, the network
and other services are not set up, yet.

6.14.1 System Configuration

Having rebooted, the system starts the manual configuration. If the configuration fails
at one of the steps of this stage, it restarts and continues from the last successful step.

Password for the System Administrator “root”

root is the name of the superuser, the administrator of the system. Unlike regular
users, who may or may not have permission to do certain things on the system, root
has unlimited power to do anything: change the system configuration, install programs,
and set up new hardware. If users forget their passwords or have other problems with
the system, root can help. The root account should only be used for system admin-
istration, maintenance, and repair. Logging in as root for daily work is rather risky:
a single mistake could lead to irretrievable loss of system files.
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For verification purposes, the password for root must be entered twice. Do not forget
the root password. Once entered, this password cannot be retrieved.

When typing passwords, the characters are replaced by dots, so you do not see the string
you are typing. If you are unsure whether you typed the correct string, use the 7est
Keyboard Layout field for testing purposes.

SUSE Linux Enterprise Server can use the DES, MD5, or Blowfish encryption algo-
rithms for passwords. The default encryption type is Blowfish. To change the encryption
type, click Expert Options > Encryption Type and select the new type.

The root can be changed any time later in the installed system. To do so run YaST
and start Security and Users > User and Group Management.

Hostname and Domain Name

The hostname is the computer's name in the network. The domain name is the name of
the network. A hostname and domain are proposed by default. If your system is part
of a network, the hostname has to be unique in this network, whereas the domain name
has to be common to all hosts on the network.

In many networks, the system receives its name over DHCP. In this case it is not nec-
essary to modify the proposed hostname and domain name. Select Change Hostname
via DHCP instead. To be able to access your system using this hostname, even when
it is not connected to the network, select Write Hostname to /etc/hosts.

To change hostname settings at any time after installation, use YaST Network Devices
> Network Settings. For more information, see Section “Configuring the Network Card
with YaST” (Chapter 18, Basic Networking, 1t Administration Guide).

Network Configuration

TIP: IBM System z: Network Configuration

For the IBM System z platforms, a working network connection is needed at
installation time to connect to the target system, the installation source, and
the YaST terminal controlling the process. The steps to set up the network are
discussed in Section 4.2.5, “Network Configuration” (page 59). The IBM System
z platforms only support the types of network interfaces mentioned there (OSA
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Ethernet, OSA Gigabit Ethernet, OSA Express Fast Ethernet, Escon, and IUCV).
The YaST dialog simply displays the interface with its settings as already config-
ured. Just confirm this dialog to continue.

By default, Traditional Method without NetworkManager Applet is enabled. If desired,
you can also use NetworkManager to manage all your network devices. However, the
traditional method is the preferred option for server solutions. Find detailed information
about NetworkManager in Chapter 24, Using NetworkManager (1 Administration
Guide).

The network can also be configured after the system installation has been completed.
If you skip it now, your system is left offline unable to retrieve any available updates.
To configure your network connection later, select Skip Configuration and click Next.

The following network settings can be configured in this step:

General Network Settings
Enable or disable the use of NetworkManager as described above. Also change the
IPv6 support here. By default the IPv6 support is enabled. To disable it, click Dis-
able IPv6. For more information about IPv6, see Section “IPv6—The Next Gener-
ation Internet” (Chapter 18, Basic Networking, * Administration Guide).

Firewall
By default SuSEfirewall2 is enabled on all configured network interfaces. To
globally disable the firewall for this computer, click on Disable. If the firewall is
enabled, you may Open the SSH port in order to allow remote connections via secure
shell. To open the detailed firewall configuration dialog, click on Firewall. See
Section “Configuring the Firewall with YaST” (Chapter 15, Masquerading and
Firewalls, tSecurity Guide) for detailed information.

Network Interfaces
All network cards detected by YaST are listed here. If you have already set up a
network connection during the installation (as described in Section “Network Setup”
(page 103)) the card used for this connection is listed as Configured. A click on
Network Interfaces opens the Network Settings dialog, where you can change exist-
ing configurations, set up networks cards not configured yet, or add and configure
additional cards. See Section 11.2, “Internet Connection Via Network” (page 166)
for checklists of configuration requirements for the various connection types and
Section “Configuring the Network Card with YaST” (Chapter 18, Basic Networking,
t Administration Guide) for configuration details.
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DSL Connections, ISDN Adapters, and Modems
If your computer is equipped with an internal DSL modem, an internal ADSL Fritz
Card, an ISDN card or a modem, clicking on the respective headline opens the
configuration dialog. Refer to Chapter 11, Accessing the Internet (page 163) for
further information.

VNC Remote Administration
To enable remote administration of your machine via VNC, click VNC Remote
Administration. Choose Allow Remote Administration in the following dialog and
adjust your firewall settings accordingly.

Proxy
If you have a proxy server controlling the Internet access in your network, configure
the proxy URLSs and authentication details in this dialog.

TIP: Resetting the Network Configuration to the Default Values

Reset the network settings to the original proposed values by clicking Change
> Reset to Defaults. This discards any changes made.

Test Internet Connection

After having configured a network connection, you can test it. For this purpose, YaST
establishes a connection to the SUSE Linux Enterprise Server server and downloads
the latest release notes. Read them at the end of the installation process. A successful
test is also a prerequisite for registering and updating online.

If you have multiple network interfaces, verify that the desired card is used to connect
to the Internet. If not, click Change Device.

To start the test, select Yes, Test Connection to the Internet and click Next. In the next
dialog, view the progress of the test and the results. Detailed information about the test
process is available via View Logs. If the test fails, click Back to return to the network
configuration to correct your entries.

If you do not want to test the connection at this point, select No, Skip This Test then
Next. This also skips downloading the release notes, configuring the customer center,
and updating online. These steps can be performed any time after the system has been
initially configured.
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Novell Customer Center Configuration

To get technical support and product updates, you need to register and activate your
product with the Novell Customer Center. The Novell Customer Center Configuration
provides assistance for doing so. Find detailed information about Novell Customer
Center at http://www.novell.com/documentation/ncc/.

If you are offline or want to skip this step, select Configure Later. This also skips SUSE
Linux Enterprise Server's online update.

In Include for Convenience, select whether to send unsolicited additional information,
such as your Hardware Profile or Optional Information when registering. This simplifies
the registration process. Click on Details to get in-depth information about how the
data will be collected. In order to obtain information about which data will be sent for
your specific product, the Novell server will be connected. Upon this initial connect no
data other than the ID of your product will be send to the Novell servers.

In order to become entitled for support, make sure to check Registration Code. You
will be prompted to enter the code when proceeding with Next. Find more information
about the technical supportathttp: //www.novell.com/products/server/
services_support.html.

NOTE: Data Privacy

No information is passed to anyone outside Novell. The data is used for statis-
tical purposes and to enhancer your convenience regarding driver support and
your Web account. Find a link to the detailed privacy policy by clicking on De-
tails. View the information transmitted in the log file at /root/.suse
_register.log.

Apart from activating and registering your product, this module also adds the official
update repositories to your configuration. These repositories provide fixes for known
bugs or security issues which can be installed via an online update.

To keep your repositories valid, select Regularly Synchronize with Customer Center.
This option checks your repositories and adds newly available catalogs or removes
obsolete ones. It does not touch manually added repositories.
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To keep your repositories valid, select Regularly Synchronize with Customer Center.
This option checks your repositories and adds newly available catalogs or removes
obsolete ones. It does not touch manually added repositories.

Proceed with Next. A connection with the Novell server is established. Follow the on-
screen instructions to finish the registration.

Local Registration Server

If your organization provides a local registration server instead of using the Novell
Customer Center, you need to specify the server's URL. Client and server communicate
solely via HTTPS protocol, therefore you also need to enter a path to the server's cer-
tificate if the certificate was not issued by a certificate authority. Open the dialog with
Advanced > Local Registration Server

Registration Server
URL of the registration server. The URL has a fixed format
https://FQON/center/regsvc/ FON has to be full qualified hostname of
the registration server. Example:

https://smt.example.com/center/regsvc/

Server CA certificate location
Location of the registration server's certificate. Specify one of the following loca-
tions:

URL
Remote location (http, https or ftp) from which the certificate can be download-
ed. Example:

http://smt.example.com/smt-ca.crt

Floppy
Specifies a location on a floppy. The floppy has to be inserted before proceed-

ing. The value has to start with the string £ 1 oppy followed by the path to the
certificate. Example:

floppy/smt/smt-ca.crt

local path
Absolute path to the certificate on the local machine. Example:

/data/inst/smt/smt-ca.cert
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Interactive

Use ask to open a pop-up menu where you can specify the path to the certifi-
cate. Do not use this option with AutoYaST. Example

ask

Deactivate certificate installation
Use done if either the certificate will be installed by an add-on product, or if
you are using a certificate issued by an official certificate authority. Example:

done

Online Update

If the Registration was successful, and updates are available, select whether to perform
a YaST online update. If there are any patched packages available on the servers,
download and install them now to fix known bugs or security issues. For detailed in-
structions see Chapter 1, YaST Online Update (1 Administration Guide). Directives on
how to perform an online update in the installed system are available at Section 9.5,
“Keeping the System Up-to-date” (page 153) or Chapter 1, YaST Online Update (1 Ad-
ministration Guide). This step is skipped if no updates are available or if you haven't
registered.

Services

After testing the Internet connection and downloading the first updates, a dialog opens
in which to enable and configure two important network services.

CA Management
The purpose of a CA (certificate authority) is to guarantee a trust relationship among
all network services communicating with each other. Without a CA, you can secure
server communications with SSL. and TLS separately for each individual service.
By default, a CA is created and enabled during the installation. Find details about
the creation of a CA with YaST in Chapter 17, Managing X.509 Certification
(*Security Guide).

OpenLDAP Server
You can run an LDAP service on your host to have a central facility manage a
range of configuration files. Typically, an LDAP server handles user account data,
but with SUSE Linux Enterprise Server it can also be used for mail, DHCP, and
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DNS data. By default, an LDAP server is set up during the installation. If you decide
against the use of an LDAP server, the YaST mail server module does not work
because it depends on LDAP functionality. However, you can still set up a mail
server on your system with the help of the Mail Transfer Agent module. Find details
about LDAP and its configuration with YaST in Chapter 4, LDAP—A Directory
Service (1Security Guide).

If preferred, you can skip this configuration proposal for now. After the installation is
finished, configure and start the same services with the help of YaST.

TIP: Resetting the Service Configuration to Defaults

Restore the defaults by clicking Change > Reset to Defaults. This discards any
changes made.

User Authentication Method

If network access was configured successfully during the previous steps of the installa-
tion, you can now choose from several user management options. If a network connection
has not been configured, create local user accounts. You may also, if present, import
users from a previous installation. Also change the password encryption type in this
dialog.

You can also add additional user accounts or change the user authentication method in
the installed system. For detailed information about user management, see Chapter 12,
Managing Users with YaST (page 167).

The default authentication method is Local (/etc/passwd). If a former version of SUSE
Linux Enterprise Server or another system using /et c/passwd is detected, you may
import local users. To do so, check Read User Data from a Previous Installation and
click Choose. In the next dialog, select the users to import and finish with OK.

Manually enter local users by clicking Next. The New Local User dialog opens. After
entering the first name and last name, either accept the proposal or specify a new
Username that will be used to log in. Finally, enter a password for the user. Reenter it
for confirmation (to ensure that you did not type something else by mistake). To provide
effective security, a password should be between five and eight characters long. The
maximum length for a password is 72 characters. However, if no special security
modules are loaded, only the first eight characters are used to discern the password.
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Passwords are case-sensitive. Special characters (7-bit ASCII) and the digits 0 to 9 are
allowed. Other special characters like umlauts or accented characters are not allowed.

Passwords you enter are checked for weakness. When entering a password that is easy
to guess, such as a dictionary word or a name, you will see a warning. It is a good secu-
rity practice to use strong passwords.

Two additional options are available:

Receive System Mail
Checking this box sends messages created by the system services to the user. These
are usually only sent to root, the system administrator. This option is useful for
the most frequently used account, because it is highly recommended to log in as
root only in special cases.

The mails sent by system services are stored in the local mailbox /var/spool/
mail/username, where username is the login name of the selected user. To
read e-mails after installation, you can use any e-mail client, for example KMail
or Evolution.

Automatic Login
This option automatically logs the current user in to the system when it starts. This
is mainly useful if the computer is operated by only one user. For automatic login
to work, the option must be explicitly enabled.

WARNING: Automatic Login

With the automatic login enabled, the system boots straight into your desktop
with no authentication at all. If you store sensitive data on your system, you
should not enable this option if the computer can also be accessed by others.

Enter more users by calling the User Management module described in Chapter 12,
Managing Users with YaST (page 167).

When using a network server for user authentication, access to the following services
can be configured:
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LDAP
Users are administered centrally on an LDAP server for all systems in the network.
More information is available in Section “Configuring an LDAP Client with YaST”
(Chapter 4, LDAP—A Directory Service, tSecurity Guide).

NIS
Users are administered centrally on a NIS server for all systems in the network.
See Section “Configuring NIS Clients” (Chapter 3, Using NIS, tSecurity Guide)
for more information.

Windows Domain
SMB authentication is often used in mixed Linux and Windows networks. Detailed
information is available in Section “Samba Server in the Network with Active Di-
rectory” (Chapter 25, Samba, t Administration Guide) and Section “Configuring a
Linux Client for Active Directory” (Chapter 5, Active Directory Support, tSecurity
Guide).

Along with user administration via LDAP and NIS, you can use Kerberos authentication.
To use it, select Set Up Kerberos Authentication. For more information on Kerberos,
refer to Chapter 6, Network Authentication with Kerberos (1Security Guide).

Release Notes

After completing the user authentication setup, YaST displays the release notes. Reading
them is recommended, because they contain important up-to-date information which
was not available when the manuals were printed. If you successfully tested the Internet
connection, read the most recent version of the release notes, as fetched from SUSE
Linux Enterprise Server's servers. Use Miscellaneous > Release Notes in YaST or start
the SUSE Help Center to view the release notes after installation.

Hardware Configuration

At the end of the installation, YaST opens a dialog for the configuration of the graphics
card and other hardware components connected to the system. Click the individual
components to start the hardware configuration. For the most part, YaST detects and
configures the devices automatically.
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TIP: IBM System z: Hardware Configuration

On the IBM System z, there is no display that would be supported by XFree.
Accordingly, you do not find a Graphics Cards entry on these systems.

You can skip any peripheral devices and configure them later, as described in Chapter 8,
Setting Up Hardware Components with YaST (page 129). To skip the configuration,
select Skip Configuration and click Next.

However, when setting up a desktop system you should configure the graphics card
right away. Although the display settings as configured by YaST should be generally
acceptable, most users have very strong preferences as far as resolution, color depth,
and other graphics features are concerned. To change these settings, select the respective
item and set the values as desired.

TIP: Resetting Hardware Configuration to the Default Values

You can cancel any changes to the hardware configuration by clicking Change
> Reset to Defaults. YaST then shows the original proposal again.

Installation Completed

After a successful installation, YaST shows the Installation Completed dialog. In this
dialog, select whether to clone your newly installed system for AutoYaST. To clone
your system, select Clone This System for AutoYaST. The profile of the current system
is stored in /root/autoyast.xml. Cloning is selected by default.

AutoYaST is a system for installing one or more SUSE Linux Enterprise Server systems
automatically without user intervention. AutoYaST installations are performed using
a control file with installation and configuration data.For detailed information, refer to
Chapter 21, Automated Installation (page 289). Finish the installation of SUSE Linux
Enterprise Server with Finish in the final dialog.
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6.15 Graphical Login

TIP: IBM System z: No Graphical Login

The graphical login is not available on IBM System z platforms.

SUSE Linux Enterprise Server is now fully installed and configured. Unless you enabled
the automatic login function or customized the default runlevel, you should see the
graphical login on your screen in which to enter a username and password to log in to
the system. On single user systems with automatic login enabled, the desktop starts
automatically.
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Updating SUSE Linux
Enterprise

SUSE® Linux Enterprise provides the option of updating an existing system to the new
version without completely reinstalling it. No new installation is needed. Old data, such
as home directories and system configuration, is kept intact. During the life cycle of
the product, you can apply Service Packs to increase system security and correct software
defects. Install from a local CD or DVD drive or from a central network installation
source.

7.1 Updating SUSE Linux Enterprise

Follow the steps outlined in this section, if you want to update from SUSE Linux Enter-
prise Server 10 to SUSE Linux Enterprise Server 11, for example. Make sure you update
the old system to the most recent patch level first—at the moment, that is SP2.

Software tends to “grow” from version to version. Therefore, take a look at the available

partition space with df before updating. If you suspect you are running short of disk
space, secure your data before updating and repartition your system. There is no general
rule of thumb regarding how much space each partition should have. Space requirements
depend on your particular partitioning profile and the software selected.

7.1.1 Preparations

Before updating, copy the old configuration files to a separate medium, such as tape
device, removable hard disk, USB stick, or ZIP drive, to secure the data. This primarily
applies to files stored in /et c as well as some of the directories and files in /var and
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/opt. You may also want to write the user data in /home (the HOME directories) to
a backup medium. Back up this data as root. Only root has read permission for all
local files.

Before starting your update, make note of the root partition. The command df / lists
the device name of the root partition. In Example 7.1, “List with df -h” (page 126), the
root partition to write down is /dev/sda3 (mounted as /).

Example 7.1 List with df-h

Filesystem Size Used Avail Use% Mounted on
/dev/sda3 74G 22G 53G  29% /

tmpfs 506M 0 506M 0% /dev/shm
/dev/sda5 116G 5.8G 111G 5% /home
/dev/sdal 44G 4G 40G 9% /data

7.1.2 Possible Problems

If you update a default system from the previous version to this version, YaST works
out necessary changes and performs them. Depending on your customizations, some
steps or the entire update procedure may fail and you must resort to copying back your
backup data. Check the following issues before starting the system update.

Checking passwd and group in /etc

Before updating the system, make sure that /et c/passwd and /etc/group do not
contain any syntax errors. For this purpose, start the verification utilities pwck and
grpck as root and eliminate any reported errors.

PostgreSQL

Before updating PostgreSQL (postgres), dump the databases. See the manual page
of pg_dump. This is only necessary if you actually used PostgreSQL prior to your
update.
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7.1.3 Updating with YaST

Following the preparation procedure outlined in Section 7.1.1, “Preparations” (page 125),
you can now update your system:

1

Optionally, prepare an installation server. For background information, see Sec-
tion 14.2.1, “Setting Up an Installation Server Using YaST” (page 202).

Boot the system as for the installation, described in Section 6.5, “System Start-
Up for Installation” (page 93). In YaST, choose a language and select Update
in the Installation Mode dialog. Do not select New Installation.

YaST determines whether there are multiple root partitions. If there is only one,
continue with the next step. If there are several, select the right partition and
confirm with Next (/dev/sda3 was selected in the example in Section 7.1.1,
“Preparations” (page 125)). YaST reads the old £ st ab on this partition to analyze
and mount the file systems listed there.

In the Installation Settings dialog, adjust the settings according to your require-
ments. Normally, you can leave the default settings untouched, but if you intend
to enhance your system, check the packages offered in the Software Selection
submenus or add support for additional languages.

4a Click Update Options to update only software that is already installed (Only
Update Installed Packages) or to add new software and features to the system
according to selected patterns. It is advisable to accept the suggestion. You
can adjustment it later with YaST.

4b You also have the possibility to make backups (Backup) of various system
components. Selecting backups slows down the update process. Use this
option if you do not have a recent system backup.

5 Click Accept and confirm Start Update to start the software installation process.

At the end of the installation read the release notes and then click Finish to restart the
computer and log in.
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7.2 Installing Service Packs

Use Service Packs to update a SUSE Linux Enterprise installation. There are several
different ways in which you can apply a Service Pack. You can either update the existing
installation or start a whole new installation using the Service Pack media. Possible
scenarios for updating the system and setting up a central network installation source
are described here.

TIP: Installation Changes

Read the installation instructions on the Service Pack media for further changes.

7.3 Software Changes from Version
10 to Version 11

NOTE: Software Changes from SLES 10 to SLES 11

For a detailed list of software and configuration changes from SUSE Linux En-
terprise Server 10 to SUSE Linux Enterprise Server 11, refer to the release notes
. View them in the installed system using the YaST release notes module.
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Setting Up Hardware
Components with YaST

YaST allows you to configure hardware items at installation time as well as in the in-
stalled system. Configure additional graphics cards and monitors, adjust mouse and
keyboard settings and configure sound hardware. If you need printer or scanner support,
use the appropriate YaST modules to configure these hardware items. Learn which
hardware components are connected to your computer by using the YaST Hardware
Information module.

8.1 Probing Your Hardware

Use YaST, if you want to know more about your hardware or if you need to find out
details like vendor and model of a certain hardware to be able to properly configure it.
Here and in the following sections we assume that you already started YaST (for exam-
ple, by pressing Alt + F2 and entering kdesu yast2 (KDE) or gnomesu yast?2
(GNOME) followed by the root password, because YaST needs system administrator
permissions to change the system files):

1 In YaST click Hardware > Hardware Information. Hardware probings starts
immediately and it will take some time until you see the hardware information
tree in a separate window.

2 In the hardware information tree recursively click on the plus icons to expand
the information about a specific device.

3 Click Close to leave the hardware information overview.
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8.2 Setting Up Graphics Card and
Monitor

After the installation you can change the configuration of your graphics system
(graphics card and monitor) according to your needs. Such a change can be necessary
because of accessibility issues or hardware upgrades.

WARNING: Changing Monitor Frequencies

Although there are safety mechanisms, you should still be very careful when
manually changing the allowed monitor frequencies. Incorrect values might
destroy your monitor. Always refer to the monitor's manual before changing
frequencies.

Change the resolution, if fonts are too small or if circles appear misshapen. Proceed as
follows:

1 In YaST, click Hardware > Graphics Card and Monitor. SaX2 checks the system
resources and displays a window.

2 Make sure the monitor is properly detected. If not, use Change to select the ap-
propriate model from the list.

3 Select an appropriate Resolution and Colors, if necessary.

m m Card and Monitor Properties
Mouse Display 1
Keyboard Card:  ATI Radeon X300 (RV370) 5860 (PCIE) Cptions..
Monitor: ['YAMA PROLITE E4315 Change
-}‘ Tablst
—_ Properties
y Resolution Colors
el Touchscreen

1280x1024 (SXGA) % 167 Mio. [24 bit] S

Dual Head Mode

Activate Dual Head Mode

No configuration available

v| Activate 3D Acceleration
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4 Test the new configuration before it is applied to the system. Click Ok to decide
what to do with your configuration (7est, Save, or Cancel.)

To activate a second monitor, proceed as follows:

1 In YaST, click Hardware > Graphics Card and Monitor. SaX2 checks the system
resources and displays the Card and Monitor Properties dialog.

2 Make sure the monitor is properly detected. If not, use Change to select the ap-
propriate model from the list.

3 Enable Activate Dual Head Mode and click Configure for further tuning.

4 Make sure the second monitor is properly detected. If not, use Change to select
the appropriate model from the list.

5 Decide whether you want to use the second monitor in Cloned Multihead or in
Xinerama Multihead mode and click Ok.

6 Test the new configuration before it is applied to the system. Click Ok to decide
what to do with your configuration (7est, Save, or Cancel.)

NOTE: Restarting the X Server

Any changes you make here take effect only after you restart the X server. If
you want to restart the X server now, log out from the graphical system and
log in again.

8.3 Setting Up Keyboard and Mouse

Reconfigure input devices such as the keyboard or the mouse, or add more than one of
these devices using the YaST Keyboard and Mouse modules.

8.3.1 Keyboard Layout

In case you want to replace a standard 104-key keyboard with a multimedia keyboard
or use a different language or country layout, proceed as follows:
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1 In YaST, click Hardware > Keyboard Layout. The SaX2 configuration tool reads
the system resources and displays the Keyboard Properties dialog.

: Monitor | Keyboard Properties

< 4 Mouse Layout | Options

Primary Sstup

- Keyboard Type [Microsoft Natural Keyboard Pro | Microsoftntsme:
Layout [u SA

m Tabet i [

[

- Additional Layouts
T Touchscreen

LCAERTRERTS

3 * Status  Layout Keyimble  Variant
] Afghanistan af
O Albania al
O Andorra ad

Variant A ]

Test

ok ] [ Gancel

2 Select your keyboard model from the Tpe list.
3 Select the country in the Layout list.

4 Depending on the country layout, you can choose a certain Variant. The selections
are applied immediately for testing.

5 As an option you can enable Additional Layouts. Check one or more boxes in
the list. This feature is handy if you want to switch between different languages
or scripts in the running system without the need for reconfiguration.

6 Before saving the configuration, use the 7est field at the bottom of the dialog to
check if special characters like umlauts and accented characters can be entered
and displayed correctly.

7 Click OK to leave the configuration dialog and in the following message click
Save to apply your changes.

132 Deployment Guide



NOTE: Configuring Console Keyboard Layout

By clicking the Save button as described in Step 7 (page 132) the setup of the
console keyboard layout takes place at the same time. If you want to change
the console keyboard layout, either call yast keyboard (the text mode in-
terface) or check the KEYTABLE and YAST_KEYBOARD settings in /etc/
sysconfig/keyboard.

8.3.2 Mouse Model

The mouse is usually detected automatically, but you can set up your mouse model
manually if the automatic detection fails. Refer to the documentation of your mouse
for a description of the model. If you want to modify your mouse configuration, proceed
as follows:

1 In YaST, click Hardware > Mouse Model. The SaX2 configuration tool reads
the system resources and displays the Mouse Properties dialog.

2 Click Change and select your mouse model from the list displayed.
3 Click OK to leave the configuration dialog and apply your changes with Save.

In the Options part of the dialog, set various options for operating your mouse.

Activate 3-Button Emulation
If your mouse has only two buttons, a third button is emulated whenever you click
both buttons simultaneously.

Activate Mouse Wheel
Check this box to use a scroll wheel.

Invert X-Axis | Invert Y-Axis
Check these options if you want to change the direction in which the mouse
pointer moves.

Activate Left-Hand Button Mapping
Check this box to make the button mapping suitable for left-hand usage.
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Emulate Wheel with Mouse Button
If your mouse does not have a scroll wheel but you want to use a similar function-
ality, you can assign an additional button for this. Select the button to use. While
pressing this button, any movement of the mouse is translated into scroll wheel
commands. This feature is especially useful with trackballs.

8.4 Setting Up Sound Cards

Most sound cards are detected automatically and configured with reasonable values.
In YaST, use Hardware > Sound if you want to add a problematic sound card that could
not be configured automatically or change the default settings. It is also possible to set
up additional sound cards or switch their sequence.

TIP: Probing for Old Sound Chips

If you know a legacy sound board is installed in your computer, let YaST probe
for old chips, if YaST cannot find a sound board. Within the pop-up click Yes,
probe.

If YaST cannot detect your sound card automatically, proceed as follows:

1 Click Add to open a dialog in which to select a sound card vendor and model.
Refer to your sound card documentation for the information required. Find a
reference list of sound cards supported by ALSA with their corresponding sound
modules in /usr/share/doc/packages/alsa/cards.txt and at
http://www.alsa-project.org/alsa—-doc/.

Make your choice and click Next.

2 In the Sound Card Configuration dialog, choose the configuration level in the
first setup screen:

Quick automatic setup
You are not required to go through any of the further configuration steps
and no sound test is performed. The sound card is configured automatically.

Normal setup
Adjust the output volume and play a test sound.
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Advanced setup with possibility to change options
Customize all settings manually.

Click Next to continue.

3 In Sound Card Volume, test your sound configuration and make adjustments to
the volume. You should start at about ten percent to avoid damage to your hearing
or the speakers. A test sound should be audible when you click Zest. If you cannot
hear anything, increase the volume. Press Next > Finish to complete the sound
configuration.

If you want to change the configuration of a sound card, go to the Sound Configuration
dialog, select a displayed Card Model and click Edit. Use Delete to remove a sound
card altogether.

Click the Other popup menu to customize one of the following options manually:

Volume...
Use this dialog is for setting the volume.

Play Test Sound
Use this option for testting the sound system.

Start Sequencer
For playback of MIDI files, check this option.

Set as the Primary Card
Click Set as the Primary Card if you want to adjust the sequence of your sound
cards. The sound device with index 0 is the default device and thus used by the
system and the applications.

PulseAudio Configuration...
Enter this dialog if you want to disable the PulseAudio sound system because you
want to use something else system-wide.

The volume and configuration of all sound cards installed are saved when you click
Finish. The mixer settings are saved to the file /etc/asound. conf and the ALSA
configuration data is appended to the end of the files /et c/modprobe.d/sound
and /etc/sysconfig/hardware.
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8.5 Setting Up a Printer

YaST can be used to configure a local printer that is directly connected to your machine
(normally with USB or parallel port) and to set up printing with network printers. It is
also possible to share printers over the network and to add 3rd party “drivers” (PostScript
Printer Description (PPD) files). Further information about printing (concepts, technical
details, and troubleshooting) is available in Chapter 11, Printer Operation (* Adminis-
tration Guide).

In YaST, click Hardware > Printer to start the printer module. By default it opens in

the Printer Configurations view, displaying a list of all printers available and configured.
This is especially useful when having access to a lot of printers via the network. From
here you can also Print a Test Page on the selected printer and configure local printers.

8.5.1 Configuring Local Printers

If an unconfigured local printer is detected, YaST starts automatically to configure it.
YaST can configure the printer automatically if the parallel or USB port can be set up
automatically and the connected printer can be detected. The printer model must also
be listed in the database used during the automatic hardware detection.

If the printer model is unknown or cannot be automatically detected, configure it man-
ually. There are two possible reasons why a printer is not automatically detected:

+ The printer does not identify itself correctly. This may apply to very old devices.
Try to configure your printer as described in Section “Configuring Manually”
(page 136).

+ If the manual configuration does not work, communication between printer and
computer is not possible. Check the cable and the plugs to make sure that the
printer is properly connected. If this is the case, the problem may not be printer-
related, but rather a USB or parallel port-related problem.

Configuring Manually

To manually configure the printer, select Add in the Printer Configurations view. YaST
will load a list of printer drivers—this may take some time. Use the Connection Wizard
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to specify how the printer is connected to the machine. Then choose a suitable driver
and specify a unique name for the printer queue in the Set Name field.

A printer is never used directly, but always through a printer queue. This ensures that
simultaneous jobs can be queued and processed one after the other. Each printer queue
is assigned to a specific driver, and a printer can have multiple queues. This makes it
possible to set up a second queue on a color printer, that prints black only, for example.
Refer to Section “The Workflow of the Printing System” (Chapter 11, Printer Operation,
t Administration Guide) for more information about print queues.

For many printer models, several drivers are available. When configuring the printer,
YaST defaults to the one marked recommended as a general rule. Normally it is be
necessary to change the driver—the recommended one should produce the best results.
However, if you want a color printer to print only in black and white, it is most conve-
nient to use a driver that does not support color printing, for example. If you experience
performance problems with a PostScript printer when printing graphics, it may help to
switch from a PostScript driver to a PCL driver (provided your printer understands
PCL).

If no driver for your printer is listed, you can try to select a generic driver with an ap-
propriate standard language from the list. Refer to your printer's documentation to find
out which language (the set of commands controlling the printer) your printer under-
stands. If this does not work, refer to Section “Adding Drivers with YaST” (page 137)
for another possible solution.

The printer is now configured with the default settings and ready to use. Click Finish
Add to return to the Printer Configurations view. The newly configured printer is now
visible in the printers list.

Adding Drivers with YaST

If your printer does not appear in the Assign Drivers dialog when adding a new printer,
the PPD (PostScript Printer Description) file for your model is not available. For more
information about PPD files, refer to Section “Installing the Software” (Chapter 11,
Printer Operation, t Administration Guide). To manually add a PPD file from the local
file system or an FTP or HTTP server, choose Add Driver.

Get PPD files directly from your printer vendor or from the driver CD of the printer.
For details, see Section “No Suitable PPD File Available for a PostScript Printer”
(Chapter 11, Printer Operation, t Administration Guide). Alternatively, you can also
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findPPDfilesathttp://www.linuxfoundation.org/en/OpenPrinting/,
the “OpenPrinting.org printer database”. When downloading PPD files from OpenPrint-
ing.org, keep in mind that it always shows the latest Linux support status, which is not
necessarily met by SUSE Linux Enterprise Server.

Fine-tuning a Local Printer Configuration

In order to adjust the default settings for paper size, resolution, media source and others,
choose a printer from the list in the Printer Configurations view and click Configure.
In the window for modifying the respective printer queue, you can make detailed ad-
justments by opening All options for the Current Driver. If you have access to more
than one printer queue, you can specify whether this should be the Default Printer. You
may also alter the generic printer Description and the Location description here.

For many printer models, several drivers are available. When configuring the printer,
YaST defaults to the one marked recommended as a general rule. See the Driver
section in the dialog for all drivers available. The one that is currently chosen is marked
as Current Driver.

Normally it is not necessary to change the driver—the one chosen by YaST should
produce the best results. However, if you want a color printer to print only in black and
white, it is most convenient to use a driver that does not support color printing, for ex-
ample. If you experience performance problems with a PostScript printer when printing
graphics, it may help to switch from a PostScript driver to a PCL driver (provided your
printer understands PCL).

8.5.2 Configuring Printing via the Network
with YaST

Network printers are not detected automatically. They must be configured manually
using the YaST printer module. Depending on your network setup, you can print to a
print server (CUPS, LPD, SMB, or IPX) or directly to a network printer (preferably via
TCP). Access the configuration view for network printing by choosing Printing via
Network from the left pane in the YaST printer module.
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Using CUPS

In a Linux environment CUPS is usually used to print via the network. The simplest
setup is to only print via a single CUPS server which can directly be accessed by all
clients. Check Do All Your Printing Directly via One Remote CUPS Server and specify
the name or IP address of the server. Click 7est the Server to make sure you have chosen
the correct name/IP address. Leave with OK.

If you print via more than one CUPS server, check Receive Printer Information from
remote CUPS Servers. Specify, whether you want to listen to servers in all networks
available, to servers in your local network, or to specific IP addresses. This setup needs
a running local CUPS daemon that communicates with the remote CUPS servers.
Therefore answer Yes when asked to start a local CUPS daemon.

Using Print Servers other than CUPS

If your network offers print services via print servers other than CUPS, start the Con-
nection Wizard and choose the appropriate Connection type. Ask your network admin-
istrator for details on configuring a network printer in your environment.

8.5.3 Sharing Printers Over the Network

Printers managed by a local CUPS daemon can be shared over the network and so turn
your machine into a CUPS server. Usually you share a printer by enabling CUPS' so
called “browsing mode”. If browsing is enabled, the local printer queues are made
available on the network for listening remote CUPS daemons. It is also possible to set
up a dedicated CUPS server, that manages all printing queues and can directly be ac-
cessed by remote clients. In this case it is not necessary to enable browsing.

To share your printer, open the Share Printers view in the YaST printer module. Select
Allow Remote Access and configure your CUPS daemon to be accessible For Computers
Within the Local Network. To enable the browsing mode, also check Publish Printers
by Default Within the Local Network. Then specify the network interface(s) that should
be used by the CUPS server. If you enable more than one interface, you can also enable
or disable the browsing mode on a per interface base. Apply the settings with OK and
allow to restart the CUPS server.

Setting Up Hardware Components with YaST

139






Installing or Removing
Software

Change the software collection of your system using YaST. This YaST module is
available in three toolkit flavors: Qt, GTK+, and ncurses; Qt and GTK+ flavors are
described here.

In YaST's software management tool search for software components you want to add
or remove. YaST resolves all the dependencies for you. Add additional software
repositories to your setup to install packages not shipped with the installation media
and let YaST manage them. Keep your system up-to-date by managing software updates
with openSUSE Updater.

9.1 Definition of Terms

Repository
A local or remote directory containing packages plus additional information about
these packages (package meta-data).

(Repository) Alias
A short name for a repository used by various zypper commands. The alias can be

chosen by the user when adding a repository and has to be unique.

Product
Represents a whole product, for example SUSE Linux Enterprise Server.

Installing or Removing Software

141



142

Pattern
A pattern is an installable list of packages needed for a special purpose. Examples
are Base System, providing the openSUSE basic system, or GNOME Base
System, containing all packages needed to run the GNOME Desktop environment.

Package
A package is a compressed file in rpm format that contains the files for a particular
program.

Patch
A patch consists of one or more packages—either full packages or patchrpm or
deltarpm packages— and may also introduce dependencies to packages that are
not installed yet.

Resolvable
An generic term for product, pattern, package or patch. The most commonly used
type of resolvable is a package or a patch.

patchrpm
A patchrpm consists only of files that have been updated since it was first released
for SUSE Linux Enterprise Server 11. Its download size is usually considerably
smaller than the size of a package.

deltarpm
A deltarpm consists only of the binary diff between two defined versions of a
package and therefore, has the smallest download size. Before being installed, the
rpm package has to be rebuilt on the local machine.

9.2 Using the Qt Interface

Start the YaST Qt interface on the command line with yast2 —--gt.

9.2.1 Installing Software

Software is available via RPM packages. Each package contains the program itself, the
configuration files, and additional documentation. If you want to add more software to
the system, proceed as follows:
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1 Click Software > Software Management to start the YaST package manager.

2 Inthe search field enter the name of the software you want to install (for example,
xpdf, a lightweight PDF viewer) and press Enter.

3 The package is listed in the right frame. Select it for installation. Once done, you
can search for more packages and select them for installation in one go.

4 Click Accept.

5 When all selected packages are installed, YaST asks you whether you want to
install or remove additional packages. Press No to close YaST.

By specifying various search criteria, you can restrict the search to display a few or
even only one package. You can also define special search patterns using wild cards
and regular expressions in Search Mode.

TIP: Quick Search

In addition to the Search filter, all lists of the package manager feature a quick
search. Click the respective list to gain focus (for example, the Package list)
and enter a letter to move the cursor to the first package in the list whose
name begins with this letter.

If you do not know the name of the software you are interested in, you can browse
through the software catalog in various ways. For example, you can filter by patterns,
package groups, languages, repositories, or installation summary. Filter by patterns, if
you are looking for software for a specific task:

1 From the filter list in the upper left corner, select Patterns. Now you see various
pattern sets listed in the area below.
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File View Package GConfiguration Dependencies Extras Hslp

Filjer.l Pattems

Pattern

E Graphical Environ

A "é' GNOME Deskiop Environment
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O KDE4 Desktop Enviranment
0 @ KDE3 Base System

O KDE4 Base System
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5 Desktop Functions
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=

Cfice Software

= Desktop Effects
= Graphics
4 »

3 Click Accept.

Package
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I bluez-gnome
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I ckiga
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NetworkManager VPN Support for v..
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Zooming Predictive Text Entry System
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A Grome based SIPH323 elecont,
The Integrated GNOME Mall, Calen
Evolution We beal

¥ gfip Multithrsadsd FTP Client for X11
[ anet Netwark Library for GLib-Based Pro
[ anoms-backgrounds GNOME Backgrounds

(F gnome-bluetooth GNOME Eluemu‘h Support .
4 L3

Description ‘ Technical Daia.

Dependencies | Versions | File Lis B

NetworkManager-openvpn-gnome - NetwarkManager VPN support for

OpenVPN

NetworkManags -openvpn provides VPN support to Netwarkhanage r for

OpenVPN.

The level of support is unspecified

to resolve possible package dependencies.

Filtering by languages is similar to filtering by package groups. Using the languages
view enables you to select packages like translated program messages, documentation,

or special fonts which are needed to support a specific language.

For installing corresponding source packages, use zypper. For more information, see
Section “Installing and Removing Software with Zypper” (Chapter 4, Managing Software

with Command Line Tools, t Administration Guide).
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2 From the patterns select one or more patterns you are interested in. If you click
on the name of a pattern, for example on Base Development, you see the packages
it contains, in the right frame. If you activate it, the status markers at the beginning
of the line will change: all packages get marked either with the status Keep or
Install. The meaning of all the symbols and font color changes is explained in
Help > Symbols.

Alternatively, filter by package groups. The package groups feature offers a more de-
tailed view of the software grouped by categories. Often packages depend on other
packages; if you select a package, you might be requested to install additional packages



Using the installation summary filter you see an overview of the packages you have
scheduled for installation. It is convenient for double-checking if many packages are
pending for installation.

9.2.2 Checking Software Dependencies

The software of one package might only work properly if the required package is also
installed. If packages with identical or similar functionality use the same system resource,
they should not be installed at the same time, because this would cause a package con-
flict.

When the package manager starts, it examines the system and displays the installed

packages. When you select to install and remove packages, the package manager auto-
matically checks the dependencies and selects any other required packages (resolution
of dependencies). If you select or deselect conflicting packages, the package manager
indicates this and suggests possible solutions to this problem (resolution of conflicts).

Check Dependencies and Autocheck are located under the information window. If you
click Check Dependencies, the package manager checks if the current package selection
results in any unresolved package dependencies or conflicts. In the event of unresolved
dependencies, the required additional packages are selected automatically. For package
conflicts, the package manager opens a dialog that shows the conflict and offers various
options for solving the problem.

If you activate Autocheck, any change of a package status triggers an automatic check.
This is a useful feature, because the consistency of the package selection is monitored
permanently. However, this process consumes resources and can slow down the package
manager. For this reason, Autocheck is not activated by default. In either case, a consis-
tency check is performed when you confirm your selection with Accept.

For example, sendmail and post f ix may not be installed concurrently. Figure 9.1,
“Conflict Management of the Package Manager” (page 146) shows the conflict message
prompting you to take a decision. post fix is already installed. Accordingly, you can
refrain from installing sendmail, remove postfix, or take the risk and ignore the
conflict.
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WARNING: Handling Package Conflicts

Unless you are very experienced, follow the suggestions of YaST when handling
package conflicts, because otherwise the stability and functionality of your
system could be endangered by the existing conflict.

Figure 9.1 Conflict Management of the Package Manager

',r_’f sendmail-8.14.3-49.4.i586 conlflicts with postfix provided by postfix-2.5.5-1.12.i586

Conflict Re solution:
deinstallation of postfix-2.5.5-1.12.i586

do not install sendmail-8.14.3-49 41586

[ CK - Try Again ] Expert - Cancel

9.2.3 Packages and Software Repositories

If you want to search for packages originating from one particular software repository,
use the Repositories filter. In the default configuration, this filter shows a list of all
packages from the selected installation source. To restrict the list, use a secondary filter.

To view a list of the all installed packages from the selected repository, select the filter
Repositories then select Installation Summary from Secondary Filter list and deactivate
all check boxes except Keep.

If you are interested in the opposite and want to detect packages not belonging to any
repository, also use the Repositories filter and select Unmaintained Packages as the
Secondary Filter.
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9.2.4 Removing Software

If you want to remove software from the system, proceed as follows:

1 Make use of a search strategy explained in Section 9.2.1, “Installing Software”
(page 142).

2 Depending on the search strategy, you can either select a complete set or single
packages one by one. For patterns, both ways are possible.

3 Click Accept and either watch the de-installation progress or adjust your selection,
if YaST complains about dependency issues.

9.3 Using the GTK+ Interface

Change the software collection of your system using YaST. In YaST's software man-
agement tool search for software components you want to add or remove. YaST resolves
all the dependencies for you. Add additional software repositories to your setup to install
packages not shipped with the installation media and let YaST manage them. Keep
your system up-to-date by managing software updates with openSUSE Updater.

Start the YaST GTK+ interface on the command line with yast2 --gtk.

9.3.1 Installing Software

Software is available via RPM packages. Each package contains the program itself, the
configuration files, and additional documentation. If you want to add more software to
the system, proceed as follows:

1 Click Software > Sofiware Management to start the YaST package manager.

2 In the package search field at the right window border enter the name of the
software you want to install (for example, xpdf, a leightweight PDF viewer).
YaST starts searching for the package while you enter the name. When the search
is finished, select the desired package in the main pane and click /nstall.

3 You are able to search for more packages and list them the same way.
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4 When finished, click Apply to perform the installation of the listed packages.

If you do not know the name of the software you are interested in, you can browse
through the software catalog in various ways. For example, you can group by patterns,
package groups, languages, or repositories. Group by patterns, if you are looking for
software for a specific task:

1 From the grouping menu in the upper left corner, select Patterns. Now you see
various pattern sets listed in the area below.

@ Software Manager

This tool lets you install, remove, and update applications. more

¥ _—
Available ’é; Upgrades = Installed All
Patterns & | Packages listing: |@_
4] Ist [
Linux Standard Base Core
5@ Fonts MozillaSunbird
(B nstalled: 5 0f 17 Mozilla's Calendar Application
MozillaSunbird-translations
Translations of Mozilla Sunbirct
Web-Based Ente = MozillaThunderhird
Installed: 0 of 4 The Stand-Alone Mozila Mail Component L
MozillaThunderhird-translations
Translations of MozillaThunderbird
Desktop Base S sane-frontends
Installed: 384 of 405 SANE-frontends xscanimage, xcam, and scanadf
| sisctrl
SiS Display Control Panel
GNOME (Default) testgart L
Installed: 220 of 252 Program for Testing AGPGART Support
KDE unclutter
Installed: 128 of 167 Remove the idle cursor image from the screen
X X Window System Windowhaker
Installed: 51 of 68 A Colorful and Flexible Window Manager
WindowlMaker-applets
[~] Window Maker Applets

|
s (1[<]

‘WindowMaker-themes
Themes for Window Maker

xpdf | Available:
This tool is used for viewing PDF (Portable Document Format) files. It is designed 3.02-07.48 (588)
to be small and efficient SUSE-Linu.top11-0 ™

S [F)instan

License: GP| v2 anlv nt

@He\p Tools v @ @Qance\

2 From the patterns select one or more patterns you are interested in. If you click
the name of a pattern, for example, Base Development, you see the packages it
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contains in the right frame. If you activate this pattern by clicking Install All, the
packages will get listed in the changes overview on the right side.

3 Click Apply to install all selected packages.

Alternatively, group by package groups. The package groups feature offers a more de-
tailed view of the software grouped by categories. Packages often depend on other
packages; if you select a package, you might be requested to install additional packages
to resolve possible package dependencies.

Grouping by languages is similar to grouping by package groups. Using the languages
view enables you to select packages like translated program messages, documentation,
or special fonts which are needed to support a specific language.

For installing corresponding source packages, use zypper. For more information, see
Section “Installing and Removing Software with Zypper” (Chapter 4, Managing Sofiware
with Command Line Tools, T Administration Guide).

9.3.2 Checking Software Dependencies

The software of one package might only work properly if the required package is also
installed. If packages with identical or similar functionality use the same system resource,
they should not be installed at the same time, because this would cause a package con-
flict.

When the package manager starts, it examines the system and displays the installed

packages. When you select a packag to install and remove it, the package manager au-
tomatically checks the dependencies and selects any other required packages (resolution
of dependencies). If you select or deselect conflicting packages, the package manager
indicates this and suggests possible solutions to this problem (resolution of conflicts).

For example, sendmail and post fix should not be installed concurrently. Figure 9.2,
“Conflict Management of the Package Manager” (page 150) shows a conflict message
prompting you to make a decision. post £ix is already installed. Accordingly, you
can decide wheter to install sendmail or remove postfix.
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WARNING: Handling Package Conflicts

Unless you are very experienced, follow the suggestions of YaST when handling
package conflicts, because otherwise the stability and functionality of your
system could be endangered by the existing conflict.

Figure 9.2 Conflict Management of the Package Manager
There are some conflicts on the
A transaction that must be solved manually.

sendmail-8.14.3-50.8.i586 conflicts with postfix provided by post
fix-2.5.5-6.3.1586

_) deinstallation of postfix-2.5.5-6.3.i586
) do not install sendmail-8.14.3-50.8.i586

9.3.3 Packages and Software Repositories

If you want to search for packages originating from one particular software repository,
use grouping by Repositories. This view shows a list of all packages from the selected
installation source.

To view a list of the all installed packages from the selected repository, click /nstalled.

From this listing select packages for removing. To accomplish the opposite action, click
Available and select packages for installation.
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9.3.4 Removing Software

If you want to remove software from the system, proceed as follows:

1 Make use of a search strategy explained in Section 9.3.1, “Installing Software”
(page 147).

2 In the Packages Listing mark the packages you want to remove. To mark all of
them with one click, right-click in the Packages Listing pane and and choose
Select All.

3 Click Remove.

If you try to remove a package which is required by installed software, the conflict
manager will complain about dependency issues and you must resolve the conflicts
first as descripted in Section 9.3.2, “Checking Software Dependencies” (page 149).

When all conflicts are resolved, the package scheduled for removing is listed in
the Changes pane on the right side.

4 Click Apply to perform all actions listed in the Changes pane.

9.4 Managing Software Repositories
and Services

Add additional software repositories to your system to install third-party software. By
default, the product repository such as SUSE Linux Enterprise Server-DVD 11 and a
matching update repository are configured once you registered your system. Depending
on the initially selected product, a separate language add-on repository with translations,
dictionaries, etc. might also be configured.

Here also manage subscriptions to so-called Services. A Service in this context is a
Repository Index Service (RIS) that can offer one or more software repositories. Such
a Service can be changed dynamically by its administrator or vendor.
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WARNING: Trusting External Software Sources

Before adding external software repositories to your list of repositories, make
sure this repository can be trusted. SUSE Linux Enterprise Server is not respon-
sible for any potential problems arising from software installed from third-
party software repositories.

To ensure the integrity software repositories can be signed with the GPG Key of the
repository maintainer. You can manage these keys in YaST—for more information,
see GPG Keys (page 153). Whenever you add a new repository, YaST offers to import
its key. Verify it as any other GPG key and pay attention that it does not change. If you
detect a key change, something could be wrong with the repository and you should
better disable it as an installation source until you know the cause of the key change.

To add product repositories either click Sofiware Repositories directly in the Sofiware
pane of the YaST control center, or from within the Software Management, proceed as
follows:

1 In the Software Management start screen, select Repositories from the upper left
drop-down menu and then click Edit to display an overview of configured soft-
ware repositories.

2 Click Add to select the media type holding the repository, for example, DVD or
USB Mass Storage with the language add-ons. Then click Next and provide ad-
ditional information about the medium.

3 YaST asks to insert the medium.

4 Confirm with Continue. It takes some moments until YaST has downloaded and
parsed the metadata of the repository. Once done you can install software from
this repository as described in Section 9.2.1, “Installing Software” (page 142)
resp. Section 9.3.1, “Installing Software” (page 147).

In the Configured Software Repositories overview find several configuration options:

Properties
By default, after adding a new repository, the repository is Enabled and the Auto-
matically Refresh is active. This means, YaST will pull in updated meta data auto-
matically and is always aware of new versions.
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The Priority of a repository is a value between 0 and 99, where 0 is the highest
priority. If a package is available in more than one repository the repository with
the highest priority wins. This is useful if you want to give a local repository (for
example, a DVD) a higher priority to avoid downloading packages unnecessarily
from the Internet although they have the same or a higher version number.

GPG Keys
Clicking GPG Keys, you open the GPG public keys management interface. In the
GPG Keys subdialog, you can add new keys manually, delete or edit existing keys.

Refresh
Refresh lets you update the repository meta data in various ways.

9.5 Keeping the System Up-to-date

Novell offers a continuous stream of software security patches for your product. The
updater applet informs you about the availability of patches and lets you easily install
them with just a few clicks.

9.5.1 Using the KDE Updater Applet

The updater applet resides in the system tray of your panel depicting the head of the
SUSE mascot (Geeko), which changes depending on the availability and relevance of
patches and the status of the updater. Whenever the icon changes, a tool tip displaying
the current status is shown, too. The applet is started by default. Choose Applications
> System > Desktop Applet > kupdateapplet from the main menu to manually start it.

Green Geeko Head with Green Arrows
No patches available.

Green Geeko Head with Yellow Arrows
The updater applet is busy (for example checking for updates, installing software).

Red Start with Arrow
Security patches available.

Orange Star with Arrow
Important patches are available.
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???Blue square with Arrow
Trivial patches are available.

Yellow Triangle with Exclamation Mark
An error occurred.

Blue Circle with Question Mark
No update repository is defined. When you click the updater applet in this state,
you are asked whether to check for updates. If you agree, the YaST Online Update
Configuration module is started.

Installing Patches

Whenever the updater icon shows the availability of patches, left-click to open the
software installation window. It lists the number of Security and Recommended
patches available. While the security patches are installed by default, you can choose
whether to install the recommended ones as well. Some patches, such as new kernel
versions, require to restart your computer. Check Do not Install Updates that Require
a Restart to skip these updates for now. Start updating your system by clicking Install.

Figure 9.3 KDE Updater Applet: Simple Update View

¥ New software for your system is available
::1“‘) 1 security update is available
- «| Install 1 recommended update additionally

% Install € Close

A click on Details opens the Available Updates window which shows a detailed
list of all patches and allows you to alter the selection of packages that will be installed.
Apart from the patch name the 7ype (Security, Recommended or Optional), a short
Summary and the patch version number is shown. Patches are sorted alphabetically by
default—change this by clicking on a column headline (Name, Summary, Type, New
Version, Catalog, or Restart). Click Install to proceed.
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Figure 9.4 KDE Updater Applet: Detailed Update View

AAvailable|Updates - Updater, Applet
Téo q
(&2)) Available Updates

Patches

The following official patches for your distribution either fix security holes o errors in the software.
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2 nstall Hypevisor and Tools
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¥aST Cont... | ® Error || @ voubak | & Availanie

() Retease Notes

| A o]
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You will be prompted for the root password after having proceeded with /nstall. The
updater performs the installation of the patches. See the system tray (KDE) or the noti-
fication area (GNOME) for status messages and a progress meter.

The YaST Online Update offers advanced features to customize the patch installation.
Please refer to Chapter 1, YaST Online Update (* Administration Guide) for more infor-

mation.

Installing New Software Versions

New software versions are available from software repositories provided by the open-
SUSE community. By default, no such repositories are preconfigured. To add a repos-
itory, right-click on the updater icon and choose Add/Remove Update Sources. You

need to enter the root password to start the Configured Software Repositories module.

WARNING: Trusting External Software Sources

Before adding external software repositories to your list of repositories make
sure this repository can be trusted. SUSE Linux Enterprise Server is not respon-
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sible for any potential problems arising from software installed from third
party software repositories.

The updater applet does not monitor repositories for new software versions by default.
To enable this feature, open the configuration window as described in Section “Config-
uring the Updater Applet” (page 156) and tick the check box Show Available Upgrades
When Back-End Provides Them check box. When the updater icon indicates the avail-
ability of updates, click on the icon to launch the software installation window. Click
on Details and then on the Upgrade tab to open the list with new software versions.
Either select single packages by checking the box in front of an entry, or click Select
All Packages. Install starts the installation of the selected software packages. You will
be prompted for the root password. See the system tray (KDE) or the notification area
(GNOME) for status messages and a progress meter.

Configuring the Updater Applet

By default the updater is started on login, checks for updates every 24 hours, shows
recurring notifications every 60 minutes and only monitors the availability of patches.
To change this behavior, right-click the applet icon and choose Configure Applet.

Figure 9.5 KDE Updater Applet: Configuration

~
Settings @
Check for updates every: 24 Hours ]
Show recurring netification when updates are available every: 60 Minutes £

Backend: PackageKit Plugin w

+ | Automatically start updater on login
Show available upgracdes when backend provides them (for experts only)
Always show detailed view

+ Check for updates only when the system is connected to charger

+| Check for updates only when the system is under low load

Search for drivers when new hardware is attached

¥ OK @ Cancel

156 Deployment Guide



The configuration dialog also offers to change the following settings:

Back-End
Choose between different back-ends. The Package Kit Plugin is used by default.
If you prefer the ZYpp Plugin, make sure the package
kded-kupdateapplet—zypp is installed.

Always Show Detailed View
Activate this option when you prefer the detailed patch view that lists all patches
available with short summaries rather than the simple view.

Check for Updates only When System Is Connected to Charger
Prohibits checking for updates when running on batteries in order to save power.
This option is activated by default but only affects mobile computers.

Check for Updates only When System Is under Low Load
Prohibits checking for updates when the system is under heavy load. This option
is activated by default.

Search for Drivers When New Hardware is Attached
Provided a repository offering appropriate drivers, the updater can automatically
install drivers for hardware such as USB devices.

9.5.2 Using the GNOME Updater Applet

The updater applet resides in the notification area of your panel. It's icon changes de-
pending on the availability and relevance of patches and the status of the updater. The
applet is started by default, choose Computer > More Applications > System > Update
System.

NOTE: Icon visibility

By default, the updater applet icon is only visible in the notification area, if
patches are available.

Open box with a globe
The updater is busy (for example checking for updates, installing software).
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Red Star with Exclamation Mark
Security patches available.

Orange Star with an Up Arrow
Recommended patches are available.

Yellow Star with a Down Arrow
Optional patches are available.

Yellow Triangle with Exclamation Mark
An error occurred.

Installing Patches

Whenever the updater icon shows the availability of patches, left-click the icon and
choose Update System Now. Provide the root password. The patches avaiable will be
installation in the background.

Alternatively, left-click the updater icon and choose Show Updates to open the Software
Update Viewer. In the overview it shows the number of patches available per category.
Click on Review to open a detailed view where all patches sorted by category are listed.
Security patches are displayed first, trivial patches last. Click on a patch to see details,
such as a description, version number, repository, and—if available—a link to bugzilla,
the Novell bug tracking system.

By default all patches are marked for installation. Uncheck the checkbox in front of a
patch to prevent a patch from being installed.
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Figure 9.6 GNOME Software Update Viewer: Detailed Update View

Security update for update-test-security
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Type: Security update
New version: update-test-security-208
Repository: nu_novell_com:SLED11-Updates

Description: Test update of update-test-security

Bugzilla: bug number 1
| @ e | | & Back to overview | | </ Apply Updates | | 3¢ close |

You will be prompted for the r oot password after having proceeded with Apply Updates
or Update System. The updater performs the installation of the patches. After having
finished the installation, choose whether to Install More Updates or whether to Close
the Software Update Viewer.

The YaST Online Update offers advanced features to customize the patch installation.
Please refer to Chapter 1, YaST Online Update (* Administration Guide) for more infor-
mation.

Configuring the Updater Applet

To configure the updater applet, either right-click the updater icon in the panel and
choose Preferences, or start the confuguration dialog with Computer > Control Center
> System > Sofiware Updates to manually start it.
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Figure 9.7 GNOME Updater Applet: Configuration

Update Settings

{»

Check for updates: Hourly

L

Automatically install: Mothing

{»

Check for major upgrades: Daily

Display Notification
When updates are available

When long tasks have completed

@lﬂelp x Close

The configuration dialog offers to change the following settings:

Check for Updates
Choose how often a check for updates is performed: Hourly, Daily, Weekly, or
Never.

Automatic Install
Configure whether patches are installed automatically or not (default). Automatic
installation can be chosen for either security patches only or for all patches.

Check for Major Upgrades
Choose how often a check for major updgrades is performed: Daily, Weekly, or
Never.

Display Notification Settings
Determine whether and when to show the updater applet icon in the panel with this
options.
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Installing Add-On Products

Add-on products are system extensions. You can install a third-party add-on product
or a special system extension of SUSE Linux Enterprise, for example, the SDK add-on
or a CD with binary drivers. To install a new add-on, use Sofiware > Add-On Products.
You can select various types of product media, like CD, FTP, USB mass storage devices
(such as USB flash drives or disks) or a local directory. You can also work directly
with local ISO files. To add an add-on as ISO file media, select Local ISO Image and
enter the Path to ISO Image. The Repository Name is arbitrary.

10.1 Add-Ons

To install a new add-on, proceed as follows:

1 Click Software > Add-On Products to see an overview of installed add-on prod-
ucts.

2 Select various types of product media, such as CD, FTP or a local directory, by
clicking Add. You can also use ISO images instead of CD or DVD media.

3 To add an ISO image, select Local ISO Image and clickNext.
4 Enter the Path to ISO Image and choose a Repository Name. Click Next.

5 After successfully adding the add-on media, the software manager window ap-
pears. If the add-on provides a new pattern, see the new item in the Patterns filter.
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To view the list of all packages from the selected software repository, select the
filter Software Repositories and choose the repository to view.

10.2 Binary Drivers

Some hardware needs binary-only drivers to function properly. If you have such hard-
ware, refer to the release notes for more information about availability of binary drivers
for your system. To read the release notes, open YaST and select Miscellaneous > Re-
lease Notes.

10.3 SUSE Software Development Kit
(SDK) 10

SUSE Software Development Kit 10 is an add-on for SUSE Linux Enterprise 10. It is
a complete tool kit for application development. In fact, to provide a comprehensive
build system, SUSE Software Development Kit 10 includes all the open source tools
that were used to build the SUSE Linux Enterprise Server product. It provides you as
a developer, independent software vendor (ISV), or independent hardware vendor
(IHV), with all the tools needed to port applications to all the platforms supported by
SUSE Linux Enterprise Desktop and SUSE Linux Enterprise Server.

SUSE Software Development Kit also contains integrated development environments
(IDEs), debuggers, code editors, and other related tools. It supports most major program-
ming languages, including C, C++, Java, and most scripting languages. For your con-
venience, SUSE Software Development Kit includes multiple Perl packages that are
not included in SUSE Linux Enterprise.

For detailed information, referto http://developer.novell.com/ndk/

susesdk . htm. Use the YaST add-on installer and package manager to install SUSE
Software Development Kit 10.
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Accessing the Internet

If you have chosen not to configure Internet access during the installation, you can
perform this task at any time using YaST. How to configure your computer to access
the Internet depends on your environment. If the computer you are installing is part of
anetwork which already is connected to the Internet, the only thing to do is to link your
machine into the network. If you are installing a machine that is directly connected to
the Internet, the hardware and the access to the Internet Service Provider (ISP) need to
be set up.

Please refer to the checklists below to make sure you have all the data ready to hand
when starting to configure the Internet access.

11.1 Direct Internet Connection

When your computer is directly connected to the Internet, you first need to configure
the hardware that is used for this task. This can either be an internal device (such as an
ISDN card) or an external device (for example a modem). In most cases it is detected
automatically.

In a second step you need to enter data provided by your ISP, such as login credentials,
gateway, or name server, for example. You should have received a data sheet from your
ISP where all the necessary data is listed.

If you have successfully configured your hardware and ISP data, use the NetworkMan-
ager for managing the internet connection. See Chapter 24, Using NetworkManager
(* Administration Guide) for details.
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11.1.1 Checklist DSL

There are different types of DSL devices available that use different point-to-point
protocol (PPP) methods:

+ aregular ethernet card connected to the external DSL modem uses PPP over Ethernet
(PPPoE). In Austria the Point-to-Point Tunneling Protocol (PPTP) is used. With
PPTP the external modem also has a static IP address.

+ an internal DSL modem uses PPP over ATM (PPPoATM)
+ an internal ADSL Fritz Card uses CAPI for ADSL

The DSL configuration module already contains the data for major ISPs in some
countries. If your ISP is not listed, you will need to know how name resolving (DNS)
and IP allocation is handled (in most cases this data is received automatically when
connecting). Regardless whether you choose an ISP from the list or add a custom
provider, you need to enter at least your login and password.

For configuration details, refer to Section “DSL” (Chapter 18, Basic Networking,
t Administration Guide).

11.1.2 Checklist ISDN

In case your internal ISDN card is not detected automatically you will need to know
the vendor and the name of the device.

NOTE: ISDN Modem or Terminal Adapter

If you are using an external ISDN modem or terminal adapter, refer to Sec-
tion 11.1.3, “Checklist Modem” (page 165) instead.

In order to configure the ISDN device you will need the following data:
+ ISDN Protocol (depends on your country)

+ Area code and phone number.
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+ Interface type (SyncPPP or RawIP). If unsure, select SyncPPP, because RawIP is
only used in connection with certain telephone systems.

+ In case you got a static [P-address from your provider: local and remote [P-addresses
for the dial-in server and the gateway.

» The ISDN configuration module already contains the data for major ISPs in some
countries. If your ISP is not listed, you will need to know how name resolving
(DNS) and IP allocation is handled (in most cases this data is received automatically
when connecting). Regardless whether you chose an ISP from the list or added a
custom provider, you need to enter at least your login and password.

For configuration details, refer to Section “ISDN” (Chapter 18, Basic Networking,
t Administration Guide).

11.1.3 Checklist Modem

In case your modem is not detected automatically, you need to know whether it is
connected to a serial port or to an USB port. Please note that not all USB modems and
internal modems are supported by SUSE® Linux Enterprise Server.

The modem configuration module already contains the data for major ISPs in some
countries. If your ISP is not listed, you will need to know its dial-in number and how
name resolving (DNS) and IP allocation is handled (in most cases this data is received
automatically when connecting). Regardless whether you chose an ISP from the list or
added a custom provider, you need to enter at least your login and password.

For configuration details, refer to Section “Modem” (Chapter 18, Basic Networking,
t Administration Guide).

11.1.4 Checklist Cable Modem

Accessing the Internet through the TV cable requires a cable modem. Such a modem
is connected to the computer via ethernet cable. Therefore it is only necessary to con-
figure your network card accordingly. For details, refer to Section “Cable Modem”
(Chapter 18, Basic Networking, t Administration Guide).
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11.2 Internet Connection Via Network

If your machine is part of a network which is already connected to the Internet, it is
very easy to gain Internet access—just configure your network card and connect your
machine to the existing network and you are done. This not only applies to large com-
pany networks, but to small home networks as well. Even if the machine you are in-
stalling is only connected to a router (e.g. a DSL router) it is already part of a network.

NOTE: Routing and Name Services

In the following it is assumed that the network is connected to the Internet
and provides routing and name services. In case these services are provided
by a router, make sure the router is configured correctly before setting up the
client.

11.2.1 Checklist Network

If your network provides DHCP (Dynamic Host Configuration Protocol) check the
appropriate check box when setting up the network card and you are done—all param-
eters needed will be provided by the DHCP server.

In case DHCP is not available, ask your network administrator for the following details:
* Hostname
+ Name server
+ Gateway

For configuration details, refer to Section “Configuring the Network Card with YaST”
(Chapter 18, Basic Networking, t Administration Guide).
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Managing Users with YaST

During installation, you have chosen a method for user authentication . This method
is either local (via /et c/passwd) or, if a network connection is established, via NIS,
LDAP, Kerberos or Samba (see Section “User Authentication Method” (page 120). You
can create or modify user accounts and can change the authentication method with
YaST at any time.

Every user is assigned a user ID (UID) which identifies him in the system. Apart from
the users which can log in to your machine, there are also a number of system users for
internal use only. Each user is assigned to one or more groups. Similar to system users,
there are also system groups for internal use. .

12.1 User and Group Administration
Dialog

To administrate users or groups, start YaST and click Security and Users > User and
Group Management. Alternatively, start the User and Group Administration dialog
directly by running yast2 users & from a command line.
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Figure 12.1 YaST User and Group Administration

-1 User and Group Administration
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Depending on the set of users you choose to view and modify with the dialog (local
users, network users, system users), the main window shows several tabs. These allow

you to execute the following tasks:

Managing User Accounts

From the Users tab, create, modify, delete or temporarily disable user accounts as
described in Section 12.2, “Managing User Accounts” (page 169). Learn about ad-
vanced options like enforcing password policies, using encrypted home directories,
using fingerprint authentication, or managing disk quotas in Section 12.3, “Addi-
tional Options for User Accounts” (page 171).

Changing Default Settings

Local users accounts are created according to the settings defined on the Defaults
for New Users tab. Learn how to change the default group assignment, or the default
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path and access permissions for home directories in Section 12.4, “Changing Default
Settings for Local Users” (page 179).

Assigning Users to Groups
Learn how to change the group assignment for individual users in Section 12.5,
“Assigning Users to Groups” (page 180).

Managing Groups
From the Groups tab, you can add, modify or delete existing groups. Refer to
Section 12.6, “Managing Groups” (page 180) for information how to do this.

Changing the User Authentication Method
When your machine is connected to a network providing user authentication
methods like NIS or LDAP, you can choose between several authentication methods
on the Authentication Settings tab. For more information, refer to Section 12.7,
“Changing the User Authentication Method” (page 182).

For user and group management, the dialog provides similar functionality. You can
easily switch between the user and group administration view by choosing the appro-
priate tab at the top of the dialog.

Filter options allow you to define the set of users or groups you want to modify: On
the Users or Group tab, click Set Filter to view and edit users or groups according to
certain categories, such as Local Users or LDAP Users, for instance (if you are part of
a network which uses LDAP). With Set Filter > Customize Filter you can also set up
and use a custom filter.

Depending on the filter you choose, not all of the following options and functions may
be available from the dialog.

12.2 Managing User Accounts

YaST offers to create, modify, delete or temporarily disable user accounts. Do not
modify user accounts unless you are an experienced user or administrator and know
about the implications.
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NOTE: Changing User IDs of Existing Users

File ownership is bound to the user ID, not to the user name. After a user ID
change, the files in the user's home directory are automatically adjusted to
reflect this change. However, after an ID change, the user does no longer own
the files he created elsewhere in the file system unless you manually change
the file ownership for those files.

In the following, learn how to set up default user accounts. For some further options,
such as auto login, login without password, setting up encrypted home directories or
managing quotas for users and groups, refer to Section 12.3.5, “Managing Quotas”
(page 176).

Procedure 12.1 Adding or Modifying User Accounts

1 Open the YaST User and Group Administration dialog and click the Users tab.

2 With Set Filter define the set of users you want to manage. The dialog shows a
list of users in the system and the groups the users belong to.

3 To modify options for an existing user, select an entry and click Edit.
To create a new user account, click Add.

4 Enter the appropriate user data on the first tab, such as Username (which is used
for login) and Password. This data is sufficient to create a new user. If you click
OK now, the system will automatically assign a user ID and set all other values
according to the default.

5 If you want to adjust further details such as the user ID or the path to the user's
home directory, do so on the Details tab.

If you need to relocate the home directory of an existing user, enter the path to
the new home directory there and move the contents of the current home directory
with Move to New Location. Otherwise, a new home directory is created without
any of the existing data.

6 To force users to regularly change their password or set other password options,
switch to Password Settings and adjust the options.

7 If all options are set according to your wishes, click OK.
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8 Click Expert Options > Write Changes Now to save all changes without exiting
the User and Group Administration dialog. Or click Finish to close the adminis-
tration dialog and to save the changes. A newly added user can now log in to the
system using the login name and password you created.

TIP: Matching User IDs

For a new (local) user on a laptop which should also integrate in a network
environment where this user already has a user ID, it is useful to match the
(local) user ID to the ID in the network. This ensures that the file ownership of
the files the user creates “offline” is the same as if he created them directly on
the network.

Procedure 12.2 Disabling or Deleting User Accounts

1 Open the YaST User and Group Administration dialog and click the Users tab.

2 To temporarily disable a user account without deleting it, select the user from
the list and click Edit. Activate Disable User Login. The user cannot log in to
your machine until you enable the account again.

3 To delete a user account, select the user from the list and click Delete. Choose

if you also want to delete the user's home directory or if you want to retain the
data.

12.3 Additional Options for User
Accounts

In addition to the settings for a default user account, SUSE® Linux Enterprise Server
offers further options, such as options to enforce password policies, to use encrypted
home directories or to define disk quotas for users and groups.
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12.3.1 Automatic Login and Passwordless
Login

If you use KDE or GNOME desktop environment you can configure Auto Login for a
certain user as well as Passwordless Login for all users. Auto login causes a user to
become automatically logged in to the desktop environment on boot. This functionality
can only be activated for one user at a time. Login without password allows all users
to log in to the system after they have entered their username in the login manager.

WARNING: Security Risk

Enabling Auto Login or Passwordless Login on a machine that can be accessed
by more than one person is a security risk. Without the need to authenticate,
any user can gain access to your system and your data. If your system contains
confidential data, do not use this functionality.

If you want to activate auto login or login without password, access these functions in
the YaST User and Group Administration with Expert Options > Login Settings.

12.3.2 Enforcing Password Policies

On any system with multiple users, it is a good idea to enforce at least basic password
security policies. Users should change their passwords regularly and use strong pass-
words that cannot easily be exploited. For local users, proceed as follows:

Procedure 12.3 Configuring Password Settings

1 Open the YaST User and Group Administration dialog and select the Users
tab.

2 Select the user for which to change the password options and click Edit.
3 Switch to the Password Settings tab.

4 To make the user change his password at next login, activate Force Password
Change.
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5 To enforce password rotation, set a Maximum Number of Days for the Same
Password and a Minimum Number of Days for the Same Password.

6 To remind the user to change his password before it expires, set a number of
Days before Password Expiration to Issue Warning.

7 To restrict the period of time the user can log in after his password has expired,
change the value in Days after Password Expires with Usable Login.

8 You can also specify a certain expiration date for a password. Enter the Expi-
ration Date in YYYY-MM-DD format.

9 For more information about the options and about the default values, click
Help.

10 Apply your changes with OK.

12.3.3 Managing Encrypted Home
Directories

To protect data in home directories against theft and hard disk removal, you can create
encrypted home directories for users. These are encrypted with LUKS (Linux Unified
Key Setup), which results in an image and an image key generated for the user. The
image key is protected with the user's login password. When the user logs in to the
system, the encrypted home directory is mounted and the contents are made available
to the user.

NOTE: Fingerprint Reader Devices and Encrypted Home Directories

If you want to use a fingerprint reader device, you must not use encrypted
home directories. Otherwise logging in will fail, because decrypting during login
is not possible in combination with an active fingerprint reader device.

With YaST, you can create encrypted home directories for new or existing users. To
encrypt or modify encrypted home directories of already existing users, you need to
know the user's current login password. By default, all existing user data is copied to
the new encrypted home directory, but it is not deleted from the unencrypted directory.
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WARNING: Security Restrictions

Encrypting a user's home directory does not provide strong security from other
users. If strong security is required, the system should not be physically shared.

Find background information about encrypted home directories and which actions to
take for stronger security in Section “Using Encrypted Home Directories” (Chapter 11,
Encrypting Partitions and Files, 1Security Guide).

Procedure 12.4 Creating Encrypted Home Directories
1 Open the YaST User and Group Management dialog and click the Users tab.
2 To encrypt the home directory of an existing user, select the user and click Edit.

Otherwise, click Add to create a new user account and enter the appropriate user
data on the first tab.

3 In the Details tab, activate Use Encrypted Home Directory. With Directory Size
in MB, specify the size of the encrypted image file to be created for this user.
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-3 Existing Local User
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4 Apply your settings with OK.
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5 Enter the user's current login password to proceed if YaST prompts for it.

6 Click Expert Options > Write Changes Now to save all changes without exiting

the administration dialog. Or click Finish to close the administration dialog and

to save the changes.

Managing Users with YaST

175



176

Procedure 12.5 Modifying or Disabling Encrypted Home Directories

Of course, you can also disable the encryption of a home directory or change the size
of the image file at any time.

1 Open the YaST User and Group Administration dialog in the Users view.
2 Select a user from the list and click Edit.

3 Ifyou want to disable the encryption, switch to the Details tab and disable Use
Encrypted Home Directory.

If you need to enlarge or reduce the size of the encrypted image file for this users,
change the Directory Size in MB.

4 Apply your settings with OK.
5 Enter the user's current login password to proceed if YaST prompts for it.

6 Click Expert Options > Write Changes Now to save all changes without exiting
the User and Group Administration dialog. Or click Finish to close the adminis-
tration dialog and to save the changes.

12.3.4 Using Fingerprint Authentication

If your system includes a fingerprint reader you can use biometric authentication in
addition to standard authentication via login and password. After registering their fin-
gerprint, users can log in to the system either by swiping a finger on the fingerprint
reader or by typing in a password.

Fingerprints can be registered with YaST. Find detailed information about configuration
and use of fingerprint authentication in Chapter 7, Using the Fingerprint Reader (1Se-
curity Guide). For a list of supported devices, refertohttp: //reactivated.net/
fprint/wiki/Supported_devices.

12.3.5 Managing Quotas

To prevent system capacities from being exhausted without notification, system admin-
istrators can set up quotas for users or groups. Quotas can be defined for one or more
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file systems and restrict the amount of disk space that can be used and the number of
inodes (index notes) that can be created there. Inodes are data structures on a file system
that store basic information about a regular file, directory, or other file system object.
They store all attributes of a file system object (like user and group ownership, read,
write, or execute permissions), except file name and contents.

SUSE Linux Enterprise Server allows usage of soft and hard quotas. Soft quotas
usually define a warning level at which users are informed they are nearing their limit,
whereas hard quotas define the limit at which write requests are denied. Additionally,
grace intervals can be defined that allow users or groups to temporarily violate their
quotas by certain amounts.

Procedure 12.6 Enabling Quota Support for a Partition

In order to configure quotas for certain users and groups, you need to enable quota
support for the respective partition in the YaST Expert Partitioner first.

1 In YaST, select System > Partitioner and click Yes to proceed.

2 Inthe Expert Partitioner, select the partition for which to enable quotas and click
Edit.

3 Click Fstab Options and activate Enable Quota Support. If the quot a package
is not already installed, it will be installed if you confirm the respective message
with Yes.

4 Confirm your changes and leave the Expert Partitioner.

Procedure 12.7 Setting Up Quotas for Users or Groups

Now you can define soft or hard quotas for specific users or groups and set time periods
as grace intervals.

1 Inthe YaST User and Group Administration, select the user or the group you
want to set the quotas for and click Edit.

2 On the Plug-Ins tab, select the quota entry and click Launch to open the Quota
Configuration dialog.

3 From File System, select the partition to which the quota should apply.

Managing Users with YaST

177



178

-3 Quota Configuration
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Below Size Limits, restrict the amount of disk space. Enter the number of 1 KB
blocks the user or group may have on this partition. Specify a Soft Limit and a
Hard Limit value.

Additionally, you can restrict the number of inodes the user or group may have
on the partition. Below Inodes Limits, enter a Soft Limit and Hard Limit.

You can only define grace intervals if the user or group has already exceeded
the soft limit specified for size or inodes. Otherwise, the time-related input fields
are not activated. Specify the time period for which the user or group is allowed
to exceed the limits set above.

Confirm your settings with OK.

Click Expert Options > Write Changes Now to save all changes without exiting
the User and Group Administration dialog. Or click Finish to close the adminis-
tration dialog and to save the changes.

SUSE Linux Enterprise Server also ships command line tools like repquota or
warnquota with which system administrators can control the disk usage or send e-
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mail notifications to users exceeding their quota. With quota_nld, administrators
can also forward kernel messages about exceeded quotas to D-BUS. For more informa-
tion, refer to the repquota, the warnquota and the quota_nld man page (root
password needed).

12.4 Changing Default Settings for
Local Users

When creating new local users, several defaults settings are used by YaST. These in-
clude, for example, the primary group and the secondary groups the user belong to, or
the access permissions of the user's home directory. You can change these default settings
to meet your requirements:

1 Open the YaST User and Group Administration dialog and select the Defaults
Jfor New Users tab.

2 To change the primary group the new users should automatically belong to, select
another group from Default Group.

3 To modify the secondary groups for new users, add or change groups in Secondary
Groups. The group names must be separated by commas.

4 If you do not want to use /home /username as default path for new users'
home directories, modify the Path Prefix for Home Directory.

5 To change the default permission modes for newly created home directories,
adjust the umask value in Umask for Home Directory. For more information
about umask, refer to Chapter 10, Access Control Lists in Linux (*Security Guide)
and to the uma sk man page.

6 For information about the individual options, click Help.

7 Apply your changes with Finish.
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12.5 Assigning Users to Groups

Local users are assigned to several groups according to the default settings which you
can access from the User and Group Administration dialog on the Defaults for New
Users tab. In the following, learn how to modify an individual user's group assignment.
If you need to change the default group assignments for new users, refer to Section 12.4,
“Changing Default Settings for Local Users” (page 179).

Procedure 12.8 Changing a User's Group Assignment

1 Open the YaST User and Group Administration dialog and click the Users tab.
It shows a list of users and of the groups the users belong to.

2 Click Edit and switch to the Details tab.

3 To change the primary group the user belongs to, click Default Group and select
the group from the list.

4 To assign the user to additional secondary groups, activate the corresponding
check boxes in the Additional Groups list.

5 Click OK to apply your changes.
6 Click Expert Options > Write Changes Now to save all changes without exiting

the User and Group Administration dialog. Or click Finish to close the adminis-
tration dialog and to save the changes.

12.6 Managing Groups

With YaST you can also easily add, modify or delete groups.
Procedure 12.9 Creating and Modifying Groups

1 Open the YaST User and Group Management dialog and click the Groups tab.

2 With Set Filter define the set of groups you want to manage. The dialog shows
a list of groups in the system.
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3 To create a new group, click Add.
4 To modify an existing group, select the group and click Edit.

5 In the following dialog, enter or change the data. The list on the right shows an
overview of all available users and system users which can be members of the
group.

-1 Existing Local Group

Enter the group data here. more

Group Data | Plug-Ins

Group Name: Group Members;
|users | 1Ot
[ avahi e
] beagleindex
Group |D (gid): [ bin
[100 | [] daemon
[ festival
[ fp -
Password:
eseoee |
Confirm Password;
(esceee J

6 To add existing users to a new group select them from the list of possible Group
Members by checking the corresponding box. To remove them from the group
just uncheck the box.

7 Click OK to apply your changes.

8 Click Expert Options > Write Changes Now to save all changes without exiting
the User and Group Administration dialog.

In order to delete a group, it must not contain any group members. To delete a group,
select it from the list and click Delete. Click Expert Options > Write Changes Now to
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save all changes without exiting the User and Group Administration dialog. Or click
Finish to close the administration dialog and to save the changes.

12.7 Changing the User
Authentication Method

When your machine is connected to a network, you can change the authentication
method you set during installation. The following options are available:

NIS
Users are administered centrally on a NIS server for all systems in the network.
For details, see Chapter 3, Using NIS (1Security Guide).

LDAP
Users are administered centrally on an LDAP server for all systems in the network.
For details about LDAP, see Chapter 4, LDAP—A Directory Service (1Security
Guide).

You can manage LDAP users with the YaST user module. All other LDAP settings,
including the default settings for LDAP users, have to be defined with the YaST
LDAP client module as described in Section “Configuring an LDAP Client with
YaST” (Chapter 4, LDAP—A Directory Service, 1Security Guide) .

Kerberos
With Kerberos, a user registers once and then is trusted in the complete network
for the rest of the session.

Samba
SMB authentication is often used in mixed Linux and Windows networks. For de-
tails, see Chapter 25, Samba (* Administration Guide).

eDirectory LDAP
eDirectory authentication is used in Novell networks.

To change the authentication method, proceed as follows:

1 Open the User and Group Administration dialog in YaST.
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2 Click the Authentication Settings tab to show an overview of the available authen-
tication methods and the current settings.

3 To change the authentication method, click Configure and select the authentication
method you want to modify. This takes you directly to the client configuration
modules in YaST. For information about the configuration of the appropriate
client, refer to the following sections:

NIS:  Section “Configuring NIS Clients” (Chapter 3, Using NIS, 1Security
Guide)

LDAP:  Section “Configuring an LDAP Client with YaST” (Chapter 4,
LDAP—A Directory Service, tSecurity Guide)

Samba:  Section “Configuring a Samba Client with YaST” (Chapter 25,
Samba, t Administration Guide)

4 After accepting the configuration, return to the User and Group Administration
overview.

5 Click Finish to close the administration dialog.
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Changing Language and
Country Settings with YaST

Working in different countries or having to work in a multilingual environment requires
your computer to be set up to support this. Use the YaST language and timezone modules
to install additional system languages and adjust the country and timezone settings ac-
cordingly. The YaST language module also lets you change your system language or
determine a primary language that you use most often. Install secondary languages to
get optional localizations if you need to start applications or desktops in languages
other than the primary one. The YaST timezone module allows you to adjust your
country and timezone settings and synchronize your system clock against a time server.

13.1 Changing the System Language

Depending on how you use your desktop and whether you want to switch the entire
system to another language or just the desktop environment itself, there are several
ways to achieve this:

Change the System Language Globally
Proceed as described in Section 13.1.1, “Installing Additional System Languages”
(page 186) and Section 13.1.2, “Switching the System Language” (page 188) to install
additional localized packages with YaST and set the default language. Changes are
effective after relogin. To ensure that the entire system reflects the change, reboot
the system or close and restart all running services, applications, and programs.

Change the Language for the Desktop Only
Provided you have previously installed the desired language packages for your
desktop environment with YaST as described below, you can switch the language
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of your desktop using the desktop's control center. After X has been restarted, your
entire desktop reflects your new choice of language. Applications not belonging
to your desktop framework are not affected by this change and may still appear in
the language that was set in YaST.

Temporarily Switch Languages for One Application Only
To run a single application in another language (that has already been installed
with YaST), use one of the following commands:

* LANG=de_DE applicationto startany standard X application or GNOME
application in German. For other languages, use the appropriate language code.
Get a list of all language codes available using the 1ocale —av command.

* KDE_LANG=de application to start any KDE application in German. For
other languages, use the appropriate language code.

13.1.1 Installing Additional System
Languages

The main language was selected during installation (see Section 6.7, “Welcome”
(page 98)) and keyboard and time zone settings were adjusted. However, you can install
additional languages on your system and determine which of the different languages
installed should be taken as the default. Before installing additional languages, determine
which of them should be activated after you install it. YaST knows two different lan-
guage categories:

Primary Language
The primary language set in YaST applies to the entire system, including YaST
and the desktop environment. This language is used whenever available unless you
manually specify another language.

Secondary Languages
Secondary languages are languages selected manually for a specific situation. For
example, use a secondary language to start an application in a certain language, for
example, to do word processing in this language.
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Figure 13.1 Setting the Language

= Languages

Choose the new Primary Language for your system. more

Primary Language Settings
Primary Language:

English (US) z Details

[ Adapt Time Zeone to [ US/Eastern

Secondary Languages:

[C] Afrikaans

[C] Arabic 3
[] Bengali

["] Bosnian

[] Bulgarian

[[] catalan

[] Croatian

'] czech

[C] Danish

1 Dutch -

@-Help @Qancel ok

To install an additional language, proceed as follows:
1 As root, start YaST.
2 Select System > Language.

3 Select the desired languages from the list of languages offered in Secondary
Languages. When you leave this dialog with Ok, YaST installs the additional
localized software packages. The system is multilingual, but you need to set the
desired language explicitly to start an application in a language other than the
primary one.

4 To make this language the default (the primary language), select it under Primary
Language:
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4a Adapt the keyboard to the new primary language and adjust the time zone,
if appropriate.

TIP

For advanced keyboard or time zone settings, open the Hardware >
Keyboard Layout (Section 8.3.1, “Keyboard Layout” (page 131)) or
System > Date and Time dialog (Section 13.2, “Changing the Country
and Time Settings” (page 189)).

4b Select Details to change language settings specific to root and to determine
the exact locale:

Locale Settings for User root
ctype only adjuststhe LC_TYPE variablein /etc/sysconfig/
language for root, which sets the localization for language-specific
function calls. yes sets the language for root to the same as the lan-
guage for local users. no means the language settings for root are not
affected by language changes. All 1ocale values remain unset.

Use UTF-8 Encoding
Disable this box, if you do not want to use UTF-8 encoding for root.

Detailed Locale Setting
If your locale was not included in the list of primary languages available,
try explicitly specifying it here. However, some of these localizations
may be incomplete.

5 Leave this dialog and apply your settings with Ok.

13.1.2 Switching the System Language

Switching the system language is similar to installing additional languages. Use the
YaST language module to change the primary language and to adjust keyboard and
time zone. Once YaST has applied your changes and any open X sessions have been
restarted, YaST, applications, and the desktop reflect your new language settings.
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13.2 Changing the Country and Time
Settings

Using the YaST date and time module, adjust your system date, clock and time zone
information to the area you are working in. First, select a general region, such as Europe,
for example. Choose an appropriate time zone that matches the one you are working
in, for example, Germany.

Depending on which operating systems run on your workstation, adjust the hardware
clock settings, accordingly:

+ Ifyou run another operating system on your machine, such as Microsoft Windows*,
it is likely your system does not use UTC, but local time. In this case, uncheck
Hardware Clock Set To UTC.

+ Ifyou only run Linux on your machine, set the hardware clock to UTC and have
the switch form standard time to daylight saving time performed automatically.

You can change the date and time manually or opt for synchronizing your machine
against an NTP server, either permanently or just for adjusting your hardware clock. If
you want to set date and time manually, proceed as follows:
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Figure 13.2 Setting Country and Time

Clock and Time Zone
To select the time zone to use in your system, first select the Region. more

Region: Time Zone:

~

Europe v ] [Germany v l

Time and Date (NTP is configured)

| Hardware Clock Set To UTC 15:34:12 - 2008-10-22
T

1 Click Change to set date and time.
2 Select Manually and enter date and time values.
3 Confirm with Accept.

If you want to make use of an NTP server:
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Figure 13.3 Setting Date and Time With NTP Server

Change Date and Time

The current system time and date are displayed. more

) Manually

Current Time:

[15):[39)

Current Date:

[2008] - [10] - [22] [~
@ Synchronize with NTP Server

NTP Server Address:

3.opensuse.pool.ntp.org | v Szmchronize now

Save NTP Configuration Configure...

@-Help @Qancel Q;j? Accept

1 Click Change to set date and time.
2 Select Synchronize with NTP Server.
3 Enter the address of an NTP server, if not prefilled.

4 Press Synchronize Now, to get your system time set correctly. If you want to
make use of NTP permanently, enable Save NTP Configuration.

5 Confirm with Accept.
With the Configure button, you can also open the advanced NTP configuration. For

details, see Section “Configuring an NTP Client with YaST” (Chapter 21, Time Syn-
chronization with NTP, t Administration Guide).
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Remote Installation

SUSE® Linux Enterprise Server can be installed in several different ways. As well as
the usual media installation covered in Chapter 6, /nstallation with YaST (page 89),
you can choose from various network-based approaches or even take a completely
hands-off approach to the installation of SUSE Linux Enterprise Server.

Each method is introduced by means of two short check lists: one listing the prerequisites
for this method and the other illustrating the basic procedure. More detail is then pro-
vided for all the techniques used in these installation scenarios.

NOTE

In the following sections, the system to hold your new SUSE Linux Enterprise
Server installation is referred to as target system or installation target. The
term installation source is used for all sources of installation data. This includes
physical media, such as CD and DVD, and network servers distributing the in-
stallation data in your network.

14.1 Installation Scenarios for Remote
Installation

This section introduces the most common installation scenarios for remote installations.
For each scenario, carefully check the list of prerequisites and follow the procedure
outlined for this scenario. If in need of detailed instructions for a particular step, follow
the links provided for each one of them.
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IMPORTANT

The configuration of the X Window System is not part of any remote installation
process. After the installation has finished, log in to the target system as root,
enter telinit 3, and start SaX2 to configure the graphics hardware.

14.1.1 Simple Remote Installation via

VNC—Static Network Configuration

This type of installation still requires some degree of physical access to the target system
to boot for installation. The installation itself is entirely controlled by a remote worksta-
tion using VNC to connect to the installation program. User interaction is required as

with the manual installation in Chapter 6, Installation with YaST (page 89).

For this type of installation, make sure that the following requirements are met:

Remote installation source: NFS, HTTP, FTP, or SMB with working network
connection.

Target system with working network connection.

Controlling system with working network connection and VNC viewer software
or Java-enabled browser (Firefox, Konqueror, Internet Explorer, or Opera).

Physical boot medium (CD or DVD) for booting the target system.

Valid static IP addresses already assigned to the installation source and the control-
ling system.

Valid static IP address to assign to the target system.

To perform this kind of installation, proceed as follows:

1 Set up the installation source as described in Section 14.2, “Setting Up the

Server Holding the Installation Sources” (page 202). Choose an NFS, HTTP, or
FTP network server. For an SMB installation source, refer to Section 14.2.5,
“Managing an SMB Installation Source” (page 210).
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2 Boot the target system using the first CD or DVD of the SUSE Linux Enterprise
Server media Kkit.

3 When the boot screen of the target system appears, use the boot options prompt
to set the appropriate VNC options and the address of the installation source.
This is described in detail in Section 14.4, “Booting the Target System for Instal-
lation” (page 222).

The target system boots to a text-based environment, giving the network address
and display number under which the graphical installation environment can be

addressed by any VINC viewer application or browser. VINC installations announce
themselves over OpenSLP and if the firewall settings permit, they can be found

using Konqueror in service:/ or slp:/ mode.

4 On the controlling workstation, open a VNC viewing application or Web
browser and connect to the target system as described in Section 14.5.1, “VNC
Installation” (page 226).

5 Perform the installation as described in Chapter 6, /nstallation with YaST
(page 89). Reconnect to the target system after it reboots for the final part of the
installation.

6 Finish the installation.

14.1.2 Simple Remote Installation via
VNC—Dynamic Network
Configuration

This type of installation still requires some degree of physical access to the target system
to boot for installation. The network configuration is made with DHCP. The installation
itself is entirely controlled from a remote workstation using VNC to connect to the in-
staller, but still requires user interaction for the actual configuration efforts.

For this type of installation, make sure that the following requirements are met:

+ Remote installation source: NFS, HTTP, FTP, or SMB with working network
connection.
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+ Target system with working network connection.

+ Controlling system with working network connection and VNC viewer software
or Java-enabled browser (Firefox, Konqueror, Internet Explorer, or Opera).

+ Physical boot medium (CD, DVD, or custom boot disk) for booting the target sys-
tem.

* Running DHCP server providing IP addresses.
To perform this kind of installation, proceed as follows:

1 Set up the installation source as described in Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 202). Choose an NFES, HTTP, or
FTP network server. For an SMB installation source, refer to Section 14.2.5,
“Managing an SMB Installation Source” (page 210).

2 Boot the target system using the first CD or DVD of the SUSE Linux Enterprise
Server media Kkit.

3 When the boot screen of the target system appears, use the boot options prompt
to set the appropriate VNC options and the address of the installation source.
This is described in detail in Section 14.4, “Booting the Target System for Instal-
lation” (page 222).

The target system boots to a text-based environment, giving the network address
and display number under which the graphical installation environment can be

addressed by any VINC viewer application or browser. VINC installations announce
themselves over OpenSLP and if the firewall settings permit, they can be found

using Konqueror in service:/ or slp:/ mode.

4 On the controlling workstation, open a VNC viewing application or Web
browser and connect to the target system as described in Section 14.5.1, “VNC
Installation” (page 226).

5 Perform the installation as described in Chapter 6, /nstallation with YaST
(page 89). Reconnect to the target system after it reboots for the final part of the
installation.

6 Finish the installation.
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14.1.3 Remote Installation via VNC—PXE
Boot and Wake on LAN

This type of installation is completely hands-off. The target machine is started and
booted remotely. User interaction is only needed for the actual installation. This approach
is suitable for cross-site deployments.

To perform this type of installation, make sure that the following requirements are met:

+ Remote installation source: NFS, HTTP, FTP, or SMB with working network
connection.

» TFTP server.
* Running DHCP server for your network.

+ Target system capable of PXE boot, networking, and Wake on LAN, plugged in
and connected to the network.

+ Controlling system with working network connection and VNC viewer software
or Java-enabled browser (Firefox, Konqueror, Internet Explorer, or Opera).

To perform this type of installation, proceed as follows:

1 Set up the installation source as described in Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 202). Choose an NFS, HTTP, or
FTP network server or configure an SMB installation source as described in
Section 14.2.5, “Managing an SMB Installation Source” (page 210).

2 Setup a TFTP server to hold a boot image that can be pulled by the target system.
This is described in Section 14.3.2, “Setting Up a TETP Server” (page 215).

3 Set up a DHCP server to provide IP addresses to all machines and reveal the lo-
cation of the TFTP server to the target system. This is described in Section 14.3.1,
“Setting Up a DHCP Server” (page 212).

4 Prepare the target system for PXE boot. This is described in further detail in
Section 14.3.5, “Preparing the Target System for PXE Boot” (page 221).
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5 Initiate the boot process of the target system using Wake on LAN. This is de-

scribed in Section 14.3.7, “Wake on LAN” (page 222).

6 On the controlling workstation, open a VNC viewing application or Web

browser and connect to the target system as described in Section 14.5.1, “VNC
Installation” (page 226).

7 Perform the installation as described in Chapter 6, /nstallation with YaST

(page 89). Reconnect to the target system after it reboots for the final part of the
installation.

8 Finish the installation.

14.1.4 Simple Remote Installation via

SSH—Static Network Configuration

This type of installation still requires some degree of physical access to the target system
to boot for installation and to determine the IP address of the installation target. The
installation itself is entirely controlled from a remote workstation using SSH to connect
to the installer. User interaction is required as with the regular installation described in
Chapter 6, Installation with YaST (page 89).

For this type of installation, make sure that the following requirements are met:

Remote installation source: NFS, HTTP, FTP, or SMB with working network
connection.

Target system with working network connection.

Controlling system with working network connection and working SSH client
software.

Physical boot medium (CD, DVD, or custom boot disk) for the target system.

Valid static IP addresses already assigned to the installation source and the control-
ling system.

Valid static IP address to assign to the target system.
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To perform this kind of installation, proceed as follows:

1 Set up the installation source as described in Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 202). Choose an NFES, HTTP, or
FTP network server. For an SMB installation source, refer to Section 14.2.5,
“Managing an SMB Installation Source” (page 210).

2 Boot the target system using the first CD or DVD of the SUSE Linux Enterprise
Server media Kkit.

3 When the boot screen of the target system appears, use the boot options prompt
to set the appropriate parameters for network connection, address of the installa-
tion source, and SSH enablement. This is described in detail in Section 14.4.2,
“Using Custom Boot Options” (page 223).

The target system boots to a text-based environment, giving the network address
under which the graphical installation environment can be addressed by any SSH
client.

4 On the controlling workstation, open a terminal window and connect to the target
system as described in Section “Connecting to the Installation Program”
(page 228).

5 Perform the installation as described in Chapter 6, Installation with YaST
(page 89). Reconnect to the target system after it reboots for the final part of the
installation.

6 Finish the installation.

14.1.5 Simple Remote Installation via
SSH—Dynamic Network
Configuration

This type of installation still requires some degree of physical access to the target system
to boot for installation and determine the IP address of the installation target. The instal-
lation itself is entirely controlled from a remote workstation using VNC to connect to
the installer, but still requires user interaction for the actual configuration efforts.
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For this type of installation, make sure that the following requirements are met:

+ Remote installation source: NFS, HTTP, FTP, or SMB with working network
connection.

+ Target system with working network connection.

+ Controlling system with working network connection and working SSH client
software.

+ Physical boot medium (CD or DVD) for booting the target system.
* Running DHCP server providing IP addresses.
To perform this kind of installation, proceed as follows:

1 Set up the installation source as described in Section 14.2, “Setting Up the

Server Holding the Installation Sources” (page 202). Choose an NFS, HTTP, or

FTP network server. For an SMB installation source, refer to Section 14.2.5,
“Managing an SMB Installation Source” (page 210).

2 Boot the target system using the first CD or DVD of the SUSE Linux Enterprise

Server media kit.

3 When the boot screen of the target system appears, use the boot options prompt
to pass the appropriate parameters for network connection, location of the instal-

lation source, and SSH enablement. See Section 14.4.2, “Using Custom Boot
Options” (page 223) for detailed instructions on the use of these parameters.

The target system boots to a text-based environment, giving you the network

address under which the graphical installation environment can be addressed by

any SSH client.

4 On the controlling workstation, open a terminal window and connect to the target

system as described in Section “Connecting to the Installation Program”
(page 228).

5 Perform the installation as described in Chapter 6, /nstallation with YaST

(page 89). Reconnect to the target system after it reboots for the final part of the

installation.

6 Finish the installation.
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14.1.6 Remote Installation via SSH—PXE
Boot and Wake on LAN

This type of installation is completely hands-off. The target machine is started and
booted remotely.

To perform this type of installation, make sure that the following requirements are met:

+ Remote installation source: NFS, HTTP, FTP, or SMB with working network
connection.

» TFTP server.
+ Running DHCP server for your network, providing a static IP to the host to install.

+ Target system capable of PXE boot, networking, and Wake on LAN, plugged in
and connected to the network.

+ Controlling system with working network connection and SSH client software.
To perform this type of installation, proceed as follows:

1 Set up the installation source as described in Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 202). Choose an NES, HTTP, or
FTP network server. For the configuration of an SMB installation source, refer
to Section 14.2.5, “Managing an SMB Installation Source” (page 210).

2 Setup a TFTP server to hold a boot image that can be pulled by the target system.
This is described in Section 14.3.2, “Setting Up a TETP Server” (page 215).

3 Set up a DHCP server to provide IP addresses to all machines and reveal the lo-
cation of the TFTP server to the target system. This is described in Section 14.3.1,
“Setting Up a DHCP Server” (page 212).

4 Prepare the target system for PXE boot. This is described in further detail in
Section 14.3.5, “Preparing the Target System for PXE Boot” (page 221).

5 Initiate the boot process of the target system using Wake on LAN. This is de-
scribed in Section 14.3.7, “Wake on LAN” (page 222).
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6 On the controlling workstation, start an SSH client and connect to the target
system as described in Section 14.5.2, “SSH Installation” (page 228).

7 Perform the installation as described in Chapter 6, /nstallation with YaST
(page 89). Reconnect to the target system after it reboots for the final part of the
installation.

8 Finish the installation.

14.2 Setting Up the Server Holding
the Installation Sources

Depending on the operating system running on the machine to use as network installation
source for SUSE Linux Enterprise Server, there are several options for the server con-
figuration. The easiest way to set up an installation server is to use YaST on SUSE
Linux Enterprise Server 11 or SUSE Linux 9.3 and higher.

TIP

You can even use a Microsoft Windows machine as installation server for your
Linux deployment. See Section 14.2.5, “Managing an SMB Installation Source”
(page 210) for details.

14.2.1 Setting Up an Installation Server
Using YaST

YaST offers a graphical tool for creating network installation sources. It supports HTTP,
FTP, and NFS network installation servers.

1 Log in as root to the machine that should act as installation server.
2 Start YaST > Miscellaneous > Installation Server.

3 Select the server type (HTTP, FTP, or NES). The selected server service is
started automatically every time the system starts. If a service of the selected
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type is already running on your system and you want to configure it manually
for the server, deactivate the automatic configuration of the server service with
Do Not Configure Any Network Services. In both cases, define the directory in
which the installation data should be made available on the server.

Configure the required server type. This step relates to the automatic configuration
of server services. It is skipped when automatic configuration is deactivated.

Define an alias for the root directory of the FTP or HTTP server on which the
installation data should be found. The installation source will later be located
under ftp://Server—-IP/Alias/Name (FTP) or under
http://Server-IP/Alias/Name (HTTP). Name stands for the name of
the installation source, which is defined in the following step. If you selected
NES in the previous step, define wild cards and export options. The NFS server
will be accessible under nfs : // Server—IP/Name. Details of NFS and exports
can be found in Chapter 26, Sharing File Systems with NFS (t Administration
Guide).

TIP: Firewall Settings

Make sure that the firewall settings of your server system allow traffic
on the ports for HTTP, NFS, and FTP. If they currently do not, start the
YaST firewall module and open the respective ports.

Configure the installation source. Before the installation media are copied to their
destination, define the name of the installation source (ideally, an easily remem-
bered abbreviation of the product and version). YaST allows providing ISO im-
ages of the media instead of copies of the installation CDs. If you want this, acti-
vate the relevant check box and specify the directory path under which the ISO
files can be found locally. Depending on the product to distribute using this in-
stallation server, it might be that more add-on CDs or service pack CDs are re-
quired and should be added as extra installation sources. To announce your in-
stallation server in the network via OpenSLP, activate the appropriate option.
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TIP

Consider announcing your installation source via OpenSLP if your network
setup supports this option. This saves you from entering the network in-
stallation path on every target machine. The target systems are just
booted using the SLP boot option and find the network installation source
without any further configuration. For details on this option, refer to
Section 14.4, “Booting the Target System for Installation” (page 222).

6 Upload the installation data. The most lengthy step in configuring an installation
server is copying the actual installation CDs. Insert the media in the sequence
requested by YaST and wait for the copying procedure to end. When the sources
have been fully copied, return to the overview of existing information sources
and close the configuration by selecting Finish.

Your installation server is now fully configured and ready for service. It is auto-
matically started every time the system is started. No further intervention is re-
quired. You only need to configure and start this service correctly by hand if you
have deactivated the automatic configuration of the selected network service
with YaST as an initial step.

To deactivate an installation source, select the installation source to remove then select
Delete. The installation data are removed from the system. To deactivate the network
service, use the respective YaST module.

If your installation server should provide the installation data for more than one product
of product version, start the YaST installation server module and select Add in the
overview of existing installation sources to configure the new installation source.

14.2.2 Setting Up an NFS Installation Source
Manually

Setting up an NFS source for installation is basically done in two steps. In the first step,
create the directory structure holding the installation data and copy the installation
media over to this structure. Second, export the directory holding the installation data
to the network.
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To create a directory holding the installation data, proceed as follows:
1 Loginas root.

2 Create a directory that should later hold all installation data and change into this
directory. For example:

mkdir install/product/productversion

cd install/product/productversion

Replace product with an abbreviation of the product name and
productversion with a string that contains the product name and version.

3 For each CD contained in the media kit execute the following commands:

3a Copy the entire content of the installation CD into the installation server di-
rectory:

cp —-a /media/path_to_your. CD-ROM_drive .

Replace path_to_your. CD-ROM_drive with the actual path under
which your CD or DVD drive is addressed. Depending on the type of drive
used in your system, this can be cdrom, cdrecorder, dvd, or
dvdrecorder.

3b Rename the directory to the CD number:

mv path to_your. CD-ROM _drive CDx

Replace x with the actual number of your CD.

On SUSE Linux Enterprise Server, you can export the installation sources with NFS
using YaST. Proceed as follows:

1 Loginas root.
2 Start YaST > Network Services > NF'S Server.
3 Select Start and Open Port in Firewall and click Next.

4 Select Add Directory and browse for the directory containing the installation
sources, in this case, productversion.
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5 Select Add Host and enter the hostnames of the machines to which to export the
installation data. Instead of specifying hostnames here, you could also use wild
cards, ranges of network addresses, or just the domain name of your network.
Enter the appropriate export options or leave the default, which works fine in
most setups. For more information about the syntax used in exporting NFS shares,

read the exports man page.

6 Click Finish. The NFS server holding the SUSE Linux Enterprise Server instal-
lation sources is automatically started and integrated into the boot process.

If you prefer manually exporting the installation sources via NFS instead of using the
YaST NFS Server module, proceed as follows:

1 Loginas root.

2 Open the file /et c/exports and enter the following line:
/productversion *(ro,root_squash, sync)

This exports the directory /productversion to any host that is part of this
network or to any host that can connect to this server. To limit the access to this

server, use netmasks or domain names instead of the general wild card *. Refer
to the export man page for details. Save and exit this configuration file.

3 To add the NFS service to the list of servers started during system boot, execute
the following commands:

insserv /etc/init.d/nfsserver
insserv /etc/init.d/portmap

4 Start the NFS server with rcnfsserver start. If you need to change the
configuration of your NFS server later, modify the configuration file and restart
the NFS daemon with rcnfsserver restart.

Announcing the NFS server via OpenSLP makes its address known to all clients in
your network.

1 Loginas root.

2 Enter the directory /etc/slp.reg.d/.
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3 Create a configuration file called install.suse.nfs.reg containing the
following lines:

# Register the NFS Installation Server
service:install.suse:nfs://S$SHOSTNAME/path to_instsource/CDl,en, 65535
description=NFS Installation Source

Replace path_to_instsource with the actual path to the installation source
ON your server.

4 Save this configuration file and start the OpenSLP daemon withrcslpd start.

For more information about OpenSLP, refer to the package documentation located under
/usr/share/doc/packages/openslp/ or refer to Chapter 20, SLP Services
in the Network (* Administration Guide). More Information about NFS is found in
Chapter 26, Sharing File Systems with NFS (t Administration Guide).

14.2.3 Setting Up an FTP Installation Source
Manually

Creating an FTP installation source is very similar to creating an NFES installation source.
FTP installation sources can be announced over the network using OpenSLP as well.

1 Create a directory holding the installation sources as described in Section 14.2.2,
“Setting Up an NFS Installation Source Manually” (page 204).

2 Configure the FTP server to distribute the contents of your installation directory:

2a Login as root and install the package vsftpd using the YaST package
manager.

2b Enter the FTP server root directory:

cd /srv/ftp

2c¢ Create a subdirectory holding the installation sources in the FTP root direc-
tory:

mkdir instsource
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Replace instsource with the product name.

2d Mount the contents of the installation repository into the change root envi-
ronment of the FTP server:
mount --bind path_to_instsource /srv/ftp/instsource

Replace path_to_instsourceand instsource with values matching
your setup. If you need to make this permanent, add it to /etc/fstab.

2e Start vsftpd with vsftpd.

3 Announce the installation source via OpenSLP, if this is supported by your net-
work setup:

3a Create a configuration file called install.suse.ftp.regunder /etc/
slp.reg.d/ that contains the following lines:

# Register the FTP Installation Server
service:install.suse:ftp://$SHOSTNAME/srv/ftp/instsource/CD1l,en, 65535
description=FTP Installation Source

Replace instsource with the actual name to the installation source direc-
tory on your server. The service: line should be entered as one continuous
line.

3b Save this configuration file and start the OpenSLP daemon with rcs1pd
start.

TIP: Configuring an FTP Server with YaST

If you prefer using YaST over manually configuring the FTP installation server,
refer to Chapter 29, Setting up a FTP server with YaST (1 Administration Guide)
for more information on how to use the YaST FTP server module.
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14.2.4 Setting Up an HTTP Installation
Source Manually

Creating an HTTP installation source is very similar to creating an NFS installation
source. HTTP installation sources can be announced over the network using OpenSLP
as well.

1 Create a directory holding the installation sources as described in Section 14.2.2,
“Setting Up an NFS Installation Source Manually” (page 204).

2 Configure the HTTP server to distribute the contents of your installation directory:

2a Install the Web server Apache as described in Section “Installation” (Chap-
ter 28, The Apache HTTP Server, T Administration Guide).

2b Enter the root directory of the HTTP server (/srv/www/htdocs) and
create a subdirectory that will hold the installation sources:

mkdir instsource

Replace instsource with the product name.

2c Create a symbolic link from the location of the installation sources to the
root directory of the Web server (/srv/www/htdocs):

ln -s /path_instsource /srv/www/htdocs/instsource

2d Modify the configuration file of the HTTP server (/etc/apache2/
default-server.conf)to make it follow symbolic links. Replace the
following line:

Options None

with

Options Indexes FollowSymLinks

2e Reload the HTTP server configuration using rcapache?2 reload.
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3 Announce the installation source via OpenSLP, if this is supported by your net-
work setup:

3a Create a configuration file called install.suse.http.reg under
/etc/slp.reg.d/ that contains the following lines:

# Register the HTTP Installation Server
service:install.suse:http://$HOSTNAME/srv/www/htdocs/instsource/CD1l/,en, 65535
description=HTTP Installation Source

Replace instsource with the actual path to the installation source on
your server. The service: line should be entered as one continuous line.

3b Save this configuration file and start the OpenSLP daemon using rcslpd
restart.

14.2.5 Managing an SMB Installation Source

Using SMB, you can import the installation sources from a Microsoft Windows server
and start your Linux deployment even with no Linux machine around.

To set up an exported Windows Share holding your SUSE Linux Enterprise Server
installation sources, proceed as follows:

1 Log in to your Windows machine.

2 Start Explorer and create a new folder that will hold the entire installation tree
and name it INSTALL, for example.

3 Export this share according the procedure outlined in your Windows documenta-
tion.

4 Enter this share and create a subfolder, called product. Replace product
with the actual product name.

5 Enter the INSTALL/product folder and copy each CD or DVD to a separate
folder, such as CD1 and CD2.
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To use a SMB mounted share as installation source, proceed as follows:

1 Boot the installation target.
2 Select Installation.
3 Press F4 for a selection of installation sources.

4 Choose SMB and enter the Windows machine's name or IP address, the share
name (INSTALL/product/CD1, in this example), username, and password.

After you hit Enter, YaST starts and you can perform the installation.

14.2.6 Using ISO Images of the Installation
Media on the Server

Instead of copying physical media into your server directory manually, you can also
mount the ISO images of the installation media into your installation server and use
them as installation source. To set up an HTTP, NES or FTP server that uses ISO images
instead of media copies, proceed as follows:

1 Download the ISO images and save them to the machine to use as the installation
server.

2 Loginas root.

3 Choose and create an appropriate location for the installation data, as described
in Section 14.2.2, “Setting Up an NFS Installation Source Manually” (page 204),
Section 14.2.3, “Setting Up an FTP Installation Source Manually” (page 207), or
Section 14.2.4, “Setting Up an HTTP Installation Source Manually” (page 209).

4 Create subdirectories for each CD or DVD.

5 To mount and unpack each ISO image to the final location, issue the following
command:

mount —-o loop path _to_iso path_to_instsource/product/mediumx
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Replace path_to_iso with the path to your local copy of the ISO image,
path_to_instsource with the source directory of your server, product
with the product name, and medi umx with the type (CD or DVD) and number
of media you are using.

6 Repeat the previous step to mount all ISO images needed for your product.

7 Start your installation server as usual, as described in Section 14.2.2, “Setting
Up an NFS Installation Source Manually” (page 204), Section 14.2.3, “Setting
Up an FTP Installation Source Manually” (page 207), or Section 14.2.4, “Setting
Up an HTTP Installation Source Manually” (page 209).

To automatically mount the ISO images at boot time, add the respective mount entries
to /etc/fstab. An entry according to the previous example would look like the
following:

path_to_iso path_to_instsource/product
medium auto loop

14.3 Preparing the Boot of the Target
System

This section covers the configuration tasks needed in complex boot scenarios. It contains
ready-to-apply configuration examples for DHCP, PXE boot, TETP, and Wake on
LAN.

14.3.1 Setting Up a DHCP Server

There are two ways to set up a DHCP server. For SUSE Linux Enterprise Server, YaST
provides a graphical interface to the process. Users can also manually edit the configu-
ration files. For more information about DHCP servers, see also Chapter 23, DHCP
(* Administration Guide).
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Setting Up a DHCP Server with YaST

To announce the TFTP server's location to the network clients and specify the boot
image file the installation target should use, add two declarations to your DHCP server
configuration.

1

2

9

Log in as root to the machine hosting the DHCP server.
Start YaST > Network Services > DHCP Server.
Complete the setup wizard for basic DHCP server setup.

Select Expert Settings and select Yes when warned about leaving the start-up di-
alog.

In the Configured Declarations dialog, select the subnet in which the new system
should be located and click Edit.

In the Subnet Configuration dialog select Add to add a new option to the subnet's
configuration.

Select filename and enter pxelinux. 0 as the value.

Add another option (next-server) and set its value to the address of the TFTP
server.

Select OK and Finish to complete the DHCP server configuration.

To configure DHCP to provide a static IP address to a specific host, enter the Expert
Settings of the DHCP server configuration module (Step 4 (page 213)) and add a new
declaration of the host type. Add the options hardware and fixed-address to
this host declaration and provide the appropriate values.

Setting Up a DHCP Server Manually

All the DHCP server needs to do, apart from providing automatic address allocation to
your network clients, is to announce the IP address of the TFTP server and the file that
should be pulled in by the installation routines on the target machine.
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1 Log in as root to the machine hosting the DHCP server.

2 Append the following lines to a subnet configuration of your DHCP server's
configuration file located under /etc/dhcpd. conf:

subnet 192.168.1.0 netmask 255.255.255.0 {
range dynamic-bootp 192.168.1.200 192.168.1.228;
# PXE related stuff
#

# "next-server" defines the tftp server that will be used
next-server ip tftp server:

#

# "filename" specifies the pxelinux image on the tftp server
# the server runs in chroot under /srv/tftpboot

filename "pxelinux.O0";

}

Replace ip_of_ the_tftp_server with the actual IP address of the TETP
server. For more information about the options available in dhcpd . conf, refer
to the dhcpd . conf manual page.

3 Restart the DHCP server by executing rcdhcpd restart.

If you plan on using SSH for the remote control of a PXE and Wake on LAN installation,
explicitly specify the IP address DHCP should provide to the installation target. To
achieve this, modify the above-mentioned DHCP configuration according to the follow-
ing example:

group {
# PXE related stuff

#
# "next-server" defines the tftp server that will be used

next-server ip tftp server:
#
# "filename" specifies the pxelinux image on the tftp server
# the server runs in chroot under /srv/tftpboot
filename "pxelinux.0";
host test {
hardware ethernet mac_address;
fixed-address some_ip address;
}
}

The host statement introduces the hostname of the installation target. To bind the
hostname and IP address to a specific host, you must know and specify the system's
hardware (MAC) address. Replace all the variables used in this example with the actual
values that match your environment.
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After restarting the DHCP server, it provides a static IP to the host specified, enabling
you to connect to the system via SSH.

14.3.2 Setting Up a TFTP Server

Set up a TFTP server with YaST on SUSE Linux Enterprise Server and SUSE Linux
Enterprise Server or set it up manually on any other Linux operating system that supports
xinetd and tftp. The TFTP server delivers the boot image to the target system once it
boots and sends a request for it.

Setting Up a TFTP Server Using YaST

1 Loginas root.
2 Start YaST > Network Services > TFTP Server and install the requested package.

3 Click Enable to make sure that the server is started and included in the boot
routines. No further action from your side is required to secure this. xinetd starts
tftpd at boot time.

4 Click Open Port in Firewall to open the appropriate port in the firewall running
on your machine. If there is no firewall running on your server, this option is not
available.

5 Click Browse to browse for the boot image directory. The default directory
/tftpboot is created and selected automatically.

6 Click Finish to apply your settings and start the server.

Setting Up a TFTP Server Manually
1 Log in as root and install the packages t ftp and xinetd.

2 Ifunavailable, create /srv/tftpboot and /srv/tftpboot/pxelinux
. cfg directories.

3 Add the appropriate files needed for the boot image as described in Section 14.3.3,
“Using PXE Boot” (page 216).
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4 Modify the configuration of xinetd located under /etc/xinetd.d/ to make

sure that the TFTP server is started on boot:

4a Ifit does not exist, create a file called t f t p under this directory with t ouch
tftp. Then run chmod 755 tftp.

4b Open the file t ftp and add the following lines:

service tftp

{

socket_type dgram
protocol udp
wait yes
user root

server /usr/sbin/in.tftpd
-s /srv/tftpboot

no

server_args
disable

4c Save the file and restart xinetd with rcxinetd restart.

14.3.3 Using PXE Boot

Some technical background information as well as PXE's complete specifications are
available in the Preboot Execution Environment (PXE) Specification (http: //www
.pix.net/software/pxeboot/archive/pxespec.pdf).

1 Change to the directory boot /<architecture>/loader of your installation

repository and copy the 1 inux, initrd, message,biostest,andmemtest
files to the /srv/tftpboot directory by entering the following:

cp -a linux initrd message biostest memtest /srv/tftpboot

Install the sys1inux package directly from your installation CDs or DVDs
with YaST.

Copy the /usr/share/syslinux/pxelinux. 0 file to the /srv/
tftpboot directory by entering the following:

cp —a /usr/share/syslinux/pxelinux.0 /srv/tftpboot
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4 Change to the directory of your installation repository and copy the i solinux
.cfgfileto /srv/tftpboot/pxelinux.cfg/default by entering the
following:

cp —a boot/<architecture>/loader/isolinux.cfg
/srv/tftpboot/pxelinux.cfg/default

5 Editthe /srv/tftpboot/pxelinux.cfg/default file and remove the
lines beginning with gfxboot, readinfo, and framebuffer.

6 Insert the following entries in the append lines of the default failsafe and
apic labels:

insmod=kernel module
By means of this entry, enter the network kernel module needed to support
network installation on the PXE client. Replace kernel module with the
appropriate module name for your network device.

netdevice=interface
This entry defines the client's network interface that must be used for the
network installation. It is only necessary if the client is equipped with several
network cards and must be adapted accordingly. In case of a single network
card, this entry can be omitted.

install=nfs://ip instserver/path_instsource/CD1l
This entry defines the NFS server and the installation source for the client
installation. Replace ip_instserver with the actual IP address of your
installation server. path_instsource should be replaced with the actual
path to the installation sources. HTTP, FTP, or SMB sources are addressed
in a similar manner, except for the protocol prefix, which should read ht tp,
ftp, or smb.

IMPORTANT

If you need to pass other boot options to the installation routines,
such as SSH or VNC boot parameters, append them to the install
entry. An overview of parameters and some examples are given in
Section 14.4, “Booting the Target System for Installation” (page 222).
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TIP: Changing Kernel and Initrd Filenames

It is possible to use different filenames for kernel and initrd images. This
is useful if you want to provide different operating systems from the
same boot server. However, you should be aware, that only one dot is
permitted in the filenames that are provided by tftp for the pxe boot.

An example /srv/tftpboot/pxelinux.cfg/default file follows.
Adjust the protocol prefix for the installation source to match your network setup
and specify your preferred method of connecting to the installer by adding the
vnc and vncpassword or the usessh and sshpassword options to the
install entry. The lines separated by \ must be entered as one continuous
line without a line break and without the \.

default harddisk

# default
label linux
kernel linux
append initrd=initrd ramdisk_size=65536 \
install=nfs://ip_instserver/path_instsource/product/DVD1l

# repair
label repair
kernel linux
append initrd=initrd splash=silent repair=1 showopts

# rescue
label rescue
kernel linux
append initrd=initrd ramdisk_size=65536 rescue=1

# bios test
label firmware

kernel linux

append initrd=biostest,initrd splash=silent
install=exec:/bin/run_biostest showopts

# memory test
label memtest
kernel memtest

# hard disk
label harddisk
localboot 0

implicit 0
display message
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prompt 1
timeout 100

Replace ip_instserverand path_instsource with the values used in
your setup.

The following section serves as a short reference to the PXELINUX options used
in this setup. Find more information about the options available in the documen-
tation of the sys1inux package located under /usr/share/doc/
packages/syslinux/.

14.3.4 PXELINUX Configuration Options

The options listed here are a subset of all the options available for the PXELINUX
configuration file.

DEFAULT kernel options...
Sets the default kernel command line. If PXELINUX boots automatically, it acts
as if the entries after DEFAULT had been typed in at the boot prompt, except the
auto option is automatically added, indicating an automatic boot.

If no configuration file is present or no DEFAULT entry is present in the configu-
ration file, the default is the kernel name “linux” with no options.

APPEND options...
Add one or more options to the kernel command line. These are added for both
automatic and manual boots. The options are added at the very beginning of the
kernel command line, usually permitting explicitly entered kernel options to override
them.

LABEL label KERNEL image APPEND options...
Indicates that if 1 abel is entered as the kernel to boot, PXELINUX should instead
boot image and the specified APPEND options should be used instead of the ones
specified in the global section of the file (before the first LABEL command). The
default for image is the same as 1abel and, if no APPEND is given, the default
is to use the global entry (if any). Up to 128 LABEL entries are permitted.

Note that GRUB uses the following syntax:
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title mytitle
kernel my_kernel my_kernel_ options
initrd myinitrd

PXELINUX uses the following syntax:

label mylabel
kernel mykernel
append myoptions

Labels are mangled as if they were filenames and they must be unique after man-
gling. For example, the two labels “v2.1.30” and “v2.1.31” would not be distin-
guishable under PXELINUX because both mangle to the same DOS filename.

The kernel does not have to be a Linux kernel; it can be a boot sector or a COM-
BOOT file.

APPEND -
Append nothing. APPEND with a single hyphen as argument in a LABEL section
can be used to override a global APPEND.

LOCALBOOT type
On PXELINUX, specifying LOCALBOOT 0 instead of a KERNEL option means
invoking this particular label and causes a local disk boot instead of a kernel boot.

Argument Description
0 Perform a normal boot
4 Perform a local boot with the Universal Network Driver In-

terface (UNDI) driver still resident in memory

5 Perform a local boot with the entire PXE stack, including
the UNDI driver, still resident in memory

All other values are undefined. If you do not know what the UNDI or PXE stacks
are, specify 0.

TIMEOUT time-out

Indicates how long to wait at the boot prompt until booting automatically, in units
of 1/10 second. The time-out is canceled as soon as the user types anything on the
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keyboard, assuming the user will complete the command begun. A time-out of zero
disables the time-out completely (this is also the default). The maximum possible
time-out value is 35996 (just less than one hour).

PROMPT flag _val
If flag_val is 0, displays the boot prompt only if Shift or Alt is pressed or Caps
Lock or Scroll Lock is set (this is the default). If f1ag_val is 1, always displays
the boot prompt.
F2 filename
F1 filename
..etc...

F9 filename
F10 filename

Displays the indicated file on the screen when a function key is pressed at the boot
prompt. This can be used to implement preboot online help (presumably for the
kernel command line options). For backward compatibility with earlier releases,
F10 can be also entered as FO. Note that there is currently no way to bind filenames
to F11 and F12.

14.3.5 Preparing the Target System for PXE
Boot

Prepare the system's BIOS for PXE boot by including the PXE option in the BIOS boot
order.

WARNING: BIOS Boot Order

Do not place the PXE option ahead of the hard disk boot option in the BIOS.
Otherwise this system would try to reinstall itself every time you boot it.

14.3.6 Preparing the Target System for
Wake on LAN

Wake on LAN (WOL) requires the appropriate BIOS option to be enabled prior to the
installation. Also, note down the MAC address of the target system. This data is needed
to initiate Wake on LAN.
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14.3.7 Wake on LAN

Wake on LAN allows a machine to be turned on by a special network packet containing
the machine's MAC address. Because every machine in the world has a unique MAC
identifier, you do not need to worry about accidentally turning on the wrong machine.

IMPORTANT: Wake on LAN across Different Network Segments

If the controlling machine is not located in the same network segment as the
installation target that should be awakened, either configure the WOL requests
to be sent as multicasts or remotely control a machine on that network segment
to act as the sender of these requests.

Users of SUSE Linux Enterprise Server can use a YaST module called WOL to easily
configure Wake on LAN. Users of other versions of SUSE Linux-based operating sys-
tems can use a command line tool.

14.3.8 Wake on LAN with YaST

1 Loginas root.
2 Start YaST > Network Services > WOL.
3 Click Add and enter the hostname and MAC address of the target system.

4 To turn on this machine, select the appropriate entry and click Wake up.

14.4 Booting the Target System for
Installation

Basically, there are two different ways to customize the boot process for installation
apart from those mentioned under Section 14.3.7, “Wake on LAN” (page 222) and
Section 14.3.3, “Using PXE Boot” (page 216). You can either use the default boot options
and function keys or use the boot options prompt of the installation boot screen to pass
any boot options that the installation kernel might need on this particular hardware.
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14.4.1 Using the Default Boot Options

The boot options are described in detail in Chapter 6, Installation with YaST (page 89).
Generally, just selecting Installation starts the installation boot process.

If problems occur, use Installation—ACPI Disabled or Installation—Safe Settings. For
more information about troubleshooting the installation process, refer to Section “In-
stallation Problems” (Chapter 7, Common Problems and Their Solutions, 1 System
Analysis and Tuning Guide).

The menu bar at the bottom screen offers some advanced functionality needed in some
setups. Using the F keys, you can specify additional options to pass to the installation
routines without having to know the detailed syntax of these parameters (see Sec-
tion 14.4.2, “Using Custom Boot Options” (page 223)). A detailed description of the
available function keys is available at Section 6.6, “The Boot Screen” (page 93).

14.4.2 Using Custom Boot Options

Using the appropriate set of boot options helps facilitate your installation procedure.
Many parameters can also be configured later using the linuxrc routines, but using the
boot options is easier. In some automated setups, the boot options can be provided with
initrdoraninfo file.

The following table lists all installation scenarios mentioned in this chapter with the
required parameters for booting and the corresponding boot options. Just append all of
them in the order they appear in this table to get one boot option string that is handed
to the installation routines. For example (all in one line):

install=... netdevice=... hostip=...netmask=... vnc=... vncpassword=...

Replace all the values . . . in this string with the values appropriate for your setup.
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Table 14.1 Installation (Boot) Scenarios Used in This Chapter

Installation Scenario

Parameters Needed for Boot Options

Booting

Chapter 6, Installation
with YaST (page 89)

Section 14.1.1, “Simple
Remote Installation via
VNC—Static Network
Configuration”

(page 194)

Section 14.1.2, “Simple
Remote Installation via
VNC—Dynamic Net-
work Configuration”
(page 195)

Section 14.1.3, “Remote
Installation via
VNC—PXE Boot and
Wake on LAN”

(page 197)

Deployment Guide

None: system boots auto-

matically

» Location of the in-
stallation server

* Network device

+ IP address

« Netmask

+ Gateway

* VNC enablement

* VNC password

* Location of the in-
stallation server

* VNC enablement

* VNC password

» Location of the in-
stallation server

» Location of the

TFTP server

VNC enablement

* VNC password

None needed

install=(nfs, http,
ftp, smb) :///path
_to_instmedia
netdevice=some
_netdevice (only need-
ed if several network de-
vices are available)
hostip=some_ ip
netmask=some
_netmask
gateway=ip_gateway
vnc=1
vncpassword=some
_password

install=(nfs, http,
ftp,smb):///path
_to_instmedia
vnc=1
vncpassword=some
_password

Not applicable; process man-
aged through PXE and DHCP



Installation Scenario

Parameters Needed for Boot Options

Booting

Section 14.1.4, “Simple
Remote Installation via
SSH—Static Network
Configuration”

(page 198)

Section 14.1.5, “Simple
Remote Installation via
SSH—Dynamic Net-
work Configuration”
(page 199)

Section 14.1.6, “Remote
Installation via
SSH—PXE Boot and
Wake on LAN”

(page 201)

* Location of the in-
stallation server

» Network device

+ IP address

» Netmask

» Gateway

« SSH enablement

+ SSH password

* Location of the in-
stallation server

+ SSH enablement

* SSH password

* Location of the in-
stallation server

» Location of the
TFTP server

+ SSH enablement

+ SSH password

install=(nfs, http,
ftp,smb) :///path
_to _instmedia
netdevice=some
_netdevice (only need-
ed if several network de-
vices are available)
hostip=some_ ip
netmask=some
_netmask
gateway=ip gateway
usessh=1
sshpassword=some
_password

install=(nfs, http,
ftp, smb) : ///path
_to_instmedia
usessh=1
sshpassword=some
_password

Not applicable; process man-
aged through PXE and DHCP
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TIP: More Information about linuxrc Boot Options

Find more information about the linuxrc boot options used for booting a Linux
system in /usr/share/doc/packages/linuxrc/linuxrc.html.

14.5 Monitoring the Installation
Process

There are several options for remotely monitoring the installation process. If the proper
boot options have been specified while booting for installation, either VNC or SSH can
be used to control the installation and system configuration from a remote workstation.

14.5.1 VNC Installation

Using any VNC viewer software, you can remotely control the installation of SUSE
Linux Enterprise Server from virtually any operating system. This section introduces
the setup using a VNC viewer application or a Web browser.

Preparing for VNC Installation

All you need to do on the installation target to prepare for a VNC installation is to
provide the appropriate boot options at the initial boot for installation (see Section 14.4.2,
“Using Custom Boot Options” (page 223)). The target system boots into a text-based
environment and waits for a VNC client to connect to the installation program.

The installation program announces the IP address and display number needed to connect
for installation. If you have physical access to the target system, this information is
provided right after the system booted for installation. Enter this data when your VNC
client software prompts for it and provide your VNC password.

Because the installation target announces itself via OpenSLP, you can retrieve the address
information of the installation target via an SLP browser without the need for any
physical contact to the installation itself provided your network setup and all machines
support OpenSLP:
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1 Start the KDE file and Web browser Konqueror.

2 Enter service://yast.installation.suse in the location bar. The
target system then appears as an icon in the Konqueror screen. Clicking this icon
launches the KDE VINC viewer in which to perform the installation. Alternatively,
run your VNC viewer software with the IP address provided and add : 1 at the
end of the IP address for the display the installation is running on.

Connecting to the Installation Program

Basically, there are two ways to connect to a VNC server (the installation target in this
case). You can either start an independent VNC viewer application on any operating
system or connect using a Java-enabled Web browser.

Using VNC, you can control the installation of a Linux system from any other operating
system, including other Linux flavors, Windows, or Mac OS.

On a Linux machine, make sure that the package t i ght vnc is installed. On a Windows
machine, install the Windows port of this application, which can be obtained at the

TightVNC home page (http://www.tightvnc.com/download.html).

To connect to the installation program running on the target machine, proceed as
follows:

1 Start the VNC viewer.

2 Enter the IP address and display number of the installation target as provided by
the SLP browser or the installation program itself:

ip_address:display_number

A window opens on your desktop displaying the YaST screens as in a normal
local installation.

Using a Web browser to connect to the installation program makes you totally indepen-
dent of any VNC software or the underlying operating system. As long as the browser
application has Java support enabled, you can use any browser (Firefox, Internet Ex-
plorer, Konqueror, Opera, etc.) to perform the installation of your Linux system.

To perform a VNC installation, proceed as follows:
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1 Launch your preferred Web browser.

2 Enter the following at the address prompt:

http://ip_address_of target:5801

3 Enter your VNC password when prompted to do so. The browser window now
displays the YaST screens as in a normal local installation.

14.5.2 SSH Installation

Using SSH, you can remotely control the installation of your Linux machine using any
SSH client software.

Preparing for SSH Installation

Apart from installing the appropriate software package (OpenSSH for Linux and PuTTY
for Windows), you just need to pass the appropriate boot options to enable SSH for
installation. See Section 14.4.2, “Using Custom Boot Options™ (page 223) for details.
OpenSSH is installed by default on any SUSE Linux—based operating system.

Connecting to the Installation Program

1 Retrieve the installation target's IP address. If you have physical access to the
target machine, just take the IP address the installation routine provides at the
console after the initial boot. Otherwise take the IP address that has been assigned
to this particular host in the DHCP server configuration.

2 Atacommand line, enter the following command:

ssh -X root@ip_address_of_target

Replace ip_address_of._target with the actual IP address of the installation
target.

3 When prompted for a username, enter root.
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4 When prompted for the password, enter the password that has been set with the
SSH boot option. After you have successfully authenticated, a command line
prompt for the installation target appears.

5 Enter yast to launch the installation program. A window opens showing the
normal YaST screens as described in Chapter 6, Installation with YaST (page 89).
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Advanced Disk Setup

Sophisticated system configurations require particular disk setups. All common parti-
tioning tasks can be done with YaST. To get persistent device naming with block devices,
use the block devices below /dev/disk/by-idor /dev/disk/by-uuid. Logical
Volume Management (LVM) is a disk partitioning scheme that is designed to be much
more flexible than the physical partitioning used in standard setups. Its snapshot func-
tionality enables easy creation of data backups. Redundant Array of Independent Disks
(RAID) offers increased data integrity, performance, and fault tolerance. SUSE® Linux
Enterprise Server also supports multipath I/O. For details, see the chapter about multipath
/0 in Storage Administration Guide. Starting with SUSE Linux Enterprise Server 10,
there is also the option to use iSCSI as a networked disk.

15.1 Using the YaST Partitioner

With the expert partitioner, shown in Figure 15.1, “The YaST Partitioner” (page 232),
manually modify the partitioning of one or several hard disks. Partitions can be added,
deleted, resized, and edited. Also access the soft RAID, EVMS, and LVM configuration
from this YaST module.

WARNING: Repartitioning the Running System

Although it is possible to repartition your system while it is running, the risk
of making a mistake that causes data loss is very high. Try to avoid repartitioning
your installed system and always do a complete backup of your data before
attempting to do so.
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Figure 15.1 The YaST Partitioner

@ Expert Partitloner
== This view shows all hard disks including isCsI disks, BIOS RAIDs and Multipath disks and their partitions. more
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- ﬂ RAID /devjsdaz 705.98 MB Linux swap  Swap swap D
/devimdo jdev/sda3 30,01 GB Linux native  Reiser
g‘ Volume Managemant Jdev/sdas 26690 GB Extended
. Jdevjsda5 100.01 GB Linux native  Reiser
[ erypt Files ”
Jdev/sdaé  30.01 GB Linux native  Ext3
EAH Device Mapper Jdevjsda7 30,01 GB Linux native  Reiser
@ NFS Jdev/sdag 30.01 GB Linux native  Ext3 ! Label
@ Unused Devices Jdev/sdag  10.00 GB Linux native  Reiser
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Jdev/sdall 33.48 GB Linux RAID
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TIP: IBM System z: Device Names

IBM System z recognize only DASD and SCSI hard disks. IDE hard disks are not
supported. This is why these devices appear in the partition table as dasda or
sda for the first recognized device.

All existing or suggested partitions on all connected hard disks are displayed in the list
of Available Storage in the YaST Expert Partitioner dialog. Entire hard disks are listed
as devices without numbers, such as /dev/sda (or /dev/dasda). Partitions are
listed as parts of these devices, such as /dev/sdal (or /dev/dasdal, respectively).
The size, type, file system, and mount point of the hard disks and their partitions are
also displayed. The mount point describes where the partition appears in the Linux file
system tree.

Several functional views are available on the lefthand System View. Use these views
to gather information about existing storage configurations, or to configure functions
like RAID, Volume Management, Crypt Files, or NFS.

If you run the expert dialog during installation, any free hard disk space is also listed
and automatically selected. To provide more disk space to SUSE® Linux Enterprise
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Server, free the needed space starting from the bottom toward the top of the list (starting
from the last partition of a hard disk toward the first). For example, if you have three
partitions, you cannot use the second exclusively for SUSE Linux Enterprise Server
and retain the third and first for other operating systems.

15.1.1 Partition Types

TIP: IBM System z: Hard Disks

On the IBM System z platforms, SUSE Linux Enterprise Server supports SCSI
hard disks as well as DASDs (direct access storage devices). While SCSI disks
can be partitioned as described below, DASDs can have no more than three
partition entries in their partition tables.

Every hard disk has a partition table with space for four entries. Every entry in the
partition table corresponds to a primary partition or an extended partition. Only one
extended partition entry is allowed, however.

A primary partition simply consists of a continuous range of cylinders (physical disk
areas) assigned to a particular operating system. With primary partitions only, you
would be limited to four partitions per hard disk, because more do not fit in the partition
table. This is why extended partitions are used. Extended partitions are also continuous
ranges of disk cylinders, but an extended partition may be subdivided into logical par-
titions itself. Logical partitions do not require entries in the partition table. In other
words, an extended partition is a container for logical partitions.

If you need more than four partitions, create an extended partition as the fourth partition
or earlier. This extended partition should span the entire remaining free cylinder range.
Then create multiple logical partitions within the extended partition. The maximum
number of logical partitions is 15 on SCSI, SATA, and Firewire disks and 63 on (E)IDE
disks. It does not matter which types of partitions are used for Linux. Primary and log-
ical partitions both work fine.

TIP: Hard Disks with a GPT Disk Label

For architectures using the GPT disk label, the number of primary partitions is
not restricted. Consequently, there are no logical partitions.
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15.1.2 Creating a Partition

To create a partition from scratch select Hard Disks and then a hard disk with free
space. The actual modification can be done in the Partitions tab:

1 Select Add. If several hard disks are connected, a selection dialog appears in
which to select a hard disk for the new partition.

2 Specify the partition type (primary or extended). Create up to four primary parti-
tions or up to three primary partitions and one extended partition. Within the
extended partition, create several logical partitions (see Section 15.1.1, “Partition
Types” (page 233)).

3 Select the file system to use and a mount point. YaST suggests a mount point
for each partition created. To use a different mount method, like mount by label,
select Fstab Options.

4 Specify additional file system options if your setup requires them. This is neces-
sary, for example, if you need persistent device names. For details on the available
options, refer to Section 15.1.3, “Editing a Partition” (page 234).

5 Click OK > Apply to apply your partitioning setup and leave the partitioning
module.

If you created the partition during installation, you are returned to the installation
overview screen.

15.1.3 Editing a Partition

When you create a new partition or modify an existing partition, set various parameters.
For new partitions, suitable parameters are set by YaST and usually do not require any
modification. To edit your partition setup manually, proceed as follows:

1 Select the partition.

2 Click Edit to edit the partition and set the parameters:
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File System ID
Even if you do not want to format the partition at this stage, assign it a file
system ID to ensure that the partition is registered correctly. Possible values
include Linux, Linux swap, Linux LVM, and Linux RAID.

File System
Change the file system or format the partition here. Changing the file system
or reformatting partitions irreversibly deletes all data from the partition.

Ext3 is the default file system for the Linux partitions. ReiserFS, JES, XFS,
and Ext3 are journaling file systems. These file systems are able to restore
the system very quickly after a system crash, because write processes are
logged during the operation. Furthermore, ReiserFS is very fast in handling
lots of small files. Ext2 is not a journaling file system. However, it is rock
solid and good for smaller partitions, because it does not require much disk
space for management.

Encrypt File System
If you activate the encryption, all data is written to the hard disk in encrypted
form. This increases the security of sensitive data, but slightly reduces the
system speed, because the encryption takes some time. More information
about the encryption of file systems is provided in Chapter 11, Encrypting
Partitions and Files (1Security Guide).

Fstab Options
Specify various parameters contained in the global file system administration
file (/etc/fstab). The default settings should suffice for most setups.
You can, for example, change the file system identification from the device
name to a volume label. In the volume label, use all characters except / and
space.

To get persistent devices names, use the mount option Device ID, UUID or
LABEL. In SUSE Linux Enterprise Server, persistent device names are en-
abled by default.

NOTE: IBM System z: Mounting by path

Since mounting by ID causes problems on IBM System z when using
disk-to-disk copying for cloning purposes, devices are mounted by
path in /etc/fstab on IBM System z by default.
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When using the mount option LABEL to mount a partition, define an appro-
priate label for the selected partition. For example, you could use the partition
label HOME for a partition intended to mount to /home.

If you intend to use quota on the file system, use the mount option Enable
Quota Support. This must be done before you can define quotas for users in
the YaST User Management module. For further information on how to
configure user quota, refer to Section 12.3.5, “Managing Quotas” (page 176).

Mount Point
Specify the directory at which the partition should be mounted in the file
system tree. Select from various YaST proposals or enter any other name.

3 Select OK > Apply to activate the partition.

NOTE: Resize Filesystems

To resize an existing file system, select the partition and use Resize. Note, that
it is not possible to resize partitions while mounted. To resize partitions, un-
mount the respective partition before running the partitioner.

15.1.4 More Partitioning Tips

The following section comprises a few hints and tips on partitioning that should help
you in taking the right decisions while setting up your system.

TIP: Cylinder Numbers

Note, that different partitioning tools may start counting the cylinders of a
partition with 0 or with 1. When calculating the number of cylinders, you should
always use the difference between the last and the first cylinder number and
add one.

Using swap

Swap is used to extend the physically available memory. This makes it possible to use
more memory than physical ram available. The memory management system of kernels
before 2.4.10 needed swap as a safety measure. In those times, if you did not have twice
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the size of your ram in swap, the performance of the system suffered. This does not
hold true anymore as these limitations no longer exist.

Linux uses a page called “Least Recently Used” (LRU) to select pages that might be
moved from memory to disk. Therefore, the running applications have more memory
available and even their caching works more smoothly.

If an application tries to allocate as much memory as it can possibly get, there are some
problems with swap. There are three major cases to look at:

System with no swap
The application gets all memory that can be freed by any means. All caches are
freed, and thus all other applications are slowed down. After a few minutes, the
out of memory killer mechanism of the kernel will become active and kill the pro-
cess.

System with medium sized swap (128 MB-512 MB)
At first, the system is slowed down like a system without swap. After all physical
ram has been used up, swap space is used as well. At this point, the system becomes
very slow and it becomes impossible to run commands from remote. Depending
on the speed of the hard disks that run the swap space, the system stays in this
condition for about 10 to 15 minutes until the out of memory killer of the kernel
resolves the issue. Note, that you will need a certain amount of swap if the computer
should perform a “suspend to disk”. In that case, the swap size should be reasonably
big to contain the necessary data from memory (512 MB-1GB).

System with lots of swap (several GB)

It is better to not have an application that is running wild and swapping frantically,
in this case. If you do have this problem, the system will need many hours to recover.
In the process, it is likely that other processes get timeouts and faults, leaving the
system in an undefined state, even if the faulty process is killed. In this case, reboot
the machine hard and try to get it running again. Lots of swap is only useful if you
have an application that relies on this feature. Such applications (like databases or
graphics manipulation programs) often have an option to directly use hard disk
space for their needs. It is advisable to use this option instead of using lots of swap
space.

If your system does not run wild, but needs more swap after some time, it is possible
to extend the swap space online. If you prepared a partition for swap space, just add
this partition with YaST. If you do not have a partition available, you may also just use
a swap file to extend the swap. Swap files are generally slower than partitions, but
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compared to physical ram, both are extremely slow and the actual speed difference is
not as important as one would think in the first place.

Procedure 15.1 Adding a Swap File Manually

To add a swap file in the running system, proceed as follows:

1

Create an empty file in your system. For example, if you want to add a swap file
with 128 MB swap at /var/1lib/swap/swapfile, use the commands:

mkdir -p /var/lib/swap
dd if=/dev/zero of=/var/lib/swap/swapfile bs=1M count=128

Initialize this swap file with the command

mkswap /var/lib/swap/swapfile

Activate the swap with the command

swapon /var/lib/swap/swapfile

To disable this swap file, use the command

swapoff /var/lib/swap/swapfile

Check the current available swap spaces with the command

cat /proc/swaps

Note, that at this point this is only temporary swap space. After the next reboot,
it is not used anymore.

To enable this swap file permanently, add the following line to /etc/fstab:

/var/lib/swap/swapfile swap swap defaults 0 0

15.1.5 Partitioning and LVM

From the expert partitioner, access the LVM configuration with Volume Management.
However, if a working LVM configuration already exists on your system, it is automat-
ically activated as soon as you enter the LVM configuration for the first time in a session.
In this case, any disks containing a partition belonging to an activated volume group

cannot be repartitioned because the Linux kernel cannot reread the modified partition
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table of a hard disk when any partition on this disk is in use. However, if you already
have a functioning LVM configuration on your system, physical repartitioning should
not be necessary. Instead, change the configuration of the logical volumes.

At the beginning of the physical volumes (PVs), information about the volume is written
to the partition. To reuse such a partition for other non-LVM purposes, it is advisable
to delete the beginning of this volume. For example, in the VG systemand PV /dev/
sda2, do this with the command dd i f=/dev/zero of=/dev/sda2 bs=512
count=1.

WARNING: File System for Booting

The file system used for booting (the root file system or /boot) must not be
stored on an LVM logical volume. Instead, store it on a normal physical partition.

For more details about LVM, see the Storage Administration Guide.

15.2 LVM Configuration

This section briefly describes the principles behind the Logical Volume Manager (LVM)
and its basic features that make it useful under many circumstances. In Section 15.2.2,
“LVM Configuration with YaST” (page 241), learn how to set up LVM with YaST.

WARNING

Using LVM might be associated with increased risk, such as data loss. Risks also
include application crashes, power failures, and faulty commands. Save your
data before implementing LVM or reconfiguring volumes. Never work without
a backup.

15.2.1 The Logical Volume Manager

The LVM enables flexible distribution of hard disk space over several file systems. It
was developed because sometimes the need to change the segmentation of hard disk
space arises only after the initial partitioning during installation has already been done.
Because it is difficult to modify partitions on a running system, LVM provides a virtual
pool (volume group, VG for short) of memory space from which logical volumes (LVs)
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can be created as needed. The operating system accesses these LVs instead of the
physical partitions. Volume groups can span more than only one disk so that several
disks or parts of them may constitute one single VG. This way, LVM provides a kind
of abstraction from the physical disk space that allows its segmentation to be changed
in a much easier and safer way than physical repartitioning does. Background information
regarding physical partitioning can be found in Section 15.1.1, “Partition Types”
(page 233) and Section 15.1, “Using the YaST Partitioner” (page 231).

Figure 15.2 Physical Partitioning versus LVM

DISK DISK 1 DISK 2
PART (PART |PART PART | PART | PART | PART |[PART
VG 1 VG 2
Lv1 Lv2 Lv3 Lv4
MP MP MP MP MP MP MP

Figure 15.2, “Physical Partitioning versus LVM” (page 240) compares physical parti-
tioning (left) with LVM segmentation (right). On the left side, one single disk has been
divided into three physical partitions (PART), each with a mount point (MP) assigned
so that the operating system can access them. On the right side, two disks have been
divided into two and three physical partitions each. Two LVM volume groups (VG 1
and VG 2) have been defined. VG 1 contains two partitions from DISK 1 and one from
DISK 2. VG 2 contains the remaining two partitions from DISK 2. In LVM, the physical
disk partitions that are incorporated in a volume group are called physical volumes
(PVs). Within the volume groups, four LVs (LV 1 through LV 4) have been defined,
which can be used by the operating system via the associated mount points. The border
between different LVs need not be aligned with any partition border. See the border
between LV 1 and LV 2 in this example.

LVM features:
+ Several hard disks or partitions can be combined in a large logical volume.

* Provided the configuration is suitable, an LV (such as /usr) can be enlarged when
the free space is exhausted.
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+ Using LVM, it is possible to add hard disks or LVs in a running system. However,
this requires hot-swappable hardware that is capable of such actions.

+ It is possible to activate a "striping mode" that distributes the data stream of a LV
over several PVs. If these PVs reside on different disks, this can improve the
reading and writing performance just like RAID 0.

+ The snapshot feature enables consistent backups (especially for servers) in the
running system.

With these features, using LVM already makes sense for heavily used home PCs or
small servers. If you have a growing data stock, as in the case of databases, music
archives, or user directories, LVM is just the right thing for you. This would allow file
systems that are larger than the physical hard disk. Another advantage of LVM is that
up to 256 LVs can be added. However, keep in mind that working with LVM is different
from working with conventional partitions. Instructions and further information about
configuring LVM is available in the official LVM HOWTO at http://t1ldp.org/
HOWTO/LVM-HOWTO/.

Starting from kernel version 2.6, LVM version 2 is available, which is downward-
compatible with the previous LVM and enables the continued management of old volume
groups. When creating new volume groups, decide whether to use the new format or
the downward-compatible version. LVM 2 does not require any kernel patches. It makes
use of the device mapper integrated in kernel 2.6. This kernel only supports LVM ver-
sion 2. Therefore, when talking about LVM, this section always refers to LVM version 2.

15.2.2 LVM Configuration with YaST

The YaST LVM configuration can be reached from the YaST Expert Partitioner (see
Section 15.1, “Using the YaST Partitioner” (page 231)) below Volume Management.
The Expert Partitioner allows you to edit and delete existing partitions and also create
new ones that should be used with LVM. The first task is to create PVs that provide
space to a volume group:

1 Select a hard disk from Hard Disks.
2 Change to the Partitions tab.

3 Click Add and enter the desired size of the PV on this disk.
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4 Use Do not Format the Partition and change the File System ID to Ox8E Linux
LVM. Do not mount this partition.

5 Repeat this procedure until you defined all the desired physical volumes on the
available disks.

Creating Volume Groups

If no volume group exists on your system yet, you have to add one (see Figure 15.3,
“Creating a Volume Group” (page 243)). It is possible to create additional groups with
Add Volume Group, but usually one single volume group is sufficient.

1 Enter a name for the VG, e.g. system.
2 Select the desired Physical Extend Size. This value defines the size of a physical

block in the volume group. All the disk space in a volume group is handled in
chunks of this size.

TIP: Logical Volumes and Block Sizes

The possible size of a LV depends on the block size used in the volume
group. The default is 4 MB and allows for a maximum size of 256 GB for
physical and LVs. The physical extent size should be increased, for exam-
ple, to 8, 16, or 32 MB, if you need LVs larger than 256 GB.

3 Add the prepared PVs to the VG by selecting the device and clicking on Add.
Selecting several devices is possible by holding Strg pressed while selecting the
devices.

4 Select Finish to make the VG available to further configuration steps.
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Figure 15.3 Creating a Volume Group
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If you have multiple volume groups defined, and want to add or remove PVs, select
the volume group in Volume Management. Then change to the Overview tab and select
Resize. In the following menu, you can add or remove PVs to the selected volume

group.

Configuring Logical Volumes

After the volume group has been filled with PVs, define the LVs the operating system
should use in the next dialog. Choose the current volume group and change to the
Logical Volumes tab. Add, Edit, Resize, and Delete 1.Vs as needed until all space in the
volume group has been exhausted. Assign at least one LV to each volume group.
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Figure 15.4 Logical Volume Management
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Click Add and go through the wizard-like popup that opens:

1. Enter the name of the LV. For a partition that should be mounted to /home, a
selfexplaining name like HOME could be used.

2. Select the size and the number of stripes of the LV. If you have only one PV, se-
lecting more than one stripes is not useful.

3. Choose the filesystem to use on the LV as well as the mount point.

By using stripes it is possible to distribute the data stream in the LV among several PVs
(striping). If these PVs reside on different hard disks, this generally results in a better
reading and writing performance (like RAID 0). However, a striping LV with n stripes
can only be created correctly if the hard disk space required by the LV can be distributed

evenly to n PVs. If, for example, only two PVs are available, a LV with three stripes
is impossible.
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WARNING: Striping

YaST has no chance at this point to verify the correctness of your entries con-
cerning striping. Any mistake made here is apparent only later when the LVM
is implemented on disk.

If you have already configured LVM on your system, the existing logical volumes can
also be used. Before continuing, assign appropriate mount points to these LVs, too.
With Next, return to the YaST Expert Partitioner and finish your work there.

15.3 Soft RAID Configuration

The purpose of RAID (redundant array of independent disks) is to combine several
hard disk partitions into one large virtual hard disk to optimize performance, data secu-
rity, or both. Most RAID controllers use the SCSI protocol because it can address a
larger number of hard disks in a more effective way than the IDE protocol and is more
suitable for parallel processing of commands. There are some RAID controllers that
support IDE or SATA hard disks. Soft RAID provides the advantages of RAID systems
without the additional cost of hardware RAID controllers. However, this requires some
CPU time and has memory requirements that make it unsuitable for real high perfor-
mance computers.

SUSE® Linux Enterprise Server offers the option of combining several hard disks into
one soft RAID system with the help. RAID implies several strategies for combining
several hard disks in a RAID system, each with different goals, advantages, and char-
acteristics. These variations are commonly known as RAID levels.

Common RAID levels are:

RAID 0
This level improves the performance of your data access by spreading out blocks
of each file across multiple disk drives. Actually, this is not really a RAID, because
it does not provide data backup, but the name RAID 0 for this type of system has
become the norm. With RAID 0, two or more hard disks are pooled together. The
performance is very good, but the RAID system is destroyed and your data lost if
even one hard disk fails.
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RAID 1

This level provides adequate security for your data, because the data is copied to
another hard disk 1:1. This is known as hard disk mirroring. If a disk is destroyed,
a copy of its contents is available on another one. All of them except one could be
damaged without endangering your data. However, if damage is not detected, it
also may happen that damaged data is mirrored to the correct disk and data corrup-
tion happens that way. The writing performance suffers a little in the copying process
compared to when using single disk access (10 to 20 % slower), but read access is
significantly faster in comparison to any one of the normal physical hard disks,
because the data is duplicated so can be parallel scanned. Generally it can be said
that Level 1 provides nearly twice the read transaction rate of single disks and almost
the same write transaction rate as single disks.

RAID 2 and RAID 3

These are not typical RAID implementations. Level 2 stripes data at the bit level
rather than the block level. Level 3 provides byte-level striping with a dedicated
parity disk and cannot service simultaneous multiple requests. Both levels are only
rarely used.

RAID 4

Level 4 provides block-level striping just like Level 0 combined with a dedicated
parity disk. In the case of a data disk failure, the parity data is used to create a re-
placement disk. However, the parity disk may create a bottleneck for write access.
Nevertheless, Level 4 is sometimes used.

RAID 5

RAID 5 is an optimized compromise between Level 0 and Level 1 in terms of
performance and redundancy. The hard disk space equals the number of disks used
minus one. The data is distributed over the hard disks as with RAID 0. Parity blocks,
created on one of the partitions, are there for security reasons. They are linked to
each other with XOR, enabling the contents to be reconstructed by the corresponding
parity block in case of system failure. With RAID 5, no more than one hard disk
can fail at the same time. If one hard disk fails, it must be replaced as soon as pos-
sible to avoid the risk of losing data.

Other RAID Levels

Several other RAID levels have been developed (RAIDn, RAID 10, RAID 0+1,
RAID 30, RAID 50, etc.), some of them being proprietary implementations created
by hardware vendors. These levels are not very widespread, so are not explained
here.
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15.3.1 Soft RAID Configuration with YaST

The YaST RAID configuration can be reached from the YaST Expert Partitioner, de-
scribed in Section 15.1, “Using the YaST Partitioner” (page 231). This partitioning tool
enables you to edit and delete existing partitions and create new ones that should be
used with soft RAID. There, create RAID partitions:

1 Select a hard disk from Hard Disks.
2 Change to the Partitions tab.
3 Click Add and enter the desired size of the raid partition on this disk.

4 Use Do not Format the Partition and change the File System ID to OxFD Linux
RAID. Do not mount this partition.

5 Repeat this procedure until you defined all the desired physical volumes on the
available disks.

For RAID 0 and RAID 1, at least two partitions are needed—for RAID 1, usually ex-
actly two and no more. If RAID 5 is used, at least three partitions are required. It is
recommended to take only partitions of the same size. The RAID partitions should be
located on different hard disks to decrease the risk of losing data if one is defective
(RAID 1 and 5) and to optimize the performance of RAID 0. After creating all the
partitions to use with RAID, click RAID > Add RAID to start the RAID configuration.

In the next dialog, choose between RAID levels 0, 1, and 5. Then, select all partitions
with either the “Linux RAID” or “Linux native” type that should be used by the RAID
system. No swap or DOS partitions are shown.
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Figure 15.5 RAID Partitions
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To add a previously unassigned partition to the selected RAID volume, first click the
partition then Add. Assign all partitions reserved for RAID. Otherwise, the space on
the partition remains unused. After assigning all partitions, click Next to select the
available RAID Options.

In the last step, set the file system to use as well as encryption and the mount point for
the RAID volume. After completing the configuration with Finish, see the /dev/md0
device and others indicated with RAID in the expert partitioner.

15.3.2 Troubleshooting

Check the file /proc/mdstat to find out whether a RAID partition has been damaged.
In the event of a system failure, shut down your Linux system and replace the defective
hard disk with a new one partitioned the same way. Then restart your system and enter
the commandmdadm /dev/mdX —-add /dev/sdX.Replace'X' with your partic-
ular device identifiers. This integrates the hard disk automatically into the RAID system
and fully reconstructs it.

Note that although you can access all data during the rebuild, you may encounter some
performance issues until the RAID has been fully rebuilt.
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15.3.3 For More Information

Configuration instructions and more details for soft RAID can be found in the HOWTOs
at:
* /usr/share/doc/packages/mdadm/Software—RAID.HOWTO.html

* http://en.tldp.org/HOWTO/Software—RAID-HOWTO.html

Linux RAID mailing lists are also available, suchashttp://marc.theaimsgroup

.com/?1l=linux-raid.
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Subscription Management

Any machine running SUSE Linux Enterprise Server 11 or SUSE Linux Enterprise
Desktop 11 can be configured to register against local Subscription Management Tool
server and download software updates from there instead of communicating directly
with the Novell Customer Center and the NU servers. To use an SMT server for client
registration and as a local update source, you must configure the SMT server in your
network first. The SMT server software is distributed as an add-on for SUSE Linux
Enterprise Server and its confuguration is desribed in the Subscription Management
Tool Guide. There is no need to install any add-on on the clients to be configured to
register against an SMT server.

To register a client against an SMT server, you need to equip the client with the server's
URL. As client and server communicate via the HTTPS protocol during registration,
you also need to make sure the client trusts the server's certificate. In case your SMT
server is set up to use the default server certificate, the CA certificate will be available
on the SMT server via HTTP protocol at http: //FODN/smt . crt. In this case you
do not have to care about the certificate: The registration process will automatically
download the CA certificate from there, unless configured otherwise. You have to enter
apath to the server's CA certificate if the certificate was issued by an external certificate
authority.

NOTE: Registering Against * .novell.com Subdomain

If you try to register against any * .novell.com subdomain, the certificate
will not be downloaded during registration for security reasons, and certificate
handling will not be done. In such a case, use a different domain name or a
plain IP address.
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There are several ways to provide this information and to configure the client machine
to use SMT. The first way is to provide the needed information via kernel parameters
at boot time. The second way is to configure clients using an AutoYaST profile. There
is also a script distributed with Subscription Management Tool,
clientSetup4SMT. sh, which can be run on a client to make it register against a
specified SMT server. These methods are described in the following sections:

16.1 Using Kernel Parameters to
Access an SMT Server

Any client can be configured to use SMT by providing the following kernel parameters
during machine boot: regurl and regcert. The first parameter is mandatory, the
latter is optional.

regurl
URL of the SMT server. The URL needs to be in the following format:
https://FODN/center/regsvc/ with FODN being the fully qualified
hostname of the SMT server. It must be identical to the FQDN of the server certifi-
cate used on the SMT server. Example:

regurl=https://smt.example.com/center/regsvc/

regeert
Location of the SMT server's CA certificate. Specify one of the following locations:

URL
Remote location (http, https or ftp) from which the certificate can be download-
ed. Example:

regcert=http://smt.example.com/smt.crt

Floppy
Specifies a location on a floppy. The floppy has to be inserted at boot time—you

will not be prompted to insert it if it is missing. The value has to start with the
string £ 1oppy, followed by the path to the certificate. Example:

regcert=floppy/smt/smt-ca.crt

Local Path
Absolute path to the certificate on the local machine. Example:
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regcert=/data/inst/smt/smt-ca.cert

Interactive

Use ask to open a pop-up menu during installation where you can specify the
path to the certificate. Do not use this option with AutoYaST. Example:

regcert=ask

Deactivate Certificate Installation

Use done if either the certificate will be installed by an add-on product, or if
you are using a certificate issued by an official certificate authority. Example:

regcert=done

WARNING: Beware of Typing Errors

Make sure the values you enter are correct. If regurl has not been specified
correctly, the registration of the update source will fail.

If a wrong value for regcert has been entered, you will be prompted for a
local path to the certificate. In case regcert is not specified at all, it will default
to http://FODN/smt .crt with FQDN being the name of the SMT server.

WARNING: Change of SMT Server Certificate

If the SMT server gets a new certificate from a new and untrusted CA, the
clients need to fetch the new CA certificate file. This is done automatically with
the registration process but only if a URL was used at installation time to fetch
the certificate, or if the regcert parameter was omitted and thus, the default
URL is used. If the certificate was loaded using any other method, such as
floppy or local path, the CA certificate will not be updated.

16.2 Configuring Clients Using
AutoYaST Profile

Clients can be configured to register with SMT server via AutoYaST profile. For gen-
eral information about creating AutoYaST profiles and preparing automatic installation,
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refer to Chapter 21, Automated Installation (page 289). In this section, only SMT spe-
cific configuration is described.

To configure SMT specific data using AutoYaST, follow these steps:

1

As root, start YaST and select Miscellaneous > Autoinstallation to start the
graphical AutoYaST front-end.

From a command line, you can start the graphical AutoYaST front-end with the
yast2 autoyast command.

Open an existing profile using File > Open, create a profile based on the current
system's configuration using 7ools > Create Reference Profile, or just work with
an empty profile.

Select Support > Novell Customer Center Configuration. An overview of the
current configuration is shown.

Click Edit.

To register while installing automatically, select Run Product Registration. You
can include information from your system with Hardware Profile and Optional
Information.

Set the URL of the SMT Server and, optionally, the location of the SMT Certifi-
cate. The possible values are the same as for the kernel parameters regur1 and
regcert (see Section 16.1, “Using Kernel Parameters to Access an SMT
Server” (page 252)). The only exception is, that the ask value for regcert
does not work in AutoYaST, because it requires user interaction. If using it, the
registration process will be skipped.

Perform all other configuration needed for the systems to be deployed.

Select File > Save As and enter a filename for the profile, such as autoinst
.xml.

Deployment Guide



16.3 Configuring Clients Using the
clientSetup4SMT.sh Script

The /usr/share/doc/packages/smt/clientSetup4SMT. sh script is
provided with SMT. This script allows to configure a client machine to use a SMT
server or to reconfigure it to use a different SMT server.

To configure a client machine to use SMT with the clientSetup4SMT. sh script,
follow these steps:

1 Copy the /usr/share/doc/packages/smt/clientSetup4SMT. sh
script from your SMT server to the client machine.

2 Asroot, execute the script on the client machine. The script can be executed
in two ways. In the first case, the script name is followed by the registration URL:
./clientSetup4SMT.sh registration_ URL, for example,
./clientSetup4SMT. sh
https://smt.example.com/center/regsvc. Inthe second case, the
script name is followed by the ——host option followed by hostname of the SMT
server: . /clientSetup4SMT.sh —-host server._ hostname, for ex-
ample, . /clientSetup4SMT.sh —-host smt.example.com.

3 The script downloads the server's CA certificate. Accept it by pressing y.

4 The script performs all necessary modifications on the client. However, the reg-
istration itself is not performed by the script.

5 Perform a registration by executing suse_register or running yast2
inst_suse_register module on the client.

16.4 Registering Clients Against SMT
Test Environment

To configure a client to register against the test environment instead the production
environment, modify /etc/suseRegister.conf onthe client machine by setting:
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register = command=register&testenv=l1l

For more information about using SMT with a test environment, refer to the Subscription
Management Tool Guide.
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Part Ill. Imaging and Creating
Products






KIWI

KIWTI is a system for creating operating system images. An image is a directory with
a file containing the operating system, its applications and configurations, the filesystem
structure of the OS, possible additional metadata, and depending on the image type,
also disk geometry and partition table data. With KIWI you can create LiveCDs and
LiveDVDs, USB sticks, virtual disk to play in full virtual systems like VMware, XEN
images for paravirtualization in a hypervisor, and a PXE environment to boot from
network.

17.1 Prerequisites for KIWI

To build images with KIWI, you need the following preconditions:
1. Free space, the more the better.

2. KIWI is split into several packages, targeted to different image types. In any case,
you need the base package kiwi. Depending on your target image, you need the
following packages:

Image Type Package Name
Installation Media kiwi-desc-oemboot
Virtualization kiwi-desc—-xenboot
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Image Type Package Name

USB Sticks kiwi-desc-usbboot

Network Client kiwi-desc-netboot

3. Install the kiwi-doc package. You can find some example configurations to get
an idea about the structure and its content.

4. Know the KIWI configuration file and its structure. It is based on a RELAX NG
schema and documented in the kiwi package under /usr/share/doc/
packages/kiwi/kiwi.html. You need this document, if you want to create
the configuration file from scratch or when you want to insert elements or attributes.

17.2 Knowing KIW/I’s Build Process

The building process of KIWI is separated into three steps:

1. Physical Extend (Preparation)  This stage prepares the content of your new
filesystem. During this step, the root directory is created, you determine which
packages are installed on your image and which user configuration files are includ-
ed.

2. Logical Extend (Creation)  This stage requires a successful preparation step.
The logical extend step creates the operating system image based on the first step.

3. Deployment The resulting image type can be deployed with different methods
like installed on a hard disk or played by a virtualization system (VMware, Qemu,
VirtualBox).

17.3 Image Description

KIWI needs an image description to build an image type. The image description is a
directory which contains at least a file config. xm1, or alternatively with the extension

*.kiwi.
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17.3.1 Contents of Image Description

The following table contains additional optional information. However, most of infor-
mation is mandatory for the functionality of the later operating system:

Table 17.1 Additional Files and Directories For Image Description

File/Directory

Description

config/

config.sh

config.xml

config-cdroot.tgz
config-cdroot.sh
config-yast—autoyast
.xml

config-yast-firstboot
.xml

images.sh

root/

optional subdirectory. Contains Bash scripts which
are executed after the installation of all the image
packages.

optional configuration script while creating the
physical extend

configuration file for each image description, ex-
plained in Section 17.3.2 (page 262)

archive, only used for ISO images

manipulate extracted data from config-cdroot
.tgz

configuration file created by AutoYaST

configuration file for controlling the YaST firstboot
service

optional configuration script while creating the
preparation step

contains other directories, special files, and scripts
which are changed after the installation of all im-
age packages
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17.3.2 The config.xml File

All information about an image description is stored in the central configuration XML
file config.xml. Each time KIWI is executed, config.xml is validated against
an RELAX NG schema (see http://www.relaxng.org for more information
about this schema language). Therefor it is recommended, to use a decent XML editor
with RELAX NG support or to use the documentation about the schema in the HTML
file /usr/share/doc/packages/kiwi/schema/kiwi.xsd.html.

The configuration file consists of several parts:
+ some description about the author, contact information, and a short explanation.
+ preferences option needed for the logical extent stage.
+ information about the users, their name, their home directories, and their passwords.
+ links to repositories.
+ alist of packages that are used for the definied image type.

+ and others, less important information which can be viewed in the above HTML
file of the RELAX NG schema documentation.

An skeleton of the file is shown in the following example:
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Example 17.1 KIWI Configuration File

<image schemeversion="2.0" name="..."> @

<description type="system"> @
<author>...</author>
<contact>...</contact>
<specification>...</specification>

</description>

<preferences> ©
<type primary="true" boot="..." flags="...">iso</type>
<type boot="..." filesystem="ext3" format="vmdk">vmx</type>
<type boot="..." filesystem="ext3">xen</type>
<type boot="..." filesystem="squashfs" flags="unified">oem</type>

<version>2.7.0</version>

<size unit="M">780</size>
<packagemanager>zypper</packagemanager>
<rpm-check-signatures>False</rpm-check-signatures>
<rpm-force>False</rpm-force>
<locale>en_US.UTF-8</locale>
<oem-swap>no</oem—swap>
<oem-boot-title>USB</oem-boot-title>

</preferences>
<users group="users"> @

<user name="root" pwd="" home="/root"/>
</users>

<repository type="rpm-md"> @
<source path="/home/rpmdir"/>
</repository>
<packages type="image" patternPackageType="onlyRequired"> ®
<package name="yast2-live-installer"/>
<package name="pam"/>
<!-— List of packages reduced -->
</packages>

®  The root element of every KIWI configuration file. Each file requires the version

number. An optional kiwirevision attribute can be used to specify an SVN
revision of KIWI.

®  Contains a mandatory descriptions with information about the creator of this image
descriptions, its contact address and some short explanation.

®  Contains a mandatory preferences with information about the version of this image,
the used package manager, the supported image types, and other settings.

® The optional users element contains a list of all users which are added to the
image. The user element contains the name, the path to its home directory,
password, and the shell.

® Contains a mandatory list of repositories used by the package manager.
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® Contains a mandatory list of packages which are included into the image.

More details about the configuration file is shown in the HTML page above.

17.4 Creating Appliances with KIWI

This section describes how to create appliances with KIWI. An appliance is a special
designed operating system for a specific task. For example, you can create an appliance
with the focus on office programs.

17.4.1 Creating a Local Installation Source

All examples in the kiwi-doc packages need a valid installation source to create an
image. Usually the examples connect to a network resource. The higher the network
bandwith, the faster the image creation. If you do not have a fast network or you do not
want to use it, create a local installation resource. Proceed as follows:

1 Collect your installation DVD.

2 Open a shell and become root.

3 Create the directory for your local installation directory. The examples use usu-
ally the path /image/CDs/£full-VERSION-ARCH. Replace the placeholders
VERSION and ARCH with the respective values.

4 Mount the medium. Replace the DRI VE placeholder with the respective device
(usually dvd, cdrom, etc.):

mount -o loop /dev/DRIVE /mnt

5 Copy all the content of the medium into the installation directory:

cp -a /mnt/* /images/CDs/full-VERSION-ARCH

To use the local installation source, all you need to do is to enable it in the repository
element:
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<repository type="...">

<!-— Remove the comment markers in the next line -->

<!-- <source path="/image/CDs/full-VERSION-ARCH" -->

<source path="opensuse://openSUSE:11.0/standard"/>
</repository>

17.4.2 Creating an Image

An image is a virtual disk image containing all partitions, boot loader information, and
packages as it resides on a real disk. To create an ISO image, proceed as follows:

1 Install the packages kiwi and kiwi-doc and resolve any dependencies.
2 Open a shell and become root.

3 Copy the directory /usr/share/doc/packages/kiwi/examples/
suse-11.0/suse—oem-preload to your current directory.

4 Open the file config.xml and locate the element repository. If you want
to use a local installation source, refer to Section 17.4.1 (page 264) for more in-

formation.

5 Execute KIWI with the following command to prepare the first stage (“physical
extend”):

kiwi —--prepare suse-oem-preload —--root oem

6 Build the ISO image:

kiwi —-create oem —-type iso --destdir /tmp/myoem

17.4.3 Creating Preload Image with NFS

To create an image with NFS functionality, proceed as follows:
1 Open a shell and become root.

2 Copy the directory /usr/share/doc/packages/kiwi/examples/
suse-11.1/suse-oem-preload to your current directory.
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3 Openthefile suse-oem-preload/config.xml and locate the packages
element with the attribute t ype="1image".

4 Insert the following line between <packages type="image"> and
</packages> and save the file:

<package name="nfs-client"/>

5 Rebuild the image as described in Step 5 (page 265).

17.5 For More Information

Find more information about KIWI in the following documents:
* http://developer.berlios.de/projects/kiwi—Homepage of KIWI

* file:///usr/share/doc/packages/kiwi/kiwi.pdf—Extensive de-
scription about the KIWI Image System
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Creating Add-On Products
With Add-on Creator

An Add-On is a special designed media, usually a CD or DVD, to extend your product.
The Add-on Creator was developed to support our customers and partners and simplify
third-party software distribution for all SUSE products.

18.1 Creating Images

To create a Add-On CD, proceed as follows:

1 Start YaST and open the Add-On Creator module. A window opens.

2 If you have not run this module before, click on Create an Add-On from the
Beginning to start. In case you have already created an Add-On, the window
shows a list of all created Add-Ons. Click Add to start.

3 Enter the product name and version of your Add-On and give some further
options:

+ Choose the required product which is based upon.

+ Optionally select the path to additional Add-On packages. You need this,
if you need further RPM packages which are not included in your base
product.

+ Optionally select the path with the required product packages.
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4 Correct the product definition and enter a vendor name. Disable Skow Only
Required Keywords to display more keywords.

5 Optionally change the package descriptions. Use Add Language to insert a
new language and add translated descriptions.

6 Optionally add new patterns. With patterns you can group your RPM packages.
Use New to add a new pattern name and change the respective attributes in
the list below.

7 Modify the output settings. Enter a path to your output directory and optionally
change the name of the ISO name. Additionally, you can modify further fea-
tures:

+ Use Configure Workflow... to enter files to customize your product
workflow.

+ Use Optional Files... to add files to your Add-On product. The first part
can be used to insert information about the Add-On in the info.txt
file. Use the license files to display a window with Agree and Disagree
buttons before the installation starts. More files can be added in the
README section.

The second part can be used to store COPYRIGHT and COPYING files
in various languages.

8 Sign your Add-On product with your GPG key. Signing your product with
your GPG key provides evidence of the origin of your product. If you do not
have a key, create one first and enter the respective passphrase twice.

9 Check your product in the overview and proceed with Finish.

10 Use the Build button to start the process. Finish closes the window.

18.2 Add-On Structure

If you create an Add-On product, the following overview contains the structure of the
files and directories:
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ARCHIVES.qgz
Contains the gzipped contents of all RPM files. It is actually a listing of the rpm
command with the options —gi1 for each RPM file.

Changelog
Contains all the changes of the RPM files.

content
Contains information about your Add-On product.

content.asc
Contains the signature file from GnuPG.

content.key, gpg-pubkey-NUMBER. asc
The public GPG key.

INDEX.gz
Contains a list of all RPM files and packed with gzip.

1s-1R.gz
Contains a list of all files and directories of your Add-On product medium.

media.N/
Contains files with basic information about the Add-On media set. The directory

is numered, somedia. 1/ is for the first Add-On medium. Additional media have
a consecutive number.

suse/
Contains sub directories with architecture specific information. Exceptions are
noarch/ for architecture independent packages, and src/ for source packages.
Proprietary software packages are stored under nosrc/.

18.3 For More Information

Find more information in the following documents:

* http://en.opensuse.org/KIWI—KIWI Project
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* http://en.opensuse.org/Creating_YaST_Installation
__Sources—YaST installation source creation

* http://en.opensuse.org/Libzypp/Metadata/YaST—YaST metadata
description

* http://developer.novell.com/wiki/index.php/Creating
_Add-ons—
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Creating Images with YaST
Product Creator

The YaST Product Creator is a unified graphical front-end for KIWI and Add-on Creator.
It was developed to provide image creation functionality in one place. All tools integrated
in the YaST Product Creator are still available as separate YaST modules or applications.

19.1 Prerequisites for Product Creator

Before you can create images with the YaST Product Creator, make sure you meet the
following prerequisites:

1. Install the package yast 2-product-creator from the SDK under ftp://
dist.suse.de/install/SLE-11-SDK. Thispackage needs other packages.
Make sure you fullfill all dependencies.

2. Free space. The more, the better.

19.2 Creating Images

The Product Creator uses KIWI to create an image of a product. In case you are inter-
ested in manually developing such images, refer to Chapter 17, KIWI (page 259).

To create an image, proceed as follows:
1 Ifyou start the Product Creator for the first time, enter the configuration name

and choose the method how packages are added to the ISO image.
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If you have been used the Product Creator already before, select Add to create a
new product definition and enter the configuration name and choose the method.

2 Select or deselect package sources. To select a source, select it from the table
and click Select. With Create New... execute the Add-on Creator, see Chapter 18,
Creating Add-On Products With Add-on Creator (page 267) for more information.
To add a different kind of source, add the source in the YaST Installation Sources
module first then run the Product Creator again. After source selection, click
Next.

NOTE: Unsupported Target Architectures

Do not change the target architecture. KIWI does not support building
of different architectures at the moment.

3 Enter the path in which to create the skeleton directory. Choose wheather to
Generate ISO Image File or Create Directory Tree Only. Use the other options
to insert metadata. Click Next.

4 Edit the content of the isolinux.cfg file, if it is a part of the configuration.
In most cases you can leave it as it is. If the file is not part of the configuration,
add it now with Load File. Click Next.

5 Select your software. All package dependencies are solved automatically after
Apply is clicked.

6 Sign your product with Digitally Sign the Product on the Medium, if needed.
Provide a key for your product configuration. Signing your product with your
GPG key provides evidence of the origin of your product. After key configuration,
click Next.

7 Review the summary. To change any option, use Back. To confirm your new
product configuration, click Finish.

Your product definition is now completed. The Product Creator allows you to choose
from the following actions:

* Create Product Creates an ISO image of the selected product. If there is some-
thing missing, the process will be aborted. Correct the error and repeat the configu-
ration.
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* Create Image with KIWIL..  Use the pull-down menu to choose from different
target formats, such as Live media or Xen images.

19.3 For More Information

Find more information about creating system images and related topics in the following
documents:

» Chapter 17, KIWI (page 259)
* http://en.opensuse.org/KIWI—The KIWI project

* /usr/share/doc/packages/kiwi/kiwi.pdf—KIWI documentation
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Deploying Customized
Preinstallations

Rolling out customized preinstallations of SUSE Linux Enterprise Server to a large
number of identical machines spares you from installing each one of them separately
and provides a standardized installation experience for the end users. With YaST first-
boot, create customized preinstallation images and determine the workflow for the final
personalization steps that involve end user interaction. This is different from AutoYaST
that allows completely automated installations; for more information, see Chapter 21,
Automated Installation (page 289).

Creating a custom installation, rolling it out to your hardware, and personalizing the
final product involves the following steps:

1 Prepare the master machine whose disk should be cloned to the client machines.
For more information, refer to Section 20.1, “Preparing the Master Machine”

(page 276).

2 Customize the firstboot workflow. For more information, refer to Section 20.2,
“Customizing the Firstboot Installation” (page 276).

3 Clone the master machine's disk and roll this image out to the clients' disks. For
more information, refer to Section 20.3, “Cloning the Master Installation”
(page 285).

4 Have the end user personalize the instance of SUSE Linux Enterprise Server.
For more information, refer to Section 20.4, “Personalizing the Installation”

(page 285).
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20.1 Preparing the Master Machine

To prepare a master machine for a firstboot workflow, proceed as follows:

1 Insert the installation media into the master machine.
2 Boot the machine.

3 Perform a normal installation including all necessary configuration steps and
wait for the installed machine to boot. Also install the yast2-firstboot
package.

4 To define your own workflow of YaST configuration steps for the end user or
to add your own YaST modules to this workflow, proceed to Section 20.2,
“Customizing the Firstboot Installation” (page 276). Otherwise proceed directly
to Step 5 (page 276).

5 Enable firstboot as root:
Create an empty file /var/1ib/YaST2/reconfig_systemto trigger

firstboot's execution. This file will be deleted, once the firstboot configuration
has been successfully accomplished. Create this file using the following command:

touch /var/lib/YaST2/reconfig_system

6 Proceed to Section 20.3, “Cloning the Master Installation” (page 285).

20.2 Customizing the Firstboot
Installation

Customizing the firstboot installation may involve several different components. Cus-
tomizing them is optional. If you do not make any changes, firstboot performs the in-
stallation using the default settings. The following options are available:

+ Customizing messages to the user as described in Section 20.2.1, “Customizing
YaST Messages” (page 277).
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+ Customizing licenses and license actions as described in Section 20.2.2, “Customiz-
ing the License Action” (page 278).

+ Customizing the release notes to display as described in Section 20.2.3, “Customiz-
ing the Release Notes” (page 279).

+ Customizing the order and number of components involved in the installation as
described in Section 20.2.4, “Customizing the Workflow” (page 279).

+ Configuring additional optional scripts as described in Section 20.2.5, “Configuring
Additional Scripts” (page 284).

To customize any of these components, adjust the following configuration files:

/etc/sysconfig/firstboot
Configure various aspects of firstboot, such as release notes, scripts, and license
actions.

/etc/YaST2/firstboot.xml
Configure the installation workflow by enabling or disabling components or adding
custom ones.

20.2.1 Customizing YaST Messages

By default, an installation of SUSE Linux Enterprise Server contains several default
messages that are localized and displayed at certain stages of the installation process.
These include a welcome message, a license message, and a congratulatory message
at the end of installation. You can replace any of these with your own versions and in-
clude localized versions of them in the installation. To include your own welcome
message, proceed as follows:

1 Loginas root.

2 Openthe /etc/sysconfig/firstboot configuration file and apply the
following changes:

2a Set FIRSTBOOT_WELCOME_DIR to the directory path where you want to

store the files containing the welcome message and the localized versions,
for example:
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FIRSTBOOT_WELCOME_DIR="/usr/share/firstboot/"

2b If your welcome message has filenames other than we 1 come . txt and

welcome_Jlocale.txt (Where 1ocale matches the ISO 639 language
codes such as “cs” or “de”), specify the filename pattern in
FIRSTBOOT_WELCOME_PATTERNS. For example:

FIRSTBOOT_WELCOME_PATTERNS="mywelcome.txt"

If unset, the default value of welcome . txt is assumed.

3 Create the welcome file and the localized versions and place them in the directory
specified in the /etc/sysconfig/firstboot configuration file.

Proceed in a similar way to configure customized license and finish messages. These
variables are FIRSTBOOT_LICENSE_DIR and FIRSTBOOT_FINISH_FILE.

Change the SHOW_Y2CC_CHECKBOX to “yes”, if the user should be able to start YaST
directly after performing the installation.

20.2.2 Customizing the License Action

You can customize the way the installation system reacts to a user not accepting the
license agreement. There are three different ways in which the system could react to a
user's failure to accept the license:

halt
The firstboot installation is aborted and the entire system shuts down. This is the
default setting.

continue
The firstboot installation continues.

abort
The firstboot installation is aborted, but the system tries to boot.

Make your choice and set LICENSE_REFUSAL_ACTION to the appropriate value.
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20.2.3 Customizing the Release Notes

Depending on whether you have changed the instance of SUSE Linux Enterprise
Server you are deploying with firstboot, you probably need to educate the end users
about important aspects of their new operating system. A standard installation uses re-
lease notes, displayed during one of the final stages of the installation, to provide im-
portant information to the users. To have your own modified release notes displayed
as part of a firstboot installation, proceed as follows:

1 Create your own release notes file. Use the RTF format as in the example file in
/usr/share/doc/release-notes and save the result as
RELEASE-NOTES.en.rtf (for English).

2 Store optional localized versions next to the original version and replace the en

part of the filename with the actual ISO 639 language code, such as de for Ger-
man.

3 Open the firstboot configuration file from /etc/sysconfig/firstboot

and set FIRSTBOOT_RELEASE_NOTES_PATH to the actual directory where
the release notes files are stored.

20.2.4 Customizing the Workflow

By default, a standard firstboot workflow includes the following components:

Language Selection
Welcome

License Agreement
Host Name
Network

Time and Date

Desktop
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+ root Password

+ User Authentication Method
» User Management

» Hardware Configuration

+ Finish Setup

This standard layout of a firstboot installation workflow is not mandatory. You can
enable or disable certain components or hook your own modules into the workflow.
To modify the firstboot workflow, manually edit the firstboot configuration file /et c/
YaST2/firstboot .xml. This XML file is a subset of the standard control . xml
file that is used by YaST to control the installation workflow.

For an overview about proposals, see Example 20.1, “Configuring the Proposal Screens”
(page 280). This provides you with enough background to modify the firstboot installation
workflow. The basic syntax of the firstboot configuration file and how the key elements
are configured is explained with this example.

Example 20.1 Configuring the Proposal Screens

<proposals config:type="1ist">@®

<proposal>®
<name>firstboot_hardware</name>®
<mode>installation</mode>®
<stage>firstboot</stage>@®
<label>Hardware Configuration</label>®
<proposal_modules config:type="1ist">@

<proposal_module>printer</proposal_module>®

</proposal_modules>

</proposal>

<proposal>

</proposal>
</proposals>

e

The container for all proposals that should be part of the firstboot workflow.

®

The container for an individual proposal.

®  The internal name of the proposal.
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® The mode of this proposal. Do not make any changes here. For a firstboot instal-
lation, this must be setto installation.

® The stage of the installation process at which this proposal is invoked. Do not
make any changes here. For a firstboot installation, this must be set to
firstboot.

® The label to be displayed on the proposal.
@ The container for all modules that are part of the proposal screen.

®  One or more modules that are part of the proposal screen.

The next section of the firstboot configuration file consists of the workflow definition.
All modules that should be part of the firstboot installation workflow must be listed
here.

Example 20.2 Configuring the Workflow Section

<workflows config:type="1list">
<workflow>
<defaults>
<enable_back>yes</enable_back>
<enable_next>yes</enable_next>
<archs>all</archs>
</defaults>
<stage>firstboot</stage>
<label>Configuration</label>
<mode>installation</mode>
. <!-— 1list of modules -->
</modules>
</workflow>
</workflows>

The overall structure of the work f 1ows section is very similar to that of the
proposals section. A container holds the workflow elements and the workflow ele-
ments all include stage, label and mode information just as the proposals introduced in
Example 20.1, “Configuring the Proposal Screens” (page 280). The most notable differ-
ence is the defaults section, which contains basic design information for the work-
flow components:

enable_back
Include the Back button in all dialogs.
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enable_next
Include the Next button in all dialogs.

archs
Specify the hardware architectures on which this workflow should be used.

Example 20.3 Configuring the List of Workflow Components

<modules config:type="1list">@®
<module>®
<label>Language</label>®
<enabled config:type="boolean">false</enabled>@®
<name>firstboot_language</name>®
</module>
<modules>

The container for all components of the workflow.
The module definition.
The label displayed with the module.

The switch to enable or disable this component in the workflow.

@ © & ® @

The module name. The module itself must be located under /usr/share/
YaST2/clients and have the . ycp file suffix.

To make changes to the number or order of proposal screens during the firstboot instal-
lation, proceed as follows:

T Open the firstboot configuration file at /etc/YaST2/firstboot .xml.
2 Delete or add proposal screens or change the order of the existing ones:

* To delete an entire proposal, remove the proposal element including all
its subelements from the proposals section and remove the respective
module element (with subelements) from the workflow.

* To add a new proposal, create a new proposal element and fill in all the
required subelements. Make sure that the proposal exists as a YaST module

in /usr/share/YaST2/clients.
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* To change the order of proposals, move the respective module elements
containing the proposal screens around in the workflow. Note that there may
be dependencies to other installation steps that require a certain order of
proposals and workflow components.

3 Apply your changes and close the configuration file.

You can always change the workflow of the configuration steps when the default does
not meet your needs. Enable or disable certain modules in the workflow or add your
Own custom ones.

To toggle the status of a module in the firstboot workflow, proceed as follows:
1 Openthe /etc/YaST2/firstboot.xml configuration file.

2 Change the value for the enabled element from true to false to disable
the module or from false to true to enable it again.

<module>
<label>Time and Date</label>
<enabled config:type="boolean">true</enabled>
<name>firstboot_timezone</name>

</module>

3 Apply your changes and close the configuration file.
To add a custom made module to the workflow, proceed as follows:

1 Create your own YaST module and store the module file module_name.ycp
in /usr/share/YaST2/clients.

2 Openthe /etc/YaST2/firstboot .xml configuration file.
3 Determine at which point of the workflow your new module should be run. In
doing so, make sure that possible dependencies to other steps in the workflow

are taken into account and resolved.

4 Create anew module element inside the modules container and add the appro-
priate subelements:
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<modules config:type="1list">

<module>
<label>my module</label>
<enabled config:type="boolean">true</enabled>
<name>filename_my_module</name>
</module>
</modules>

4a Enter the label to display on your module in the 1abel element.

4b Make sure that enabled is set to t rue to have your module included in
the workflow.

4c Enter the filename of your module in the name element. Omit the full path
and the . ycp suffix.

5 Apply your settings and close the configuration file.

TIP: For More Information

For more information about YaST development, refer to http://developer
.novell.com/wiki/index.php/YaST. Detailed information about YaST
firstboot can be found at http://forgeftp.novell.com/yast/doc/
SL11.1/tdg/inst_in_general_chap.html.

20.2.5 Configuring Additional Scripts

firstboot can be configured to execute additional scripts after the firstboot workflow
has been completed. To add additional scripts to the firstboot sequence, proceed as
follows:

1 Openthe /etc/sysconfig/firstboot configuration file and make sure
that the path specified for SCRIPT_DIR is correct. The default value is /usr/
share/firstboot/scripts.

2 Create your shell script, store it in the specified directory, and apply the appropri-
ate file permissions.
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20.3 Cloning the Master Installation

Clone the master machine's disk using any of the imaging mechanisms available to you
and roll these images out to the target machines.

20.4 Personalizing the Installation

As soon as the cloned disk image is booted, firstboot starts and the installation proceeds
exactly as laid out in Section 20.2.4, “Customizing the Workflow” (page 279). Only the
components included in the firstboot workflow configuration are started. Any other
installation steps are skipped. The end user adjusts language, keyboard, network, and
password settings to personalize the workstation. Once this process is finished, a firstboot
installed system behaves as any other instance of SUSE Linux Enterprise Server.
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Part IV. Automated Installations






Automated Installation

AutoYaST allows you to install SUSE® Linux Enterprise on a large number of machines
in parallel. The AutoYaST technology offers great flexibility to adjust deployments to
heterogeneous hardware. This chapter tells you how to prepare a simple automated in-
stallation and lay out an advanced scenario involving different hardware types and in-
stallation purposes.

21.1 Simple Mass Installation

IMPORTANT: Identical Hardware

This scenario assumes you are rolling out SUSE Linux Enterprise to a set of
machines with exactly the same hardware configuration.

To prepare for an AutoYaST mass installation, proceed as follows:

1 Create an AutoYaST profile that contains the installation details needed for your
deployment as described in Section 21.1.1, “Creating an AutoYaST Profile”
(page 290).

2 Determine the source of the AutoYaST profile and the parameter to pass to the
installation routines as described in Section 21.1.2, “Distributing the Profile and
Determining the autoyast Parameter” (page 292).

3 Determine the source of the SUSE Linux Enterprise installation data as described
in Section 21.1.3, “Providing the Installation Data” (page 294).
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4 Determine and set up the boot scenario for autoinstallation as described in Sec-
tion 21.1.4, “Setting Up the Boot Scenario” (page 295).

5 Pass the command line to the installation routines by adding the parameters

manually or by creating an info file as described in Section 21.1.5, “Creating
the info File” (page 297).

6 Start the autoinstallation process as described in Section 21.1.6, “Initiating and
Monitoring the Autoinstallation” (page 300).

21.1.1 Creating an AutoYaST Profile

An AutoYaST profile tells AutoYaST what to install and how to configure the installed
system to get a completely ready-to-use system in the end. It can be created in several
different ways:

+ Clone a fresh installation from a reference machine to a set of identical machines
+ Use the AutoYaST GUI to create and modify a profile to meet your requirements
» Use an XML editor and create a profile from scratch

To clone a fresh reference installation, proceed as follows:

1 Perform a normal installation.

2 After you complete the hardware configuration and read the release notes, check
Create Profile For AutoYaST, if it is not yet checked by default. This creates a
ready-to-use profile as /root/autoyast .xml that can be used to create
clones of this particular installation.

To use the AutoYaST GUI to create a profile from an existing system configuration
and modify it to your needs, proceed as follows:

1 Asroot, start YaST.

2 Select Miscellaneous > Autoinstallation to start the graphical AutoYaST front-
end.
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3 Select Tools > Create Reference Control File to prepare AutoYaST to mirror the
current system configuration into an AutoYaST profile.

4 As well as the default resources, like boot loader, partitioning, and software se-
lection, you can add various other aspects of your system to the profile by
checking the items in the list in Create a Reference Control File.

5 Click Create to have YaST gather all the system information and write it to a
new profile.

6 To proceed, choose one of the following:

+ Ifthe profile is complete and matches your requirements, select File > Save
as and enter a filename for the profile, such as autoyast .xml.

+ Modify the reference profile by selecting the appropriate configuration aspects
(such as “Hardware/Printer”) from the tree view to the left and clicking
Configure. The respective YaST module starts but your settings are written
to the AutoYaST profile instead of applied to your system. When done, select
File > Save as and enter a suitable name for the profile.

7 Leave the AutoYaST module with File > Exit.
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Figure 21.1 Editing an AutoYaST Profile with the AutoYaST Front-End
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Hardware
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Help

21.1.2 Distributing the Profile and
Determining the autoyast Parameter

The AutoYaST profile can be distributed in several different ways. Depending on the
protocol used to distribute the profile data, different AutoYaST parameters are used to
make the profile location known to the installation routines on the client. The location
of the profile is passed to the installation routines by means of the boot prompt or an

info file that is loaded upon boot. The following options are available:

Profile Lo- Parameter Description

cation

File autoyast=file:// Makes the installation routines look for
/path the control file in specified path (relative

to source root directory—file:///

autoyast.xml if in the top directory
of a CD-ROM).
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Profile Lo- Parameter Description
cation
Device autoyast=device:// Makes the installation routines look for
/path the control file on a storage device. Only
the device name is needed—/dev/sdal
is wrong, use sdal instead.
Floppy autoyast=floppy:// Makes the installation routines look for
/path the control file on a floppy in the floppy
drive. This option is especially useful, if
you want to boot from CD-ROM.
NFS autoyast=nfs:// Has the installation routines retrieve the
/server/path control file from an NFS server.
HTTP autoyast=http:// Has the installation routines retrieve the
/server/path control file from an HTTP server.
HTTPS autoyast=https://  Has the installation routines retrieve the
/server/path control file from an HTTPS server.
TETP autoyast=tftp:// Has the installation routines retrieve the
/server/path control file from a TFTP server.
FTP autoyast=ftp:// Has the installation routines retrieve the

/server/path

control file from an FTP server.

Replace the server and path placeholders with values matching your actual setup.

AutoYaST includes a feature that allows binding certain profiles to the client's MAC
address. Without having to alter the aut oyast= parameter, you can have the same
setup install several different instances using different profiles.

To use this, proceed as follows:

1 Create separate profiles with the MAC address of the client as the filename and
put them on the HTTP server that holds your AutoYaST profiles.

Automated Installation

293



294

2 Omit the exact path including the filename when creating the aut oyast= pa-
rameter, for example:

autoyast=tftp://192.168.1.115/

3 Start the autoinstallation.

YaST tries to determine the location of the profile in the following way:

1. YaST searches for the profile using its own IP address in uppercase hexadecimal,
for example, 192.0.2.911isC000025B.

2. If this file is not found, YaST removes one hex digit and tries again. This action
is repeated eight times until the file with the correct name is found.

3. If that still fails, it tries looking for a file with the MAC address of the clients as
the filename. The MAC address of the example client is 0080C8F6484C.

4. If the MAC address—named file cannot be found, YaST searches for a file named
default (in lowercase). An example sequence of addresses where YaST
searches for the AutoYaST profile looks as follows:

C000025B
C000025
c00002

C0000

C000

Cco0

e10}

C
0080C8F6484C
default

21.1.3 Providing the Installation Data

The installation data can be provided by means of the product CDs or DVDs or using
a network installation source. If the product CDs are used as the installation source,
physical access to the client to install is needed, because the boot process needs to be
initiated manually and the CDs need to be changed.
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To provide the installation sources over the network, set up a network installation
server (HTTP, NFES, FTP) as described in Section 14.2.1, “Setting Up an Installation
Server Using YaST” (page 202). Use an info file to pass the server's location to the
installation routines.

21.1.4 Setting Up the Boot Scenario

The client can be booted in several different ways:

Network Boot
As for a normal remote installation, autoinstallation can be initiated with Wake on
LAN and PXE, the boot image and control file can be pulled in via TFTP, and the
installation sources from any network installation server.

Bootable CD-ROM
You can use the original SUSE Linux Enterprise media to boot the system for au-
toinstallation and pull in the control file from a network location or a floppy. Alter-
natively, create your own custom CD-ROM holding both the installation sources
and the AutoYaST profile.

The following sections provide a basic outline of the procedures for network boot or
boot from CD-ROM.

Preparing for Network Boot

Network booting with Wake on LAN, PXE, and TFTP is discussed in Section 14.1.3,
“Remote Installation via VNC—PXE Boot and Wake on LAN” (page 197). To make
the setup introduced there work for autoinstallation, modify the featured PXE Linux
configuration file (/srv/tftp/pxelinux.cfg/default) to contain the
autoyast parameter pointing to the location of the AutoYaST profile. An example
entry for a standard installation looks like this:

default linux
# default label linux

kernel linux
append initrd=initrd install=http://192.168.1.115/install/suse-enterprise/
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The same example for autoinstallation looks like this:

default linux

# default label linux
kernel linux
append initrd=initrd install=http://192.168.1.115/install/suse-enterprise/
\
autoyast=nfs://192.168.1.110/profiles/autoyast.xml

Replace the example IP addresses and paths with the data used in your setup.

Preparing to Boot from CD-ROM

There are several ways in which booting from CD-ROM can come into play in Auto-
YaST installations. Choose from the following scenarios:

Boot from SUSE Linux Enterprise Media, Get the Profile over the Network
Use this approach if a totally network-based scenario is not possible (for example,
if your hardware does not support PXE) and you have physical access to system
to install during most of the process.

You need:
+ The SUSE Linux Enterprise media

» A network server providing the profile data (see Section 21.1.2, “Distributing the
Profile and Determining the autoyast Parameter” (page 292) for details)

* A floppy containing the inf o file that tells the installation routines where to find
the profile

or

Access to the boot prompt of the system to install where you manually enter the
autoyast= parameter

Boot and Install from SUSE Linux Enterprise Media, Get the Profile from a Floppy
Use this approach if an entirely network-based installation scenario would not
work. It requires physical access to the system to install for turning on the target
machine, or, in the second case, to enter the profile's location at the boot prompt.
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In both cases, you may also need to change media depending on the scope of instal-
lation.

You need:

The SUSE Linux Enterprise media

* A floppy holding both the profile and the info file

or

Access to the boot prompt of the target to enter the aut oyast= parameter

Boot and Install from Custom Media, Get the Profile from the Media
If you just need to install a limited number of software packages and the number
of targets is relatively low, creating your own custom CD holding both the installa-
tion data and the profile itself might prove a good idea, especially if no network is
available in your setup.

21.1.5 Creating the info File

The installation routines at the target need to be made aware of all the different compo-
nents of the AutoYaST framework. This is done by creating a command line containing
all the parameters needed to locate the AutoYaST components, installation sources,
and the parameters needed to control the installation process.

Do this by manually passing these parameters at the boot prompt of the installation or
by providing a file called info that is read by the installation routines (linuxrc). The

former requires physical access to any client to install, which makes this approach un-
suitable for large deployments. The latter enables you to provide the i nf o file on some
media that is prepared and inserted into the clients' drives prior to the autoinstallation.

Alternatively, use PXE boot and include the linuxrc parameters in the pxelinux
.cfg/default file as shown in Section “Preparing for Network Boot” (page 295).

The following parameters are commonly used for linuxrc. For more information, refer
to the AutoYaST package documentation under /usr/share/doc/packages/
autoyast.
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IMPORTANT: Separating Parameters and Values

When passing parameters to linuxrc at the boot prompt, use = to separate
parameter and value. When using an info file, separate parameter and value

with :.

Keyword Value

netdevice The network device to use for network setup (for
BOOTP/DHCP requests). Only needed if several network
devices are available.

hostip When empty, the client sends a BOOTP request. Other-
wise the client is configured using the specified data.

netmask Netmask for the selected network.

gateway Default gateway.

nameserver Name server.

autoyast Location of the the control file to use for the automatic
installation, such as
autoyast=nfs//192.168.1.110/profiles/.

install Location of the installation source, such as
install=nfs://192.168.1.110/CDs/.

vnc If set to 1, enables VNC remote controlled installation.

vncpassword The password for VNC.

usessh If set to 1, enables SSH remote controlled installation.

If your autoinstallation scenario involves client configuration via DHCP and a network
installation source and you want to monitor the installation process using VNC, your
info would look like this:

298 Deployment Guide



autoyast:profile source install:install source vnc:l vncpassword:some_password

If you prefer a static network setup at installation time, your info file would look like
the following:

autoyast:profile_source \
install:install_source \
hostip:some_ip \

netmask: some_netmask \
gateway:some_gateway

The \ indicate that the line breaks have only been added for the sake of readability. All
options must be entered as one continuous string.

The info data can be made available to linuxrc in various different ways:

+ Asafile on a floppy or CD Rom that is in the client's drive at installation time.
Add the info parameter similarto info=floppy:/infoorinfo=cd:/info.

+ As a file in the root directory of the initial RAM disk used for booting the system
provided either from custom installation media or via PXE boot.

+ As part of the AutoYaST profile. In this case, the AutoYaST file needs to be called
info to enable linuxrc to parse it. An example for this approach is given below.

» By means of an URL that points to the location of the info file. The syntax for this
looks like info=http://www.example.com/info.

linuxrc looks for a string (start_linuxrc_conf) in the profile that represents the
beginning of the file. If it is found, it parses the content starting from that string and
finishes when the string end_1inuxrc_conf is found. The options are stored in the
profile as follows:

<install>

<init>
<info_file>

<! [CDATA[
#
# Don't remove the following line:
# start_linuxrc_conf
#
install: nfs:server/path
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vnc: 1
vncpassword: test
autoyast: file:///info

# end_linuxrc_conf

# Do not remove the above comment
#

11>

</info_file>
</init>

</install>

linuxrc loads the profile containing the boot parameters instead of the traditional info
file. The install: parameter points to the location of the installation sources. vnc
and vncpassword indicate the use of VNC for installation monitoring. The
autoyast parameter tells linuxrc to treat info as an AutoYaST profile.

21.1.6 Initiating and Monitoring the
Autoinstallation

After you have provided all the infrastructure mentioned above (profile, installation
source, and info file), you can go ahead and start the autoinstallation. Depending on
the scenario chosen for booting and monitoring the process, physical interaction with
the client may be needed:

+ If the client system boots from any kind of physical media, either product media
or custom CDs, you need to insert these into the client's drives.

+ Ifthe client is not switched on via Wake on LAN, you need to at least switch on
the client machine.

+ Ifyou have not opted for remote controlled autoinstallation, the graphical feedback
from AutoYaST is sent to the client's attached monitor or, if you use a headless
client, to a serial console.

To enable remote controlled autoinstallation, use the VNC or SSH parameters described
in Section 21.1.5, “Creating the info File” (page 297) and connect to the client from
another machine as described in Section 14.5, “Monitoring the Installation Process”
(page 226).
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21.2 Rule-Based Autoinstallation

The following sections introduce the basic concept of rule-based installation using
AutoYaST and provide an example scenario that enables you to create your own custom
autoinstallation setup.

21.2.1 Understanding Rule-Based
Autoinstallation

Rule-based AutoYaST installation allows you to cope with heterogeneous hardware
environments:

+ Does your site contain hardware of different vendors?

+ Are the machines on your site of different hardware configuration (for example,
using different devices or using different memory and disk sizes)?

+ Do you intend to install across different domains and need to distinguish between
them?

What rule-based autoinstallation does is, basically, generate a custom profile to match
a heterogeneous scenario by merging several profiles into one. Each rule describes one
particular distinctive feature of your setup (such as disk size) and tells AutoYaST which
profile to use when the rule matches. Several rules describing different features of your
setup are combined in an AutoYaST rules. xml file. The rule stack is then processed
and AutoYaST generates the final profile by merging the different profiles matching
the AutoYaST rules into one. To illustrate this procedure, refer to Section 21.2.2, “Ex-
ample Scenario for Rule-Based Autoinstallation” (page 303).

Rule-based AutoYaST offers you great flexibility in planning and executing your SUSE
Linux Enterprise deployment. You can:

+ Create rules for matching any of the predefined system attributes in AutoYaST

+ Combine multiple system attributes (such as disk size and kernel architecture) into
one rule by using logical operators
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+ Create custom rules by running shell scripts and passing their output to the Auto-
YaST framework. The number of custom rules is limited to five.

NOTE

For more information about rule creation and usage with AutoYaST, refer to
the package's documentation under /usr/share/doc/packages/
autoyast2/html/index.html, Chapter Rules and Classes.

To prepare for a rule-based AutoYaST mass installation, proceed as follows:

1 Create several AutoYaST profiles that contain the installation details needed for
your heterogeneous setup as described in Section 21.1.1, “Creating an AutoYaST
Profile” (page 290).

2 Define rules to match the system attributes of your hardware setup as shown in
Section 21.2.2, “Example Scenario for Rule-Based Autoinstallation” (page 303).

3 Determine the source of the AutoYaST profile and the parameter to pass to the
installation routines as described in Section 21.1.2, “Distributing the Profile and
Determining the autoyast Parameter” (page 292).

4 Determine the source of the SUSE Linux Enterprise installation data as described
in Section 21.1.3, “Providing the Installation Data” (page 294)

5 Pass the command line to the installation routines by adding the parameters
manually or by creating an info file as described in Section 21.1.5, “Creating
the info File” (page 297).

6 Determine and set up the boot scenario for autoinstallation as described in Sec-
tion 21.1.4, “Setting Up the Boot Scenario” (page 295).

7 Start the autoinstallation process as described in Section 21.1.6, “Initiating and
Monitoring the Autoinstallation” (page 300).
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21.2.2 Example Scenario for Rule-Based
Autoinstallation

To get a basic understanding of how rules are created, think of the following example,
depicted in Figure 21.2, “AutoYaST Rules” (page 304). One run of AutoYaST installs
the following setup:

A Print Server
This machine just needs a minimal installation without a desktop environment and
a limited set of software packages.

Workstations in the Engineering Department
These machines need a desktop environment and a broad set of development soft-
ware.

Laptops in the Sales Department
These machines need a desktop environment and a limited set of specialized appli-
cations, such as office and calendaring software.
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Figure 21.2 AutoYaST Rules
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In a first step, use one of the methods outlined in Section 21.1.1, “Creating an AutoYaST
Profile” (page 290) to create profiles for each use case. In this example, you would

create print.xml, engineering.xml, and sales.xml.
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In the second step, create rules to distinguish the three hardware types from one another
and to tell AutoYaST which profile to use. Use an algorithm similar to the following
to set up the rules:

1. Does the machine have an IP of 792.7168.2.253? Then make it the print server.

2. Does the machine have PCMCIA hardware and feature an Intel chipset? Then
consider it an Intel laptop and install the sales department software selection.

3. Ifnone of the above is true, consider the machine a developer workstation and install
accordingly.

Roughly sketched, this translates into a rules . xml file with the following content:

<?xml version="1.0"?>
<!DOCTYPE autoinstall SYSTEM "/usr/share/autoinstall/dtd/rules.dtd">
<autoinstall xmlns="http://www.suse.com/1.0/yast2ns"
xmlns:config="http://www.suse.com/1.0/configns">
<rules config:type="1list">
<rule>
<hostaddress>
<match>192.168.2.253</match>
<match_type>exact</match_type>
</hostaddress>
<result>
<profile>print.xml</profile>
<continue config:type="boolean">false</continue>
</result>
</rule>
<rule>
<haspcmcia>
<match>1</match>
<match_type>exact</match_type>
</haspcmcia>
<customl>
<script>
if grep -i intel /proc/cpuinfo > /dev/null; then
echo -n "intel"

else
echo —-n "non_intel"
fi;
</script>
<match>*</match>
<match_type>exact</match_type>
</customl>
<result>

<profile>sales.xml</profile>
<continue config:type="boolean">false</continue>
</result>
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<operator>and</operator>
</rule>
<rule>
<haspcmcia>
<match>0</match>
<match_type>exact</match_type>
</haspcmcia>
<result>
<profile>engineering.xml</profile>
<continue config:type="boolean">false</continue>
</result>
</rule>
</rules>
</autoinstall>

When distributing the rules file, make sure that the rules directory resides under the
profiles directory specified in the autoyast=protocol: serverip/
profiles/ URL. AutoYaST looks for a rules subdirectory containing a file named
rules.xml first then loads and merges the profiles specified in the rules file.

The rest of the autoinstallation procedure is carried out as usual.

21.3 For More Information

For in-depth information about the AutoYaST technology, refer to the documentation
installed along with the software. It is located under /usr/share/doc/packages/
autoyast?2. The most recent edition of this documentation can be foundat http: //
www.suse.de/~ug/autoyast_doc/index.html.
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Automated Deployment of
Preload Images

With KIWI you are able to create operating system images. This chapter handles the
process of deploying an system image to an empty machine. For this, you have to create
a preload image which contains a bootable RAW image. This file contains two important
parts: a partition table and the actual operating system. This RAW image will be written
to the empty hard disk and the operating system extends to the remaining disk space at
first boot.

To create such a image, see Section 17.4.2, “Creating an Image” (page 265). When you
build the ISO image, you can find the RAW file at the destination folder. There are
many possibilities to dump a raw image onto a disk.

+ Plug the disk into a deployment server and just copy the image to the raw device.

+ Provide the raw image by means of a HTTP or FTP server and dump it on the disk
of the client to install.

+ Create a netboot image that does nothing but get the image and dump it on the disk.
This is a good method for mass deployment.

+ Boot a rescue disk and do the dump manually from the rescue image.

For a quick start, it is good to use one of the methods described in Section 22.1, “De-
ploying system manually from rescue image” (page 308).
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22.1 Deploying system manually from

rescue image

Deploying with generated ISO file from KIWI:

1.

Burn the ISO image you get from the KIWI building process, see Section 17.4.2,
“Creating an Image” (page 265) on CD/DVD

. Boot from this medium on the machine you want to install the system.
. Select the hard disk you want to install.

. Restart the machine and boot from hard disk.

Deploying over rescue system:

1.

Boot the client to install with a rescue system. Such systems are available on
all SUSE installation CDs or DVDs.

. Log in as root. Leave the password empty, no need to enter anything.

. Configure your network. If you have DHCP available in your network, this is

merely the command ifup-dhcp ethO. If you must do this manually, use
the command ip to configure your network. The output starting DHCP also
tells you the IP address of the computer.

. Listen on an unused port of your network like 1234 and dump the incoming

data to disk with the command:

netcat -1 -p 1234 > /dev/sda

. On the imaging server, send the raw image to the client to install with the com-

mand:

netcat <IP of client> 1234 < S$HOME/preload_image/<image_name>

. When the image is transferred, remove the rescue system from your CD or DVD

drive and shutdown the client computer. At the next boot, the boot loader GRUB
should be started on the client and the firstboot system will take over.
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22.2 Automated Deployment with PXE
Boot

When doing many installations of a operating system on similar hardware, it is useful
to put some effort into preparing a mass deployment of the operating system and to
minimize the time needed for the actual deployment. This is what this chapter is about.
The goal is to just attach a computer to power and network, start a network boot, and
wait until it switches off again.

The following actions have to be performed in order to accomplish this task:

Setup a boot and install server
A dedicated machine is needed, that should be prepared to offer PXE boot as well
as an ftp or web server to provide a preload image. It is a good idea to give the
machine enough memory to hold all necessary installation data in memory. For a
default installation, you should have at least 4 GByte of memory. All the necessary
tasks can be accomplished with a SUSE Linux Enterprise Server. For more details,
see Section 22.2.1, “Setup a Boot and Install Server” (page 310).

Prepare a preload Image

The actual installation is done by copying a raw image of the operating system to
the new harddisk. All features and settings have to be prepared and tested carefully.
To provide such an image, KIWI can be used, that is available in the SDK of the
SUSE Linux Enterprise operating system. More information about image creation
with KIWTI is available in Chapter 17, KIWI (page 259). For more details about the
requirements of the preload image, see Section 22.2.2, “Creating a Preload Image”
(page 310).

Create a initial system for deployment
This is a task that needs some linux expertise. A description about how this can be
achieved by means of an example installation is available at Section 22.2.3, “Cre-
ating a Initial System to Deploy a Preload Image” (page 311).

Configure the boot server to do automatic deployments
Finally, all must be put together. PXE boot must be told to boot the installation
system, that in turn will take the preload image from the server and copy it to the
harddisk.
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22.2.1 Setup a Boot and Install Server

There are four steps to accomplish to perform this task after you installed a SUSE
Linux Enterprise Server:

To perform this type of installation, proceed as follows:

1 Set up the installation source as described in Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 202). Choose a HTTP, or FTP
network server.

2 Setup a TFTP server to hold a boot image that will be created in a later step.
This is described in Section 14.3.2, “Setting Up a TETP Server” (page 215).

3 Set up a DHCP server to provide IP addresses to all machines and reveal the lo-
cation of the TFTP server to the target system. This is described in Section 14.3.1,
“Setting Up a DHCP Server” (page 212).

4 Prepare the installation server PXE boot. This is described in further detail in
Section 14.3.3, “Using PXE Boot” (page 216).

Note, that the actual installation process will greatly benefit if you provide enough
memory to this machine to hold the preload image in memory. Secondly, using gigabit
ethernet will speedup the deployment process considerably compared to slower networks,
if the complete network supports this.

22.2.2 Creating a Preload Image

The process of creating images with KIWI is described in Section 17.4.2, “Creating an
Image” (page 265). However, to create a useful image for a mass deployment, several
considerations should be taken into account:

+ A typical preload image will use the following type:

<type primary="true" filesystem="ext3" boot="oemboot/suse-SLES11">vmx</type>

* During the setup of a preload image, the image creation process is run multiple
times. The needed repositories to build the image should be available on the local
computer.
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» Depending on the desired usage of the preload, some effort should be invested in
configuring firstboot. Find more details about firstboot in Chapter 20, Deploying
Customized Preinstallations (page 275). With this method you can also require the
user to do initial configurations at the first bootup of the system.

+ Many additional features can be configured into the image like adding update
repositories, or doing an update at the first bootup. However, it is impossible to
describe all possibilities at this place, and depending on the requirements, the cre-
ation of the preload image requires in depth knowledge of the imaging system KIWI
as well as several other technologies used in SUSE Linux Enterprise Server.

The actual image to be deployed should be available from the ftp or http server you
provided on the installation server.

22.2.3 Creating a Initial System to Deploy a
Preload Image

In order to run an automatic deployment, it is necessary to start a initial linux system
on the target computer. During a typical installation, kernel and initial ram filesystem
are read from some boot medium and started by the bios. The needed functionality can
be implemented in the ram filesystem, which together with the kernel will serve as
initial system.

The main features that must be provided by the initial system is to enable access to the
harddisk, and to make a network connection available. Both of these functions are de-
pending on the hardware that you want to deploy on. In principle, it is possible to create
a initial system from scratch, but to ease this task, it is also possible to modify the initial
ram filesystem used by the machine during boot.

The following procedure is just one example how to create the needed initial ram
filesystem. There are many different methods to create such a system, however this one
is not too complex.

1 Do a standard installation of SUSE Linux Enterprise Server on the target
system.

2 Install the package busybox on the system.

3 Create a new ram filesystem with the following command:
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10

1

mkinitrd -f busybox -D ethO

Note that ethO represents the ethernet device where your network cable is at-
tached to. The parameter —f busybox adds the multi call binary busybox
to the ram filesystem. After doing this, many standard unix commands are
available inside this system.

Copy the new ram filesystem and the kernel to your boot server with the
command:

scp /boot/initrd /boot/vmlinuz pxe.example.com:

Replace pxe.example.com with the name of your local boot server or ip ad-
dress.

Log into your bootserver as user root, and create a directory where you can
modify the ram filesystem:

mkdir ~/bootimage

Change your working directory into this directory with the command cd
~/bootimage.

Unpack the previously copied initial ram filesystem with the command:

zcat ../initrd | cpio -1

Edit the file run_all. sh.

Search for the following line, delete it and the rest of the file:

[ "Sdebug" ] && echo preping 21-nfs.sh

Add the following lines to the end of the files run_all. sh:

[ "$Sdebug" ] && echo preping 92-install.sh
[ "Sdebug" ] && echo running 92-install.sh
source boot/92-install.sh

[ "Smodules" ] && load_modules

Create a new script boot /92-install. sh with the following content:

#!/bin/bash
if [ "$(get_param rawimage)" ]; then
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13

14

15

rawimage=$ (get_param rawimage)

if [ "$(get_param rawdevice)" ]; then
rawdevice=$ (get_param rawdevice)
echo "wget -0 ${rawdevice} ${rawimage}"
wget -0 ${rawdevice} ${rawimage}

sync
sleep 5
echo "DONE"
fi

fi
# /bin/bash
/bin/poweroff -f

If you want to have a debug shell before the computer switches off, remove
the comment sign before /bin/bash.

Make this script executable with the command chmod 755
boot/92-install.sh.

Create a new initial ram filesystem with the commands:
mkdir -p /srv/tftpboot

find . | cpio --quiet -H newc -o | gzip -9 -n > \
/srv/tftpboot/initrd.boot

Also copy the kernel to this directory:

cp ../vmlinuz /srv/tftpboot/linux.boot

The initial ram filesystem is now prepared to take two new kernel command line param-
eters. The parameter rawimage=<URL> is used to identify the location of the preload
image. Any URL that is understood by wget can be used. The parameter
rawdevice=<device> is used to identify the block device for the harddisk on the
target machine.

22.2.

4 Boot Server Configuration

The configuration of the boot server is covered in detail in several different chapters
as listed in Section 22.2.1, “Setup a Boot and Install Server” (page 310). This section
should give a check list that covers steps that are at least necessary to configure the

system.
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+ Setup a dhcp server. The subnet where the machines are installed needs the addi-
tional lines:

filename "pxelinux.0";
next-server 192.168.1.115;

In this example, 192.168.1.115 is the ip address of the PXE server pxe.example.com.

+ Configure a PXE server as described in Section 14.3.3, “Using PXE Boot”
(page 216). When editing /srv/tftpboot/pxelinux.cfg/default,add
the following entries:

default bootinstall

label bootinstall
kernel linux.boot
append initrd=initrd.boot \
rawimage=ftp://192.168.1.115/preload/preloadimage.raw rawdevice=/dev/sda

* Setup a fip server and copy your prepared preload imageto /srv/ftp/preload/
preloadimage.raw.

Test your setup by booting the target system with PXE network boot. This will automat-
ically copy the prepared preload image to harddisk and switch off the machine when
ready.
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